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Használati útmutató  - 1 - 

Ismerkedés a HP iPAQ-kal 
 
Gratulálunk a HP iPAQ rx3000-es sorozatú mobil média készülék 
megvásárlásához! Ennek az útmutatónak a segítségével megismerkedhet az 
eszköz képességeivel. 
 
Az alábbiakban bemutatott programok előtelepítve megtalálhatóak a készüléken. 
Ezek a programok akkor sem törlődnek, ha az akkumulátor teljesen lemerül. 
 
A programok működésével kapcsolatban részletes információkat a HP iPAQ-on 
található Súgó (Help) fájlokban találhat. A Súgó megnyitásához érintse meg a 
Start menüben a Help parancsot, és válasszon ki egy programot! 
 
A HP iPAQ működésével kapcsolatos további információt a Microsoft Pocket PC 
Basics-ben találhat. A Pocket PC Basics elindításához érintse meg a Start > Help > 
Pocket PC Basics elemet! 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos HP iPAQ 
modelleken áll rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban 
(Accessories Brochure) talál bővebb információt a HP Photosmart kameráról. 
 
Bónusz program Súgó Leírás 
DockWare Start > Help > 

DockWare 
A HP iPAQ-ot asztali óraként, havi 
naptárként és személyes digitális 
képkeretként használhatja. 

iPAQ Backup Start > Programs> 
iPAQ Backup > 
Options> About 

Védekezzen a teljesen lemerülő 
akkumulátor, véletlen törlés vagy 
hardverhiba miatti adatvesztés ellen! 

Experience 
HP iPAQ 

Programs > 
Experience 
HP iPAQ 

A HP iPAQ lehetőségeinek bemutatója. 

Flash Player Start > Programs> 
Flash Player > 
Help 

Macromedia Flash fájlok lejátszása a HP 
iPAQ-on. 

iPAQ Mobile 
Media 

Start > Help > 
iPAQ Mobile 
Media 

Zene, fénykép és videó gyűjtemények 
tallózása és megtekintése vezetéknélküli 
hálózat segítségével, bárhonnan a 
lakásban. 
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Bónusz program Súgó Leírás 
Nevo Home 
Control 

Start > Help > 
Nevo 

Távvezérelje a szórakoztató elektronikai 
berendezéseit a HP iPAQ segítségével! 

HP Image Zone 
for iPAQs 

Start > Help > HP 
Image Zone 

Fényképek megnézése, szerkesztése, 
megosztása, ellátása jegyzetekkel a HP 
iPAQ-on. Kinyomtathatja, elküldheti a 
fényképeket, vagy készíthet diavetítést. 
Hozzon létre diavetítéseket, játszon le 
videókat, és ossza meg a barátaival és 
családjával! 

HP Photosmart 
kamera (csak 
bizonyos 
modelleken) 

Start > Help > 
Photosmart 

Fényképek, videó felvételek készítése, 
valamint a kamera beállításainak 
módosítása a HP iPAQ-on. 

Self-Test Start > Settings > 
System fül > 
Seft Test 

Alapvető önteszt futtatása. 

Asset Viewer Start > Settings > 
System fül > 
HP Asset Viewer 

A rendszerjellemzők és a beállítások 
részletes listája. 

Bluetooth 
Manager 

Start > Help > 
Bluetooth 

Rövid hatótávolságú vezetéknélküli 
kommunikáció (max. 10m távolság). 

HP Mobile Print 
Center 

Start > Help > 
HP Image Zone 

Fényképek nyomtatását teszi lehetővé a 
HP Image Zone-ból. 

iPAQ Wireless A Launch 
képernyőn érintse 

meg a  jelet, 

majd a  jelet 
az iPAQ Wireless 
menüben. 

A Wi-Fi és a Bluetooth be- és 
kikapcsolása. 

iTask Start > Help > 
iTask 

A HP iPAQ leggyakrabban használt 
funkcióinak elérése. 
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Microsoft Pocket PC 
program 

Leírás 

 ActiveSync Információk szinkronizálása a HP iPAQ és a számítógép 
között, hogy mindkét készüléken az aktuális információk 
legyenek elérhetőek. Mielőtt a HP iPAQ-t a számítógéphez 
csatlakoztatja, mindenképpen telepítse az ActiveSync-et a 
számítógépre! 

Calculator Számológép. 
Calendar Találkozók, megbeszélések és egyéb események ütemezése, 

melyekre emlékeztető is beállítható. Az aktuális napi 
események láthatóak a Today képernyőn is. 

Contacts Barátok és munkatársak adatait tartalmazó lista. 
File Explorer Adatok kezelése (programok, dokumentumok, zene, videó és 

fénykép fájlok) 
Find Keresés a HP iPAQ-on. Érintse meg a Start > Help > Find 

menüpontot bővebb információért! Adja meg a keresendő 
szöveget, vagy érintse meg a legördülő lista melletti nyilat 
adattípus kereséséhez! 

Játékok (Solitaire, 
Jawbreaker) 

Előtelepített játékok. 

MSN Messenger Üzenetek küldése és fogadása. MSN Messenger (Passport) 
hozzáférés beállítása szükséges. 

Messaging E-mail küldése és fogadása az Interneten keresztül, ha 
telepítette az ActiveSync-et. E-mail küldéséhez és 
fogadásához rendelkeznie kell az internet-szolgáltatójától 
(ISP) vagy a munkáltatójától kapott e-mail címmel. 

Notes Kézzel írt vagy gépelt jegyzetek, rajzok és hangfelvételek 
készítése. 

Pocket Excel Excel munkafüzetek létrehozása és szerkesztése, valamint a 
számítógépen létrehozott munkafüzetek megtekintése és 
szerkesztése. 

Pocket Internet 
Explorer 

Az Internet böngészése és honlapok, programok letöltése 
szinkronizálással vagy az Internetre kapcsolódással. 

Pocket Word Word dokumentumok létrehozása és szerkesztése, valamint 
a számítógépen létrehozott Word dokumentumok 
megtekintése és szerkesztése. 

Pocket MSN Regisztrálja magát, hogy az MSN szolgáltatások (MSN 
Hotmail, MSN Messenger) a HP iPAQ-on is rendelkezésére 
álljanak! 
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Microsoft Pocket PC 
program 

Leírás 

Settings Gyors hozzáférés a háttérvilágítás, az óra, a memória, az 
energiaellátás, a helyi beállítások, a Launch képernyő, a 
Today képernyő, a jelszó, a hangjelzések, figyelmeztetések 
stb. beállításaihoz. 

Tasks A tennivalók listájának nyomon követése. 
Windows Media 
Player 9 Series 

Windows Media és MP3 formátumú digitális hang és videó 
fájlok lejátszása. 

 
 

A toll használata 
 
A HP iPAQ tartozéka egy toll, amely a képernyő érintésére és a képernyőre való 
írásra szolgál. 
 
FIGYELEM: A HP iPAQ kijelzőjének sérülését megelőzendő, a készülékhez kapott 
tollon vagy más, elfogadott érintőeszközön kívül ne használjon más eszközt írásra 
vagy a kijelző érintésére. Ha elveszik vagy eltörik a toll, újat rendelhet a 
www.hp.com/go/ipaqaccessories címen. 
 
A tollal három műveletet lehet végrehajtani: 
 
Érintés – Egy tétel kiválasztásához vagy megnyitásához finoman érintse meg a 
kijelzőt! Emelje fel a tollat az érintés után! Az érintés egyenértékű a számítógépen 
az egérrel történő kattintással. 
 
Húzás – Helyezze a toll hegyét a kijelző egy pontjára és húzzon egy tételt végig 
a képernyőn, amíg be nem fejezte a kijelölést. A húzás egyenértékű a 
számítógépen lenyomott bal egérgombbal történő húzással. 
 
Érintés és tartás – Tartsa rövid ideig egy tételen a tollat, míg egy menü meg 
nem jelenik! Az érintés és tartás egyenértékű a számítógépen a jobb egérgombbal 
történő kattintással. Amikor a képernyőn tartja a tollat, a toll körül megjelenő piros 
pontok jelzik, hogy hamarosan megjelenik a menü. 

 

http://www.hp.com/go/ipaqaccessories


  

Használati útmutató  - 5 - 

A dátum és az idő beállítása 
 
A HP iPAQ első bekapcsolásakor be kell állítania az időzónát. Az időzóna 
beállítása után még be kell állítania a dátumot és az időt. Mindhárom beállítás 
egyidejűleg elvégezhető a Clock Settings képernyőn. 
 
MEGJEGYZÉS: Alapértelmezésben a HP iPAQ minden alkalommal szinkronizálja 
az időt a számítógéppel, amikor a két eszköz kapcsolódik az ActiveSync-en 
keresztül. 
 

Otthoni és helyi idő beállítása utazáskor 
  

1. A Start menüben érintse meg a Settings > System fül > Clock ikont! 
2. Érintse meg a Home (Otthoni) vagy a Visiting (Helyi) gombot! 
3. Érintse meg az időzóna (time-zone) melletti lefelé mutató nyilat és válassza 

ki a megfelelő időzónát! 
4. Érintse meg az órát, a percet vagy a másodpercet, és a fel- vagy lefelé 

mutató nyíllal állítsa be az időt! 
5. Érintse meg az AM (de.) vagy a PM (du.) jelet a megfelelő napszak 

kiválasztásához! 
6. Érintse meg az OK gombot! 
7. Érintse meg a Yes gombot az idő elmentéséhez! 

 

A dátum beállítása 
 

1. A Start menüben érintse meg a Settings > System fül > Clock ikont! 
2. Érintse meg a dátum melletti lefelé mutató nyilat! 
3. Érintse meg a balra vagy a jobbra mutató nyilat az év és a hónap 

kiválasztásához! 
4. Érintse meg a napot! 
5. Érintse meg az OK gombot! 
6. Érintse meg a Yes gombot a dátum elmentéséhez! 

 
Újra be kell állítania az időzónát, a dátumot és az időt, ha: 
 

• A honos időt (Otthoni vagy Helyi) meg kell változtatni. 
• Teljesen lemerül a HP iPAQ és minden elmentett beállítás elveszik. 
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• Teljes resetet hajt végre a készüléken. 
 

Tulajdonosi információk beírása 
 
Személyre szabhatja a HP iPAQ-t a tulajdonosi információk megadásával. A 
tulajdonosi információk megadásához: 
 

1. A Launch képernyőn érintse meg a Start > Settings > Owner Information 
elemet!  

2. Érintse meg a Name mezőt! Egy billentyűzet jelenik meg a képernyő alján. 
A betűk érintésével írja be a nevét! 

 
MEGJEGYZÉS: Ha kívánja, az adatok beviteléhez használhatja a Letter 
Recognizer-t, a Microsoft Transcriber-t vagy a Block Recognizer-t is. Erről 
részletesebb információt a 4. fejezetben („Beviteli módszerek”) talál. 
 

3. Érintse meg  a Tab gombot a billentyűzeten a következő mezőre való 
ugráshoz! 

4. Folytassa az adatok bevitelét! 
5. Ha szeretné, hogy bekapcsoláskor megjelenjenek a tulajdonosi 

információk, kapcsolja be a Show information when device is turned on 
jelölőnégyzetet! 

6. Érintse meg a Notes fület megjegyzések beírásához! 
7. Érintse meg az OK gombot az adatok elmentéséhez és a Launch 

képernyőhöz való visszatéréshez! 

A készülék újraindítása 

Normál újraindítás végrehajtása 
 
A normál (vagy puha, soft) újraindítás esetén nem törlődik semmilyen program 
vagy mentett adat. Bizonyosodjon meg róla, hogy minden adatot mentett a normál 
újraindítás végrehajtása előtt! 
 
Az alábbi célokból hajtson végre normál újraindítást: 
 

• Minden futó alkalmazás leállítása 
• Új alkalmazások telepítése után 
• A HP iPAQ újraindítása, ha nem válaszol 
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A normál újraindítás végrehajtása: 
 

1. Nyomja meg az iTask  gombot! 
2. Érintsen meg és tartsa a tollat bármely alkalmazáson a listában! 

 

 
 

3. Érintse meg a Close All Tasks menüpontot! 
4. Keresse meg a Reset gombot a HP iPAQ alján! 
5. A tollal finoman nyomja meg a Reset gombot! A HP iPAQ újraindul és 

megjelenik a Launch képernyő, vagy a hagyományos Today képernyő. 

Teljes újraindítás végrehajtása 
 
A teljes (vagy hard) újraindításra a következő esetekben van szükség: 
 

• Minden programot és adatot törölni kíván a fő memóriából (ahol az adatok 
és a telepített programok tárolódnak) 

• Vissza kívánja állítani a gyári beállításokat 
• A HP iPAQ-kal kapcsolatos problémát a normál újraindítás nem oldja meg 
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A teljes újraindítás nem törli azokat a programokat, amelyek gyárilag lettek 
telepítve a készülékre. A HP iPAQ-ba bevitt információk törlődnek, köztük a Word 
dokumentumok, a fényképek, a zenék és az egyéb beállítások. 
 
Az adatok mentésével kapcsolatosan bővebb információt a „Biztonsági mentés és 
visszaállítás” részben talál. 
 
Ha az akkumulátor teljesen lemerül, újratöltés után a HP iPAQ úgy viselkedik, 
mintha teljes újraindítást hajtott volna végre rajta. Bővebb információt az „Az 
akkumulátor ellenőrzése” részben talál. 
 
 
FIGYELEM: Teljes újraindítás végrehajtása esetén a HP iPAQ visszatér az 
alapértelmezett állapotába és minden információ elveszik (fájlok, beállítások stb.), 
ami fő memóriában van. Az iPAQ File Store-ban lévő adatok nem vesznek el. Az 
iPAQ File Store-ral kapcsolatban bővebb információt az „Az alapok” c. részben 
találhat. A kapcsolatokat is újra létre kell hoznia. Kapcsolatok létrehozásával 
kapcsolatban bővebb információt a CD melléklet „Ho Do I Guie” útmutatójának a 
„How Do I Synchronize Calendar, E-mail, Contact Data and More between My HP 
iPAQ and PC (installing Microsoft ActiveSync and establishing Partnerships)?” 
című részében találhat. 
 
A teljes újraindítás végrehajtása: 
 

1. Nyomja meg és tartsa lenyomva az iPAQ Mobile Media ( ) és az iTask 

( ) gombokat! 
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2. Az iPAQ Mobile Media és az iTask gombok nyomvatartása közben a tollal 
finoman nyomja meg és tartsa lenyomva a készülék alján található Reset 
gombot kb. 3 másodpercig, míg a képernyő elhalványodik! 

3. Amikor a képernyő elhalványodik, engedje el az iPAQ Mobile Media és az 
iTask gombokat, valamint a Reset gombot! A HP iPAQ újraindul és 
bekapcsol. 

 
Ha a HP iPAQ nem kapcsolódik be, próbálja meg a következőt: 
 

• Ellenőrízze, hogy az akkumulátor ajtaja zárva van-e. Ha nem, zárja be az 
akkumulátor ajtaját: illessze a füleket a helyükre és csúsztassa be! Így 
bezárja az akkumulátor ajtaját. Ha az akkumulátor ajtaja nincs bezárva, a 
HP iPAQ nem kapcsol be. Bővebb információt az „Az akkumulátor 
kezelése” című részben találhat. 

 
Hajtson végre normál újraindítást a készüléken! Olvassa el a mellékelt CD lemezen 
található „Ho Do I Guide” útmutató „How Do I Regain Functionality if My HP iPAQ 
Locks Up or Runs Slowly (Perform a Soft „Normal” Reset)?” című részét! 

A képernyő kalibrálása 
 
Első bekapcsoláskor a HP iPAQ végigvezeti Önt a képernyő kalibrálás 
folyamatán. Újra kell kalibrálnia a képernyőt, ha: 
 
§ A készülék nem reagál megfelelően az érintésre. 
§ Teljes újraindítást hajt végre a készüléken. 

 
A képernyő újrakalibrálása: 
 

1. A Start menüből válassza a Settings > System fül > Screen ikont! 
2. Érintse meg az Align Screen gombot! 
3. Érintse meg a képernyőn a szálkereszteket! Legyen precíz a 

szálkeresztek érintésekor! 
4. Érintse meg az OK-t! 

Karbantartás 
 
A HP iPAQ képernyőjének és kamerájának védelme érdekében kövesse az alábbi 
útmutatásokat! 
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MEGJEGYZÉS: A beépített kamera csak egyes modelleknél áll rendelkezésre! 
 
 

• Ha zsebben, táskában stb. magával viszi a HP iPAQ-t, vigyázzon, hogy ne 
nyomja össze, ne hajlítsa meg, ne ejtse le, ne üsse oda semmihez, továbbá 
ne üljön rá a készülékre! 

• Ha nem használja, tartsa a HP iPAQ-t tokban! A 
www.hp.com/go/ipaqaccessories oldalon tokok széles skálájából 
választhat. 

• Ne tegyen semmit a HP iPAQ tetejére! 
• Ne üsse a készüléket kemény tárgyakhoz! 
• Csak a készülékhez kapott tollal vagy más, elfogadott érintőeszközzel 

érintse meg vagy írjon a képernyőre! Ha elveszik vagy eltörik a toll, újat 
rendelhet a www.hp.com/go/ipaqaccessories címen. 

• Tisztitáshoz a képernyőt, a kamera lencséjét és a burkolatot puha, vízzel 
benedvesített ruhával törölje le. 

 
FIGYELEM: A belső alkatrészek károsodásának elkerülése érdekében nem 
permetezzen közvetlenül folyadékot a képernyőre és vigyázzon, hogy ne kerüljön 
folyadék a HP iPAQ belsejébe! Szappan és más tisztítószer hatására a képernyő 
elszíneződhet illetve károsodhat. 
 

 

http://www.hp.com/go/ipaqaccessories
http://www.hp.com/go/ipaqaccessories
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Az alapok 
 

A Launch képernyő és a Today képernyő használata 
 
A készülék első bekapcsolásakor a Launch képernyő (Indítőképernyő) jelenik meg. 
A Start > Today megérintésével is megjelenítheti az indítóképernyőt. 
 
 
 

 
 

   Új tétel létrehozása 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos modelleken áll 
rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban (Accessories 
Brochure) talál bővebb információt a HP Photosmart kameráról. 
 

    Kapcsolatok megtekintése 
Programok menü  Hangerő szabályozás és némítás 

HP Photosmart kamera 
indítása 
 
iPAQ Mobile Media 
indítása 
 
 
 
 
HP Image Zone indítása 
 
 
Wi-Fi és Bluetooth 
beállítások 
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A Launch képernyőről átválthat a hagyományos Today képernyőre az alábbi 
módon: 
 
 
 

 
 

   Új tétel létrehozása 
 
 

1. Érintse meg a Start > Settings > Today elemet! 
2. A Settings képernyőn érintse meg az Items fület, és kapcsolja ki az iPAQ 

Entertainment négyzetet a Launch képernyő kikapcsolásához! 
3. Az Items fülön jelölje ki azokat az elemeket, amelyeket látni kíván a Today 

képernyőn! 
4. Érintse meg az OK-t a beállítások érvényesítéséhez! Megjelenik a 

hagyományos Today képernyő. 
 

    Kapcsolatok megtekintése 
Programok menü  Hangerő szabályozás és némítás 

Dátum és idő beállítása 
E-mail olvasása 
 
 
Találkozó létrehozása 
vagy megtekintése 
 
 
 
 
 
 
 
 
Wi-Fi és Bluetooth 
beállítások 
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 Launch képernyő   Hagyományos Today képernyő 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos modelleken áll 
rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban (Accessories 
Brochure) talál bővebb információt a HP Photosmart kameráról. 
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A menüsor és a parancssor 
 
A menüsor a képernyő tetején található. A menüsor jelzi az időt, a hangok és a 
kapcsolatok állapotát, valamint lehetővé teszi programok indítását. A Start menü 
segítségével indíthat programokat.  
 

 
 
Érintse meg a Súgó megnyitásához 

  
Parancsok végrehajtásához a képernyő alján található parancssort használhatja 
Érintse meg a New elemet az aktuális programban új tétel létrehozásához. 

 
Új tétel létrehozása Beviteli mód választása (Input panel) 
 

  
 
Menü parancsok      Gombok 

Érintse meg egy program elindításához 
 
 
 
 
Érintse meg egy nemrég használt program 
elindításához 
 
Érintse meg további programok közti kereséshez 
Érintse meg a beállítások testreszabásához 
 
 
Wi-Fi és Bluetooth beállítások 



  

Használati útmutató  - 15 - 

Állapotjelző ikonok 
 
A menüsorban vagy a parancssorban az alább bemutatott ikonok jelenhetnek 
meg. Az ikon megérintésével bővebb információhoz juthat az adott tétellel 
kapcsolatban. 
 

 
Aktív kapcsolat a számítógéppel vagy a vezetéknélküli hálózattal.  

 
Nincs aktív kapcsolat a számítógéppel és a vezetéknélküli 
hálózattal. 

 
A Microsoft ActiveSync szinkronizációs tevékenységet végez. 

 
A hangszóró be van kapcsolva. 

 
A hangszóró ki van kapcsolva. 

 
A HP iPAQ és a számítógép össze vannak kötve. Ez az ikon csak 
akkor jelenik meg, ha van aktív kapcsolat. 

 
Vezetéknélküli ikon. Ha a Bluetooth vagy a Wi-Fi be van kapcsolva, 
a vezetéknélküli LED kékre vált. 

 
Vezetéknélküli ikon. Ha a Bluetooth és a Wi-Fi ki van kapcsolva, a 
vezetéknélküli LED nem világít. 
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Felbukkanó menük 
 
A felbukkanó menükkel végre lehet hajtani egy műveletet az adott elemen. A 
felbukkanó menü segítségével kivághatja, másolhatja, átnevezheti vagy törölheti 
az adott elemet, valamint elküldheti e-mailben vagy fájlként egy másik készülékre. 
 
A művelet végrehajtásához érintse meg és tartsa a tollat a kívánt elemen! Amikor 
megjelenik a menü, érintse meg a kívánt műveletet! Ha meggondolja magát, 
érintse meg a képernyőt bárhol a menün kívül a menü bezárásához! 
 

 

Érintse meg és tartsa rajta a tollat a 
felbukkanó menü megnyitásához! 
Érintse meg a kívánt műveletet! 
 
 
Érintse meg a képernyőt a menün 
kívül a menü bezárásához, ha nem 
kíván műveletet végrehajtani! 
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Információ létrehozása 
 
A Launch és a Today képernyőn új információt hozhat létre, például: 
 

• Találkozók 
• Névjegyek 
• Üzenetek 
• Excel munkafüzetek 
• Jegyzetek 
• Teendők 
• Word dokumentumok 

 

1. Érintse meg a  jelet vagy a Start menüben érintse meg a Today > New 
parancsot! 

2. Válassza ki, milyen új tételt kíván létrehozni! 
3. Érintse meg az OK-t az új tétel létrehozása után! 

A Today képernyő testreszabása 
 
Az alábbi beállításokkal módosíthatja a Today képernyő kinézetét: 
 

• Beállíthat egy képet háttérképnek 
• Kiválaszthatja, mely elemek jelenjenek meg a Today képernyőn 
• Beállíthatja, milyen sorrendben jelenjenek meg az elemek 
• Beállíthatja, mikor kívánja a hagyományos Today képernyőt látni 

 

1. Érintse meg a  jelet, vagy a Start menüben érintse meg a Settings > 
Today elemet! 

2. Kapcsolja be a Use this picture as the background (Kép használata 
háttérképként) lehetőséget! 

3. Érintse meg a Browse (Tallózás) gombot és válasszon egy képet a File 
Explorer-rel! 

4. Érintse meg az Items fület a Today képernyőn látható információk 
kiválasztásához és átsorrendezéséhez! 

5. Érintsen meg egy elemet, hogy ki legyen jelölve! 
6. Érintse meg a Move Up (Felfelé mozgatás) vagy a Move Down (Lefelé 

mozgatás) lehetőségek egyikét az elemek sorrendjének 
megváltoztatásához! 



  

Használati útmutató  - 18 - 

7. Érintse meg a Display Today screen if device is not used for ... hours (Today 
képernyő megjelenítése ... óra után) melletti lefelé mutató nyilat, és állítsa 
be, hány óra elteltével jelenjen meg a Today képernyő! 

 
MEGJEGYZÉS: A dátum helyét nem lehet megváltoztatni. 
 

8. Érintse meg az OK-t! 
 

Programok használata 
 

iTask Launcher 
 
Az iTask segítségével elindíthatja a gyakran használt programokat. Az iTask 
segítségével gyorsan elindíthatja és bezárhatja a programokat, valamint válthat a 
futó programok között. 
 
Ikon Alapértelmezett gomb Leírás 

 
Today Megjeleníti a Launch vagy a Today képernyőt. 

 Contacts (Névjegyzék) Megjeleníti a névjegyzéket. 

 
Calendar (Naptár) Megjeleníti a naptárat a találkozók listájával. 

 Képernyő kikapcsolása Kikapcsolja a képernyőt. 

 Hang ki- és bekap-
csolása 

Ki- és bekapcsolja a hangokat. 

 Háttérvilágítás 
kikapcsolása 

Kikapcsolja a háttérvilágítást. 

 iTask menü Megjeleníti az iTask menüt. 

 Álló/fekvő nézet Álló és fekvő nézet között vált. 

 iPAQ Wireless 
(vezetéknélküli) 

Elindítja a Wireless Manager-t. 
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Kétféle módon indíthatja el az iTask-ot: 
 

• Az iTask gomb ( ) megnyomásával. Megjelenik az iTask menü és válthat 
a programok között. 

• A Start > Programs > iTask megérintésével. Megjelenik az iTask menü és 
válthat a programok között. 

 

Programok indítása 
 
Bármely alkalmazást elindíthatja a Start menüből. 
 
MEGJEGYZÉS: Úgy is elindíthat egy programot, hogy hozzárendeli egy 
parancsgombhoz. A parancsgombhoz való hozzárendeléshez a Launch vagy a 
Today képernyőn érintse meg a Start > Settings > Buttons menüpontot! 
 
Program elindítása: 
 

1. Érintse meg a Start > Programs menüpontot! 
2. Érintse meg a kívánt program nevét vagy ikonját! 

 

Pocket Internet Explorer 
 
A Pocket Internet Explorer elindítása: 
 

1. Érintse meg a Start > Internet Explorer menüpontot! Megjelenik a Pocket 
Internet Explorer. 

2. Válasszon a kezdőlapról! 
 
Ikon Gomb Leírás 

 Vissza Visszatér az előző oldalra. 

 
Frissítés Frissíti az aktuális oldalt. 

 Kezdőlap Betölti a kezdőlapot. 

 Csillag Megnyitja a Kedvencek (Favorites) listát. 
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Váltás álló és fekvő üzemmód között 
 
A képernyő beállításának megváltoztatása: 
 

1. Érintse meg a Start > Settings menüpontot! 
2. Érintse meg a Settings képernyő alján a System fület! 
3. Érintse meg a Screen (Képernyő) ikont! Megjelennek a lehetséges képernyő 

orientációk. 
4. Válassza ki a kívánt képernyő orientációt, majd érintse meg az OK gombot! 

A képernyő az új orientációban jelenik meg. 
 

 
 

MEGJEGYZÉS: Bizonyos programok csak álló képernyőmódban működnek és 
indulásukkor automatikusan visszaállíthatják a képernyőmódot. 
 

Programok ikonizálása 
 
Program ikonizálásához érintse meg a jobb felső sarokban látható x-et! 
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Programok bezárása 
 
A szabad memória függvényében a programok automatikusan bezáródnak. Ha a 
HP iPAQ lassú, kézzel is bezárhat programokat az iTask vagy a Settings menü 
segítségével. 
 

Programok bezárása az iTask-kal 
 

1. Nyomja meg az iTask gombot! 
2. Érintse meg és tartsa a tollat a bezárandó programon! 
3. A felbukkanó menüben válassza a Close This Task menüpontot! 

 

Programok kézi bezárása 
 

1. A Start menüben érintse meg a Settings > System fül > Memory > Running 
Programs fület! 

2. Érintse meg a Stop All gombot, vagy válasszon ki egy programot és érintse 
meg a Stop gombot! 

 
MEGJEGYZÉS: Futó programot előtérbe hozhat az Activate gombbal. 
 

Programok telepítése 
 
Az alábbi forrásokból telepíthet programokat a HP iPAQ-ra: 
 

• A számítógépről a Microsoft ActiveSync segítségével. 
• A HP iPAQ-ról, ha a program fájl kiterjesztése .cab. 
• A HP iPAQ-ról vagy a számítógépről másolással, ha a program fájl 

kiterjesztése .exe vagy .cef. 
 
Programok telepítéséhez keresse meg a HP iPAQ modellhez készült verziót. 
 

• Kövesse a programhoz mellékelt és a telepítő által adott utasításokat a 
számítógépről történő telepítéshez! 

• Érintse meg a program fájlt a HP iPAQ-on a File Explorer-ben! Kövesse a 
tepelítő utasításait! 
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Biztonsági mentés készítése 
 
Az iPAQ Backup és a Microsoft ActiveSync segítségével biztonsági mentést 
készíthet az adatairól, illetve visszaállíthat egy mentést. 
 
MEGJEGYZÉS: Az iPAQ Backup előre van telepítve a HP iPAQ-on. Az ActiveSync 
Backup használatához először telepítenie kell az ActiveSync-et a számítógépre. 
 
Az adatvesztés kockázatának csökkentése érdekében rendszeresen készítsen 
biztonsági mentést! 
 

Biztonsági mentés és visszaállítás az iPAQ Backup programmal 
 
Az iPAQ Backup egy biztonsági mentés fájlban tárolja az adatokat. Megadhatja, 
hogy mi legyen a fájl neve és hová kívánja létrehozni a biztonsági mentést. Az 
iPAQ Backup a memóriakártyára, a fő memóriába, vagy az iPAQ File Store 
mappába tud menteni. A biztonsági mentés és a visszaállítás megkezdése előtt 
zárjon be minden programot a HP iPAQ-on! 
 
FIGYELEM: A visszaállítás során a HP iPAQ-on található adatok felülíródnak a 
mentésben eltárolt adatokkal. 
 
Biztonsági mentés készítése és visszaállítás az iPAQ Backup segítségével: 
 

1. Érintse meg a  jelet, vagy a Start menüben érintse meg a Programs > 
iPAQ Backup menüpontot! 

2. Érintse meg a Backup vagy a Restore fület! 
3. Válassza ki az elmenteni vagy visszaállítani kívánt fájlokat és mappákat! 
4. Válassza ki, hová kívánja létrehozni a biztonsági mentést! 
5. Válassza ki, hogy biztonsági mentést készít, vagy visszaállít egy korábbi 

mentést! 
6. Érintse meg a Backup (Biztonsági mentés készítése) vagy a Restore 

(Visszaállítás) gombot, majd a Start gombot a következő képernyőn! 

 



  

Használati útmutató  - 23 - 

Biztonsági mentés és visszaállítás az ActiveSync használatával 
 
A biztonsági mentés készítése illetve a visszaállítás előtt zárjon be minden 
alkalmazást a készüléken! 
 
 
FIGYELEM: A visszaállítás során a HP iPAQ-on az adatok felülíródnak a biztonsági 
mentésben szereplő adatokkal. 
 
 
Biztonsági mentés/visszaállítás az ActiveSync-kel: 
 

1. Kösse össze a HP iPAQ-t a számítógéppel! 
2. A számítógépen indítsa el a Microsoft ActiveSync programot a Start > 

Programs > Microsoft ActiveSync-re való kattintással! 
3. Az ActiveSync-ben kattintson a Tools > Backup/Restore menüpontra! 
4. Kattintson a Backup (Biztonsági mentés készítése) vagy a Restore 

(Visszaállítás) fülre, és végezze el a beállításokat! 
5. Kattintson a Backup Now vagy a Restore Now gombra! 

 

Az iPAQ File Store használata 
 
Telepíthet programokat és menthet fájlokat az iPAQ File Store mappába, amelyet 
a File Explorer segítségével érhet el. (Ez a lehetőség bizonyos modelleken és 
bizonyos országokban nem áll rendelkezésre.) 
 
Ha az iPAQ File Store-ban tárolja a programokat és az adatokat, akkor nem 
törlődnek teljes újraindítás esetén sem, valamint akkor sem, ha teljesen lemerül az 
akkumulátor. 
 
Fájlok tárolása az iPAQ File Store-ban: 
 

1. A Start > Programs > File Explorer kiválasztása után keresse meg a kívánt 
fájlokat és programokat! 

2. Másolja át az elmenteni kívánt programokat és fájlokat: 
• Egy fájl kiválasztásához érintse meg a fájlt és tartsa rajta a tollat, hogy 

kijelölődjön. 
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• Több fájl kiválasztásához érintse meg és húzza végig a tollat a 
kijelöléshez, majd érintse meg és tartsa a tollat a fájlokon! 

3. A felbukkanó menüben érintse meg a Copy-t! 
4. Nyissa meg az iPAQ File Store-t a Start > Programs > File Explorer > My 

Documents > My Device > iPAQ File Store megérintésével! 
5. A képernyő alján érintse meg az Edit > Paste menüpontot! 

 
Az iPAQ File Store-ban rendelkezésre álló memória megtekintése: 
 

1. Érintse meg a Start > Settings > System fül > Memory > Storage Card fület! 
2. Érintse meg az iPAQ File Store-t a legördülő listából a rendelkezésre álló 

memória megtekintéséhez! 
 
MEGJEGYZÉS: Mielőtt az iPAQ File Store mappába mentene valamit, érdemes 
megnézni, mennyi memória áll rendelkezésre. A rendelkezésre álló memória 
megtekintéséhez érintse meg a Start > Settings > System fül > Memory > Storage 
Card fület, majd válassz a legördülő menüből az iPAQ File Store lehetőséget! 
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Szinkronizáció a számítógéppel 

 

A Microsoft ActiveSync használata 
 
A Microsoft ActiveSync egy szinkronizációs program, amelyet az asztali 
számítógépre vagy a laptopra kell telepíteni, és amelynek segítségével adatokat 
másolhat a számítógép és a HP iPAQ között. Így csak egyszer kell bevinnie az 
adatokat: vagy a számítógépen, vagy a HP iPAQ-on. Az ActiveSnyc és a 
szinkronizációs kábel segítségével az alábbiakra nyílik lehetősége: 
 

• Fájlokat másolhat (adat, hang, videó) a készülék és legfeljebb két 
számítógép között, hogy mindenhol a legfrissebb információkkal 
rendelkezzen. 

• Alkalmazásokat telepíthet a készülékre. 
• Lementheti és visszaállíthatja a készüléken lévő adatokat. 
• Szinkronizálhatja a linkeket. 
• E-mailt küldhet és fogadhat. 
• Meghívót küldhet találkozóra. 

Az ActiveSync telepítése 
 
A szinkronizációhoz az akkumulátornak feltöltött állapotban kell lennie. 
 
FIGYELEM: Az első szinkronizáció előtt hajtsa végre a lentebb található 1. és 2. 
lépést (telepítse a Microsoft ActiveSync-et a számítógépre)! Ezután, amikor a 
program kéri, csatlakoztassa a HP iPAQ-ot a számítógéphez! 
 
A Microsoft ActiveSync telepítése a számítógépre: 
 

1. Helyezze be a készülékhez kapott CD-t a számítógép CD meghajtójába! 
2. Amikor a CD tartalma megjelenik a számítógép képernyőjén, kattintson a 

Start Here feliratra! Kövesse a Setup Wizard utasításait! 
 
Amikor a rendszer arra kéri, csatlakoztassa a HP iPAQ-ot a számítógéphez a 
készülékhez kapott kábellel a következő módon: 
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1. Amikor a rendszer arra kéri, kösse össze a HP iPAQ-ot és a számítógépet a 
szinkronizációs kábel vagy az asztali dokkoló segítségével a következő 
módon: 
• Ha rx3700-as sorozatú készülékkel rendelkezik, csatlakoztassa az USB 

csatlakozót a számítógép USB portjához! Helyezze a HP iPAQ-ot a 
dokkolóba! Csatlakoztassa a hálózati adaptert a dokkoló egységhez, 
hogy feltöltse az akkumulátort! 

• Ha rx3100-as vagy rx3400-as sorozatú készülékkel rendelkezik, 
csatlakoztassa a szinkronizációs kábelt a számítógép USB portjához, a 
másik végét pedig a HP iPAQ-hoz! Csatlakoztassa a hálózati adaptert a 
szinkronizációs kábelhez, hogy feltöltse az akkumulátort! 

 
MEGJEGYZÉS: A HP iPAQ támogatja a soros vonali kapcsolatot is. A soros 
vonalon történő szinkronizációhoz a külön kapható soros kábelre van szükség. 
 

2. A Setup Wizard megkeresi a számítógépen a programokat, és lépésenként 
végigvezeti az ActiveSync telepítésén. A telepítés után bonthatja a HP iPAQ 
és a számítógép közti kapcsolatot. 

 

Szinkronizáció a számítógéppel 
 
Az ActiveSync telepítése után a következőkre nyílik lehetősége: 
 

• Kapcsolatokat (partnership) alakíthat ki, amelyek lehetővé teszik az 
információ szinkronizálását egy második számítógéppel. 

• Kiválaszthatja a szinkronizálni kívánt információkat (például Contacts 
(Névjegyzék), Calendar (Naptár), Messaging (Üzenetek), Tasks (Teendők), 
Favorites (Kedvencek), Files (fájlok), Notes (Jegyzetek), AvantGo). 

 
MEGJEGYZÉS: Fájlok szinkronizálásakor fogja meg és húzza a kiválasztott fájlokat 
a számítógépről a készülék szinkronizált mappájára. Ha „PC1”-nek nevezte el az 
eszközt a kapcsolat létrehozásakor, a szinkronizált mappa neve „PC1”. 
Szinkronizáláskor a fájlok átkerülnek a PC1 mappába és a PC1 mappából a 
kívánt helyre. 
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A szinkronizációs beállítások megváltoztatása 
 
Módosíthatja szinkronizációs beállításokat: 
 

• Megváltoztathatja, mikor történjen meg a szinkronizáció. 
• Megváltoztathatja kapcsolat típusát. 
• Kiválaszthatja a szinkronizálni kívánt fájl típusokat. 
• Kiválaszthatja a szinkronizálni nem kívánt fájlokat és adatokat (például e-

mail csatolt állományok). 
• Meghatározhatja a HP iPAQ-on és a számítógépen lévő információk 

ütközésének kezelésének módját. 
 
 
A szinkronizációs beállítások megváltoztatása: 
 

1. A számítógépen válassza a Start > Programs > Microsoft ActiveSync 
menüpontot! 

2. Az ActiveSync-ben kattintson a Tools > Options menüpontra! 
a. A Sync Options oldalon válassza ki a szinkronizálandó fájlokat és 

információkat! 
b. A Schedule fülön válassza ki, mikor szinkronizálódjon a HP iPAQ és 

a számítógép! 
c. A Rules fülön állítsa be, hogyan kell a számítógép és a HP iPAQ 

közti információ ütközéseket kezelni! 
3. Érintse meg az OK gombot! 
4. A File menüben válassza a Connection Settings... menüpontot! Válassza ki 

a HP iPAQ és a számítógép közt használni kívánt kapcsolat típusát! 
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A soros infravörös (IR) kapcsolat használata 
 
A HP iPAQ rendelkezik infravörös porttal. Ha a számítógépnek van infravörös 
portja vagy rendelkezésére áll egy USB-s infravörös adapter, a szinkronizációs 
kábel helyett az infravörös kapcsolat segítségével is szinkronizálhat a HP iPAQ és 
a számítógép között. Az infravörös kapcsolat csak Microsoft Windows 98SE, Me, 
2000 vagy XP operációs rendszerrel rendelkező számítógépek esetén működik. 
 
Infravörös kapcsolat létrehozása: 
 

1. Kövesse a gyártó utasításait az infravörös port telepítéséhez! 
2. Helyezze egyvonalba a HP iPAQ infravörös portját a számítógép 

infravörös portjával, hogy szabad rálátása legyen, és 30 cm-en belül 
legyenek! 

3. A HP iPAQ-on érintse meg a Start > ActiveSync > Tools > Connecti via IR... 
menüpontot! Megkezdődik a szinkronizáció. 

4. A kapcsolat bontásához távolítsa el egymástól a készülékeket vagy érintse 
meg az X-et a képernyő jobb felső sarkában! 

 

ActiveSync kapcsolat kialakítása Bluetooth-os számítógéppel 
 
A HP iPAQ rendelkezik Bluetooth illesztővel, ezért Bluetooth-on keresztül is 
létrehozhat ActiveSync kapcsolatot. A szinkronizációs kábel helyett Bluetooth 
kapcsolaton keresztül is szinkronizálhatja a számítógépet és a HP iPAQ-ot. 
 
Bluetooth-os ActiveSync kapcsolat létrehozása: 
 

1. Ha szükséges, vegye le a HP iPAQ-ot a dokkoló egységről! 
2. Érintse meg a Start > Program > ActiveSync menüpontot! 
3. Az ActiveSync-ben érintse meg a Tools > Options menüpontot! 
4. A PC Synchronization menüben érintse meg az Options gombot! 
5. Válassza a Bluetooth ActiveSync lehetőséget a legördülő menüből! 
6. Érintse meg az OK-t! 
7. Érintse meg ismét az OK-t! Mostmár végezhet szinkronizációt a HP iPAQ és 

a számítógép között Bluetooth kapcsolaton is a szinkronizációs kábel 
helyett. 
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Fájlok kézi másolása és mozgatása 
 
Fájlokat másolhat a számítógépről és a számítógépre az ActiveSync-ben vagy a 
Windows Explorer-ben az Explore paranccsal. 
 
Fájlok másolása: 
 

1. Hozzon létre kapcsolatot a HP iPAQ és a számítógép között a 
szinkronizációs kábellel vagy a dokkolóval! 

2. A számítógépen kattintson a jobb egérgombbal a Start menün! 
3. Kattintson az Explore-ra! Megnyílik a számítógépen található fájlok listája. 
4. Keresse meg az átmásolandó vagy átmozgatandó fájlt! 
5. Ha megtalálta a fájl(oka)t, hagyja nyitva az ablakot! 

 
MEGJEGYZÉS: Előtelepített fájlok és rendszerfájlok nem másolhatóak. 
 

6. A számítógépen kattintson a Start > Programs > Microsoft ActiveSync 
elemre az ActiveSync elindításához! 

7. Az ActiveSync-ben kattintson az Explore elemre! Megnyílik a HP iPAQ-on 
található fájlok listája (a Mobile Device könyvtárban). 

8. Nyissa meg a My Pocket PC > My Documents ablakot és hagyja nyitva! 
9. Húzza át a fájl(oka)t a HP iPAQ és a számítógép között! Ha a program 

engedélyt kér egy fájl átalakítására, hogy az a HP iPAQ-on használható 
legyen, válaszoljon igennel (yes)! 

10. Ha kívánja, nyissa meg a File Explorer-t a HP iPAQ-on! Érintse meg a My 
Device-t! Ellenőrízze, hogy a fájlok átmásolásra vagy átmozgatásra 
kerültek! 

 

Programok telepítése 
 
Az ActiveSync segítségével programokat telepíthet a számítógépről: 
 

1. A szinkronizációs kábellel kösse össze a HP iPAQ-ot és a számítógépet! 
2. Kövesse a program telepítőjének az utasításait! 
3. Ellenőrízze a HP iPAQ képernyőjén, hogy van-e szükség további lépésekre 

a telepítés befejezéséhez! 
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Biztonsági mentés és visszaállítás 
 
Az információvesztés kockázatának csökkentése érdekében rendszeresen mentse a 
számítógépre az adatait! A Microsoft ActiveSync segítségével történő biztonsági 
mentésről és a visszaállításról bővebb információt a 2. fejezetben talál („Az 
alapok”). 
 

Linkek szinkronizálása 
 
Szinkronizálhatja a számítógépen található Favorites listából a weboldalakra 
mutató linkeket, hogy azokat kapcsolat nélkül is megnézhesse a Pocket Internet 
Explorer segítségével. 
 

1. A számítógépen indítsa el az Internet Explorert! 
2. Kattintson a Favorites menüre a kedvencek megtekintéséhez! 
3. Ha el akar menteni egy oldalt a Mobile Favorites listába, nyissa meg az 

oldalt és kattintson a Create Mobile Favorite parancsra! 
 

• Ha a kedvenceket is kijelöli szinkronizálásra, az ActiveSync a következő 
szinkronizáció során a mobil kedvenceket átmásolja a HP iPAQ-re. 

• Ha a kedvenceket nem jelöli ki szinkronizálásra, az ActiveSync nem 
másolja át a kedvenceket a HP iPAQ-re a következő szinkronizáció során. 
A kedvenc linkek kézi szinkronizálása esetén kövesse az ezen fejezetben 
bemutatott lépéseket! 

 

E-mail küldése és fogadása 
 
Küldhet és fogadhat e-mailt a HP iPAQ és a számítógép ActiveSync-kel való 
szinkronizálásával. E-mail küldésekor és fogadásakor az aktuális mappa neve a 
képernyő alján látható. 
 
Bővebb információt az ActiveSync-kel történő levél küldésről és fogadásról a Start 
> Help > Messaging pontban találhat. 
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Meghívó küldése 
 
Szervezhet megbeszélést és küldhet rá meghívót az ActiveSync használatával. Az 
Üzenetkezelő (Messaging) segítségével megadhatja a megbeszélés adatait, 
amelyet a következő szinkronizáció során küldhet el. 
 
MEGJEGYZÉS: Csak olyanoknak küldhet meghívót, akik Outlook-ot vagy Pocket 
Outlook-ot használnak. 
 
Bővebb információt a Start > Help > View > All Installed Help > Calendar pontban 
találhat. 
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Beviteli módszerek 
 

A beviteli programok használata 
 
 
FIGYELEM: A kijelző sérülését elkerülendő, érintéshez mindig a készülékhez kapott 
tollat vagy az ujját használja! Ne használjon más tollat vagy fém érintőeszközt! 
 
Adatot vihet be bármely alkalmazásban a képernyőn megjelenő billentyűzet 
segítségével, a Letter Recognizer (KarakterfelismerőÖ, a Microsoft Transcriber és a 
Block Recognizer (Blokkfelismerő) használatával. A toll segítségével írhat vagy 
rajzolhat a képernyőre a Calendar (Naptár), Contacts (Névjegyzék) és a Tasks 
(Teendők) alkalmazások Notes (Jegyzetek) fülén. 
 

A javasolt szavak beállításainak megváltoztatása 
 
Gépelés vagy írás közben a készülék a billentyűzet, a Letter Recognizer és a Block 
Recognizer fölött egy dobozban szavakat javasol. Ez a lehetőség a Transcriber-
ben nem áll rendelkezésre. 
 
Meghatározhatja az alábbiakat: 
 

• Javasoljon-e a rendszer szavakat? 
• A javaslattételhez szükséges beírandó betűk számát. 
• Az egyidejűleg javasolt szavak számát. 

 
A javaslat beállításainak megváltoztatása: 
 

1. A Start menüben érintse meg a Settings > Input elemet! 
2. Érintse meg a Word Completion fület! 
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3. Érintse meg a betűk melletti lefelé mutató nyilat és adja meg a 
javaslattételhez szükséges betűk számát! 

 

 
 

4. Érintse meg a szavak melletti lefelé mutató nyilat és adja meg a 
javasolandó szavak számát! 
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5. Érintse meg az OK gombot! 
 
MEGJEGYZÉS: Ha nem kívánja, hogy a készülék szavakat javasoljon, kapcsolja ki 
a Suggest Words When Entering Text jelölőnégyzetet! 
 

Írás a billentyűzet használatával 
 
A toll és a képernyőn megjelenő billentyűzet használatával szöveget vihet be a 
képernyőre a betűk, számok és jelek megérintésével. 
 

1. Bármely alkalmazásban érintse meg a felfelé mutató nyilat az Input Panel 
ikon mellett! 
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2. Érintse meg a Keyboard lehetőséget! 
    
MEGJEGYZÉS: A jelek (szimbólumok) megjelenítéséhez érintse meg az 123 
gombot! 
 

3. Érintsen meg egy betűt, jelet vagy számot! 
4. Érintse meg az OK gombot! 

 

Írás a karakterfelismerő használatával 
 
A toll és a karakterfelismerő használatával betűket, számokat és jeleket írhat a 
képernyőre. Alkosson szavakat és mondatokat nagybetűk (ABC), kisbetűk (abc) és 
jelek (123) beírásával! 
 
A toll és a karakterfelismerő használata: 
 

1. Érintse meg a felfelé mutató nyilat az Input Panel mellett bármely 
alkalmazásban! 

2. Érintse meg a Letter Recognizer-t (Karakterfelismerő)! 
3. Írjon betűt vagy szimbólumot a szaggatott vonal és az alapvonal közé! 

a) Nagybetű beírásához írjon egy betűt az ABC jelű mezőbe! 
b) Kisbetű beírásához írjon egy betűt az abc jelű mezőbe! 
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c) Szám vagy jel beírásához írjon egy számot vagy jelet az 123 jelű 
mezőbe! 

 
A képernyőre írt jeleket szöveggé alakítja a szoftver. 
 
MEGJEGYZÉS: A programban a kérdőjel a Súgót jelöli. 
 
 
MEGJEGYZÉS: A Karakterfelismerő hatékony működése érdekében a szaggatott 
vonal és az alapvonal közé írja a karaktereket! 

• Ha a „p”-hez hasonló betűt ír, a betű felső felét a szaggatott vonal és az 
alapvonal közé írja, az alsó részét pedig az alapvonal alá! 

• Ha a „b”-hez hasonló betűt ír, a betű alsó felét a szaggatott vonal és az 
alapvonal közé írja, a felső részét pedig a szaggatott vonal fölé! 

 
 

Írás a toll és a Microsoft Transcriber használatával 
 
A toll és a Microsoft Transcriber használatával szavakat, betűket, számokat és 
jeleket írhat bárhol a képernyőn. 
 
Írás a tollal és a Microsoft Transcriber-rel: 
 

1. Érintse meg az Input Panel melletti felfelé mutató nyilat bármely 
alkalmazásban! 

2. Érintse meg a Transcriber menüpontot a Transcriber Intro megjelenítéséhez! 
3. Érintse meg az OK gombot! 
4. Érintse meg a New parancsot! 
5. Kezdjen el írni a képernyőre! A beírt jeleket a szoftver szöveggé alakítja. 

 
MEGJEGYZÉS: Tanítsa meg a Transcriber-nek az írását! Érintse meg a 
parancssorban az „ ” gombot a Letter Shapes képernyő megjelenítéséhez, és 
kövesse az ott látható utasításokat! 
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Írás a toll és a blokkfelismerő használatával 
 
A toll és a blokkfelismerő használatával betűket, számokat és jeleket írhat. 
Alkosson szavakat és mondatokat a betűk és számok beírásával a megfelelő 
helyre! 
 

1. Érintse meg az Input Panel melletti felfelé mutató nyilat bármely 
alkalmazásban! 

2. Érintse meg a Block Recognizer menüpontot! 
 

MEGJEGYZÉS: A Súgó elindításához érintse meg a  jelet! 
 

3. Írjon szót, betűt vagy jelet a szálkeresztek közé! 
a) Szöveg beírásához írjon egy betűt az „abc” jelű mezőbe! 
b) Számok vagy jelek beírásához írjon egy számot vagy jelet az „123” 

jelű mezőbe! 
 
A képernyőre írt jeleket a szoftver szöveggé alakítja. 
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Rajzolás és írás a képernyőre 
 
A tollal normál tollként is rajzolhat vagy írhat a képernyőre a Calendar, Contacts 
vagy Tasks programok Notes fülén. 
 

1. A Start menüben érintse meg a Notes > New parancsot! 
2. Írjon vagy rajzoljon a képernyőre! 
3. Érintse meg a Pen (Toll) ikont! 
4. Érintse meg az OK gombot! 

Az írás átalakítása szöveggé 
 
Szöveggé alakíthatja kézírását, ha a tollal ír a Notes alkalmazásban vagy az 
alábbi programok Notes fülén: 
 

• Calendar 
• Contacts 
• Tasks 

 
Az írás szöveggé alakítása: 
 

1. A Start menüben érintse meg a Notes menüpontot vagy a Notes fület a 
Calendar, Contacts vagy a Tasks alkalmazások egyikében! 

2. Érintsen meg egy feljegyzést a megnyitásához! 
3. Érintse meg a Tools parancsot! 
4. Érintse meg a Recognize parancsot! 

 
MEGJEGYZÉS: Egy szó vagy kifejezés átalakításához jelölje ki a szót vagy 
kifejezést a Recognize parancs megérintése előtt! Ha a rendszer nem ismeri fel a 
szót, nem alakítja át. 

 
5. Érintse meg az OK-t! 
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A digitális képkezelő funkciók használata 
 
A HP iPAQ rx3000 sorozatú készülék rendelkezik egy beépített kamerával, 
amelynek segítségével a HP iPAQ mobil digitális képkezelő központként 
alkalmazható. Megoszthatja a képeit e-mailben vagy a Weben, kinyomtathatja a 
készülékről vezeték nélkül, vagy tárolhat fájlokat a HP iPAQ-on. 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos HP iPAQ 
modelleken áll rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban 
(Accessories Brochure) talál bővebb információt a HP Photosmart kameráról. 
 
Az alább bemutatott programok a készülékhez mellékelt CD lemezen találhatóak. 
 
Program Leírás 
HP Photosmart kamera 
(csak bizonyos mo-
delleken) 

Fényképek és videófelvételek készítése, valamint a 
kamera beállítások módosítása. 

HP Image Zone for 
iPAQs 

Fényképek megnézése, szerkesztése, megosztása, 
nyomtatása, valamint kiegészítése jegyzetekkel. A HP 
iPAQ-ról kinyomtathatja, elküldheti a képeket, vagy 
készíthet diavetítést. Megoszthatja a diavetítést és a 
videókat barátaival és családjával. 

HP Image Zone for PC A HP iPAQ-kal készített fényképek és videó fájlok 
kezelése. Fényképek szerkesztése, nyomtatása és 
felhasználása multimédiás CD-ken, valamit fényképek 
elküldése barátoknak és családtagoknak. 

HP Image Transfer Fényképek automatikus átvitele a számítógépre 
szinkronizáció során. 
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Ismerkedés a kamera részeivel 
 
A kioldó gomb å a bal oldalon található. A tükör ç és a kamera lencséi é a HP 
iPAQ hátulján találhatóak. 
 

 
 

A kioldó gomb megnyomására elindul a HP Photosmart program, így 
fényképezhet és készíthet videó felvételt. 
 

Fényképezés 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos HP iPAQ 
modelleken áll rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban 
(Accessories Brochure) talál bővebb információt a HP Photosmart kameráról. 
 
A HP Photosmart kamera segítségével fényképeket és videófelvételeket készíthet az 
emlékezetes pillanatokról. Ebben a részben megismerkedhet a fényképezés és a 
videó készítés módjával, valamint a visszanézési lehetőséggel és a HP Photosmart 
kamera beállításaival. 
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HP Photosmart kamera 
 
A HP Photosmart kamera program elindításakor az alábbi ikonok jelennek meg a 
képernyőn: 
 

 
 

Ikon Leírás 

 Kilépés a HP Photosmart programból. 

 Súgó. 

 Settings (Beállítások) menü. 

 Képek és videók megtekintése a HP Image Zone-ban. 

 Kicsinyítés. (Az ikon megérintésével illetve a vezérlő tapipad lefelé 
nyomásával kicsinyíthet.) 

 Nagyítás. (Az ikon megérintésével illetve a vezérlő tapipad felfelé 
nyomásával nagyíthat.) 

 Váltás videó és fényképező mód között. 

 
Az ikon megérintésével fényképezhet illetve elindíthatja/leállíthatja a 
felvételt. 

 Az aktuális felbontás. 
 Az aktuális tömörítési mód. 
 Még ennyi kép fér el a memóriában. 

 Jelzi, hogy az időzítő be van kapcsolva. 
 Jelzi, hogy az éles kép érdekében stabilan kell tartani a fényképezőt. 
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Fénykép készítése 
 
Fénykép készítése a HP Photosmart kamerával: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Irányítsa a fényképező lencséjét a lefényképezendő alanyra a HP iPAQ 
képernyőjén található digitális kereső segítségével! 

3. Érintse meg az  ikont a nagyításhoz, illetve az  ikont a 
kicsinyítéshez! 

 
MEGJEGYZÉS: A vezérlő tapipad felfelé nyomásával is nagyíthat, illetve a 
lefelé nyomásával kicsinyíthet. 

 
4. Ne mozogjon se Ön, se a fényképezendő alany, hogy éles képet kapjon! 
5. A fénykép elkészítéséhez nyomja meg a készülék oldalán található elsütő 

gombot, vagy érintse meg a kioldó ikont ( ) a képernyőn! 
 
MEGJEGYZÉS: A fénykép elkészülte után pár másodpercig tart a kép feldolgozása 
és elmentése. Ezalatt a foglaltságot jelző kurzor jelenik meg a képernyőn. 
 
A HP Photosmart programból való kilépéshez érintse meg a Close (Bezárás) 

gombot ( )! 
 
MEGJEGYZÉS: Önmagát is lefényképezheti. Ehhez használja a készülék hátulján 
található tükröt! 
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Videófelvétel készítése 
 
A HP iPAQ a HP Photosmart kamera segítségével videót is tud rögzíteni. 
 
Videó rögzítése: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a Videó ikont ( ) a kamera programban a videó módba 
váltáshoz! 

3. Érintse meg a kioldó ( ) gombot a rögzítés megkezdéséhez! A rögzítés 
leállításához érintse meg újra ezt a gombot! 

4. Érintse meg a lejátszás gombot ( ) a Video Review (Visszanézés) 
képernyő megnyitásához! 

5. Érintse meg a visszajátszás gombot ( ) a rögzített videó lejátszásához! 
 
Videó megtekintése: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot! 
2. Érintse meg a megtekinteni kívánt videó kisképét, majd érintse meg a videó 

előnézeti képét! 

3. Érintse meg a visszajátszás gombot ( ) a videó lejátszásához! 
4. Érintse meg az OK-t a Video Review (Visszajátszás) ablak bezárásához! 

 
 

Az Instant Review (Visszanézés) használata 
 
A visszanézés segítségével megtekintheti az éppen elkészült fénykép előnézetét. 
Lehetősége van a kép törlésére, elmentésére, valamint elküldésére. 
 
Ha nem némította le a hangokat, a fénykép elkészítésekor a HP iPAQ egy hallható 
zárhangot ad. A fénykép feldolgozása és elmentése pár másodpercig tarthat a 
méretétől, minőségétől és összetettségétől függően. 
 
A fénykép elkészítése után megjelenik három ikon, amelyek segítségével 
eldobhatja, elküldheti, vagy megtarthatja a képet. 
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Az alábbi ikonokkat hajthatja végre ezeket a műveleteket: 
 

• Szemetes ikon  - az aktuális kép törlése 

• E-mail ikon  - az aktuális kép elküldése e-mail-ben 

• OK ikon  - a visszanézés bezárása, mert végzett és meg akarja tartani 
a képet 

 
MEGJEGYZÉS: A visszanézés hat másodperc után automatikusan bezáródik. A 
visszanézési beállítások megváltoztatásával kapcsolatban bővebb információt 
ezen fejezet az „A visszanézési beállítások megváltoztatása” részében találhat. 
 

A kamera beállítása 
 
A HP iPAQ rx3000 sorozatú készülék segítségével egyszerűen, egyetlen 
gombnyomással készíthet fényképeket, de további beállításokat is elvégezhet: 
 

• Fehéregyensúly (White Balance) 
• Színek (Color) 
• Felbontás (Resolution) 
• Automatikus záridő (Auto Exposure (AE) Metering) 
• Kamera hangok (Camera Sounds) 
• Visszanézés (Instant Review) 
• Időzítő (Self-Timer) 
• Fájl (File) 
• Videó felvétel (Video Recording) 
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A kamera beállításainak módosítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Settings vagy Setup fület! 
 

 
 

3. Érintse meg a megváltoztatni kívánt kategóriát, majd a Change gombot! 
4. Válassza ki a kívánt beállítást, majd érintse meg az OK-t! 
5. Érintse meg ismét az OK-t a menüből való kilépéshez! 

 

A fehéregyensúly beállítása 
 
Beállíthatja a piros, zöld és kék színek közti egyensúlyt a fényviszonyoknak 
megfelelően. Lehetősége van automatikus beállítást kérni, hogy a kamera 
automatikusan állítsa be a legjobb fehéregyensúlyt, vagy beállíthatja kézzel is. 
 
A fehéregyensúly beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Settings fül > White Balance > Change gombot! 
3. Válassza ki a kívánt beállítást, majd érintse meg az OK-t! 
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A rendelkezésre álló fehéregyensúly beállítások: 
 

• Auto (automatikus, alapértelmezett) – Automatikusan beállítja a 
fehéregyensúlyt. 

• Sun (napos) – Szabadtéri fényképezéshez, természetes fénynél (napos és 
felhős időben). 

• Tungsten (izzó) – Beltéri fényképezéshez, sárga megvilágításnál, illetve 
izzólámpa fényénél. 

• Fluorescent (fénycső) – Fehér megvilágításnál, illetve fénycső fényénél. 
 

Színek beállítása 
 
A HP iPAQ segítségével különböző színhatásokat használhat a fénykép 
elkészítéséhez, mint például a régi stílusú fényképekhez használt sepia (barna és 
fehér) vagy a fekete-fehér. 
 
A színek beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Settings fül > Color > Change gombot! 
3. Állítsa be a szín típust és érintse meg az OK-t! 

 
A rendelkezésre álló színtípusok: 
 

• Full Color (színes, alapértelmezett) – Normál színes képek készítése 
• Black and White (fekete-fehér) – Szürkeárnyalatos képek készítése 
• Sepia – Barna-fehér régi stílusú képek készítése 
• Negative (negatív) – A kép negatívját készíti el 
• Cool (hűvös) – Kék-fehér fényképek készítése 
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Tömörítés 
 
A tömörítés határozza meg, hogy mekkora lesz a fájl a kép elmentésekor. 
Háromféle tömörítésből választhat. 
 
A tömörítés beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Settings fül > Compression > Change gombot! 
3. Válassza ki a tömörítést és érintse meg az OK-t! 

 
Háromféle tömörítési mód áll rendelkezésére: 
 

• Good (jó) – A legkisebb fájlméret és a legrosszabb minőség 
• Better (jobb, alapértelmezett) – Közepes fájlméret és minőség 
• Best (legjobb) – A legnagyobb fájlméret és a legjobb minőség 

 
Az alábbi táblázat bemutatja a körülbelüli fájlméreteket a rendelkezésre álló 
felbontásokhoz: 
 

Tömörítés 1280x960 
(24 bites 

színmélység) 

640x480 
(24 bites 

színmélység) 

320x240 
(24 bites 

színmélység) 

160x120 
(24 bites 

színmélység) 
Good (jó) 148 kB 44 kB 17 kB 6 kB 

Better (jobb) 305 kB 85 kB 35 kB 11 kB 
Best (legjobb) 501 kB 127 kB 56 kB 17 kB 
 

A felbontás beállítása 
 
Négyféle felbontásból (méretből) választhat. A felbontás meghatározza a kép 
minőségét is. A jobb minőségű (nagyobb felbontású) képek jobban néznek ki a 
képernyőn és kinyomtatva is, különösen nagyításkor, de több tárhelyet is 
igényelnek. A rosszabb minőségű képek kevesebb helyet igényelnek és 
gyorsabban elküldhetőek e-mailben vagy infravörös kapcsolaton. 
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A Photosmart kamera a képernyő jobb felső sarkában jelzi, hogy körülbelül hány, 
a jelenlegi beállításoknak megfelelő felbontású és tömörítésű kép fér el a 
memóriában. Bővebb információt a „Tömörítés” című részben találhat. 
 
A rendelkezésre álló felbontások: 
 

• 1280x960 (alapértelmezett) 
• 640x480 
• 320x240 
• 160x120 

 

Az expozíciós idő beállítása 
 
Beállíthatja, hogy a fénykép mely területe alapján határozza meg a kamera az 
expozíciós időt. 
 
Az expozíciós idő beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Settings fül > AE Metering > Change gombot! 
3. Végezze el a beállítást, majd érintse meg az OK-t! 

 
A következő táblázat bemutatja a rendelkezésre álló beállításokat. 
 
Beállítás Leírás 
Average (átlagos) A kamera a teljes képterület alapján határozza meg az 

expozíciós időt. Akkor használja ezt a lehetőséget, ha azt 
akarja, hogy a kamera a teljes kép alapján határozza meg az 
expozíciós időt, például tájkép készítésekor. 

Center-weighted 
(közép, ez az 
alapértelmezett) 

A kamera a kép közepéből egy nagyobb terület alapján 
határozza meg az expozíciós időt. Akkor használja ezt a 
beállítást, ha a fényképezett alany a kép közepén helyezkedik 
el, ezért az expozíciós időt inkább hozzá kell igazítani, és 
nem a környezetéhez. 
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A kamera hangjának be- és kikapcsolása 
 
A kamera beállításainál ki- és bekapcsolhatja a fényképező hangjait. 
 
A kamera hangok beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Setup fül > Camera Sounds > Change gombot! 
 

 
 

3. Érintse meg az Off lehetőséget a hangok kikapcsolásához, vagy az On-t a 
hangok bekapcsolásához! 

4. Érintse meg az OK-t a menüből való kilépéshez! 
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A visszanézési beállítások megváltoztatása 
 
A visszanézési beállítások megváltoztatása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Setup fül > Instant Review > Change gombot! 
3. Válassza ki, mennyi ideig legyen látható a kép fényképezés után! 

Válasszon az alábbi lehetőségek közül: 
• Off (kikapcsolva) – letiltja a visszanézési lehetőséget 
• 2 seconds (2 mp) – 2 másodperc 
• 4 seconds (4 mp) – 4 másodperc 
• 6 seconds (6 mp, alapértelmezett) – 6 másodperc 

4. Érintse meg az OK-t a menüből való kilépéshez! 
 

Az időzítő használata 
 
Az időzítő segítségével beiktathat egy kis szünetet a kioldó gomb és a fénykép 
elkészülte közé. Akkor használja ezt a lehetőséget, ha olyan képet szeretne 
készíteni, amin Ön is látható! 
 
Az időzítő beállítása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Setup fül > Self-Timer > Change gombot! 
3. Állítsa be, hogy 2 vagy 10 másodperces késleltetést kíván használni, vagy 

nem akar késleltetést használni! Késleltetés használata esetén a fénykép a 
kioldó gomb lenyomása után 2 vagy 10 másodperccel készül el. 

4. Érintse meg az OK-t a menüből való kilépéshez! 
 
MEGJEGYZÉS: Ha az időzítő be van kapcsolva, a képernyőn megjelenik az   
ikon. 
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Fájl beállítások 
 
A fájl beállítások segítségével meghatározhatja, hol kerüljenek tárolásra a képek a 
HP iPAQ-on és milyen nevet kapjanak. A File fülön beállíthatja, milyen előtagot 
kapjanak a képfájlok, valamit beállíthatja a számlálót. A kettő kombinációjából 
(az előtagból és a számláló értékéből) jön létre a képfájl és a videófájl neve. 
Megadhatja azt a könyvtárat is, ahol a képek és a videók tárolódnak. 
 
A fájl beállítások (File Settings) menü megnyitása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > File fület! 
3. Állítsa be a kívánt paramétereket! 
4. Érintse meg az OK-t a menüből való kilépéshez! 

 
Könyvtár létrehozása, átnevezése és törlése: 
 

1. Érintse meg az Open Folder gombot a fájl menüben! 
2. Érintse meg a kívánt mappát! 
3. Érintse meg mégegyszer, és adja meg a nevét! 
4. A képernyő alján található ikonok segítségével hozhat létre, törölhet, vagy 

frissíthet egy mappát. 
5. Érintse meg az OK-t a menüből való kilépéshez! 

 
MEGJEGYZÉS: Csak üres könyvtárak törölhetőek, ezért egy könyvtár törlése előtt 
távolítson el belőle minden fájlt és alkönyvtárat! 
 

A videó beállítások megváltoztatása 
 
Rögzíthet videót (hanggal) a HP iPAQ beépített kamerája segítségével. Videót 
MotionJPEG vagy H.263 (csak rx3700 sorozat) formátumban rögzíthet. MJPEG 
használatával nagyobb felbontású felvételt készíthet, ez azonban lényegesen több 
memóriát igényel. A H.263 formátum használata esetén alacsonyabb felbontású, 
de hosszabb felvételt készíthet. 
 
MEGJEGYZÉS: A MotionJPEG formátumú videó csak a fő memóriába vagy az 
iPAQ File Store-ba menthető. MotionJPEG formátumú videót nem rögzíthet 
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közvetlenül SD/MMC kártyára. H.263 formátumú videó rögzíthető a fő 
memóriába, az iPAQ File Store-ba és SD/MMC kártyára is. A rendelkezésre álló 
memória megtekintéséről a „How Do I Guide...?” útmutató „Ho Do I Manage 
Available Storage?” című részében olvashat. 
 
A videó beállítások (Video Settings) menü megnyitása: 
 

1. A Start menüben érintse meg a Programs > HP Photosmart menüpontot, 
vagy a Launch képernyőn a Photosmart kamerát! 

2. Érintse meg a  > Video fület! 
3. Válassza ki a használni kívánt videó formátumot! (MJPEG vagy H.263) 
4. Válassza ki a használni kívánt felbontást: 

• MJPEG 
v 320x240 
v 176x144 
v 160x120 

• H.263 
v 176x144 
v 128x96 

5. Érintse meg a Record audio (hang rögzítése) jelölőnégyzetet, ha hangot is 
kíván rögzíteni! 

6. Érintse meg az OK-t a menüből való kilépéshez! 
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Visszanézés és megjelenítés 
 
A HP Image Zone segítségével megnézheti és szerkesztheti a HP iPAQ-on vagy az 
SD kártyán tárolt fényképeket és videókat. 
 

A HP Image Zone használata 
 
MEGJEGYZÉS: Alapértelmezés szerint a HP Image Zone a My Documents/My 
Pictures mappába mentett képeket jeleníti meg. 
 
A HP Image Zone progamot az alábbiakra használhatja: 
 
• Megtekintheti a HP iPAQ-on vagy az SD tárolt képeket 
• Hangot rögzíthet képekhez és lejátszhatja azokat 
• Elküldheti a képeket a HP Instant Share segítségével e-mailben vagy infravörös 

kapcsolaton 
• Könyvtárak kezelése (létrehozás, átnevezés, törlés) 
• Képeket nyomtathat a HP Mobile Printing vagy a HP Instant Share  segítségével 
• Diavetítést futtathat 
• Szöveges megjegyzéseket adhat JPEG fényképekhez 
• Elindíthatja a HP Photosmart programot 
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A HP Image Zone elindításakor az alábbi ikonok jelennek meg a képernyő alján. 
 

 
 
 
Ikon Leírás 

 Váltás fényképező és videókamera mód között. 

 Teljes képernyős mód. 

 Diavetítés elindítása. 

 Mappa váltás. 

 Fénykép vagy videó törlése. 

 Hang rögzítése a képhez. 

 Kép elküldése a kedvenc módszerrel. 

 Kép kinyomtatása a kedvenc módszerrel. 
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Kisképek megtekintése 
 
Kép megtekintése: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone elemet, vagy a 
Launch képernyőn a Photos elemet! 

 
MEGJEGYZÉS: Alapértelmezés szerint tallózás (Browse) módban nyílik meg a 
nézegető. A tallózás mód az aktuális mappában található képekről kisképeket 
jelenít meg. 
 

2. Érintsen meg egy kisképet (egy nagyobb kép lekicsinyítése) a kép 
kiválasztásához! Megjelenik a kép előnézete és néhány adat a képről. 

 

 
 
Más mappában lévő képek megtekintése: 
 

1. Érintse meg a File menüt a parancssorban, majd az Open menüpontot! 
2. Válassza ki a kívánt mappát! 
3. Érintse meg az OK gombot! A HP Image Zone az újonnan kiválasztott 

mappában lévő képeket jeleníti meg. 
 
MEGJEGYZÉS: A HP Image Zone-ban győződjön meg róla képek megtekintésekor, 
hogy a gördítősáv balra van tolva, ellenkező esetben elképzelhető, hogy nem látja 
a kisképeket. 
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Kép megtekintése teljes képernyőn 
 
Ha egy képet teljes képernyőn kíván megtekinteni, illetve nagyítani vagy 
kicsinyíteni akarja: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone elemet, vagy a 
Launch képernyőn a Photos elemet! 

2. Válassza ki a képet a kisképének megérintésével! 
3. Érintse meg az előnézeti ablakon a Tools > View Image menüpontot! 
4. Az eszköztár gombjaival nagyíthatja vagy kicsinyítheti a képet. Ha a kép 

nem fér el a képernyőn, a nem látható részeit a tollnak a képernyőn való 
húzásával jelenítheti meg. A vezérlőgomb segítségével is átméretezheti a 
képet. 

5. Érintse meg az OK-t a kép bezárásához! 

 

Diavetítés futtatása 
 
A megadott könyvtárban található képekből diavetítést készíthet. 
 

1. A Start menüben érintse meg a Programs > HP Image Zone elemet, vagy a 
Launch képernyőn a Photos elemet! 

2. Érintse meg a Tools > View Slideshow menüpontot! 
3. A vezérlő gombok megjelenítéséhez érintse meg bárhol a képernyőt! A 

vezérlő gombok segítségével mozoghat előre vagy hátra a képek között, 
illetve befejezheti a diavetítést. A vezérlőgomb segítségével is mozoghat 
előre vagy hátra a képek között. 

 
A következő megjelenítési beállítások állnak rendelkezésére: 
 
• Sequence (sorozat) – a képek megjelenésének sorrendje 
• Delay (késleltetés) – meddig legyen látható egy kép a következő megjelenése 

előtt 
• Rotation (forgatás) – a diavetítés automatikusan el tudja forgatni a képeket, 

hogy teljes képernyőn jelenjenek meg 
• Transition Effect (áttűnési hatás) – a diavetítésbe való belépéskor és kilépéskor 

használt hatás 
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A diavetítés beállításainak módosítása: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone elemet, vagy a 
Launch képernyőn a Photos elemet! 

2. Érintse meg a Tools > Settings > Slideshow fület! 
3. Állítsa be a diavetítés során használni kívánt beállításokat és hatásokat! 
4. Érintse meg az OK gombot! 

 

Kilépés a HP Image Zone-ból 
 
A HP Image Zone-ból való kilépéshez a parancssorban válassza a File > Exit 
menüpontot, vagy a jobb felső sarokban érintse meg az  ikont! 

 

A DockWare képernyővédő használata 
 
A DockWare a HP iPAQ-ra előtelepített képernyővédő program. Az Ilium 
DockWare asztali órává, havi naptárrá és személyes digitális képkeretté alakítja a 
HP iPAQ-ot. 
 
Amikor a HP iPAQ-ot a dokkolóra helyezi, a DockWare automatikusan elindul, ha 
5 percig nem használja a készüléket. Megjelenik az aktuális naptár, az aktuális 
dátum és az idő, valamint egy diavetítés. 
 

A DockWare elindítása 
 
Ha már 5 perce nem használja a készüléket és még mindig be van kapcsolva 
vagy a dokkolón van, a DockWare automatikusan elindul. A Start > Programs  
DockWare ikon megérintésével is elindíthatja a DockWare-t. 
 
A DockWare beállításainak megváltoztatásához érintse meg és tartsa a tollat 
bárhol a képernyőn! 
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A DockWare leállítása 
 
A DockWare azonnal leáll, ha megérinti a képernyőt vagy megnyomja bármely 
gombot a HP iPAQ-on (kivéve a fénykép megtekintésére szolgáló felfelé és lefelé 
görgetést). A DockWare akkor is leáll, ha bekapcsolódik egy jelzés vagy 
megjelenik egy felbukkanó ablak. 
 
Figyeljen a következőkre: 
 

• Ha a HP iPAQ akkumulátorról kapja az áramot, ez az alkalmazás nem 
indul el automatikusan. 

• Ha a DockWare fut és leveszi a HP iPAQ-ot a töltőről, az alkalmazás 
tovább fut, amíg le nem állítja. 

 
A DockWare letiltásához érintse meg és tartsa a tollat bárhol a képernyőn, majd 
kapcsolja ki a Start Automatically menüpontot a felbukkanó menüben! Ez a 
menüpont egy kapcsoló, amelynek segítségével elindíthatja és leállíthatja a 
DockWare-t, tehát, ha ismét el akarja indítani a DockWare-t, válassza ugyanezt a 
menüpontot! 
 
Bővebb információt a Start > Help > DockWare pontban találhat. 

 

Szerkesztés 
 
A HP Image Zone segítségével többféleképpen szerkesztheti a fényképeit: 
 

• Különböző toll típusokkat és színekkel rajzolhat a képre 
• Szöveget írhat a képre 
• Kivághat a képből egy részletet, forgathatja, átméretezheti 
• Módosíthatja a fénykép minőségét 
• Ötletes szűrőkett és hatásokat alkalmazhat a képen 

 



  

Használati útmutató  - 59 - 

Fényképek szerkesztése 
 
Fényképek szerkesztése: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone elemet, vagy a 
Launch képernyőn a Photos elemet! 

2. Válassza ki a szerkeszteni kívánt fényképet a kisképének megérintésével! 
3. Érintse meg a képernyő alján, a parancssorban a Tools menüpontot! 
4. Érintse meg az Edit parancsot! Elindul a HP Image Zone Editor, ahol 

elvégezheti a szerkesztést. 
 
A HP Image Zone Editor-ról bővebb információt a Start > Help > HP Image Zone 
menüpontban találhat. 
 

Hang rögzítése 
 
A fényképekhez rögzíthet hangot. Ha olyan képet nyit meg, amelyhez hang van 
rendelve, a HP Image Zone megjeleníti a képet és lejátsza a hozzá rendelt 
hangot. 
 
MEGJEGYZÉS: A hang nem játszódik le, ha letiltotta az Auto-play associated 
sounds files during preview (Hozzárendelt hang automatikus lejátszása) 
lehetőséget. A funkció engedélyezéséhez érintse meg a Start > Programs > HP 
Image Zone menüpontot, vagy a Launch képernyőn a Photos elemet! Érintse meg a 
Settings > General fül > Auto-play associated sound files during preview 
jelölőnégyzetet! 
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Hang csatolása képhez 
 
Hang hozzáadása egy képhez: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernyőn a Photos elemet! 

2. Válassza ki a képet a kisképének megérintésével! 
3. Érintse meg a kazetta (Casette) ikont a parancssorban, a képernyő alján! 
4. Érintse meg a Record gombot a Sound eszköztárban! 

 
Ikon Név Leírás 

 Felvétel (Record) Felvétel indítása. 

 Stop (Stop) Felvétel leállítása. 

 Lejátszás (Play) A kiválasztott képhez rendelt felvétel lejátszása. 

 Törlés (Delete) A kiválasztott képhez rendelt felvétel törlése. 
 

5. Beszéljen a mikrofonba, vagy rögzítse a képhez rendelendő hangot! 
6. Érintse meg a Stop gombot a Sound eszköztárban! 

 
Amely képekhez van hang rendelve, egy kis hangszórót tartalmaznak a 
kisképükben. 
 
A hang beállításainak megváltoztatása: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernyőn a Photos elemet! 

2. Érintse meg a képernyő alján a parancssorban a Tools menüpontot! 
3. Érintse meg a Settings > Audio fület! 
4. Állítsa meg a hang tulajdonságait! 
§ Codec settings (codec beállítások): PCM vagy GSM 6.10 

o A GSM 6.10 jó minőséget biztosít beszéd rögzítésekor és 
lényegesen kevesebb helyet foglal a PCM-nél (Pulse Code 
Modulation). 

o A PCM jobb hangminőséget biztosít, de akár 86-szor több 
tárhelyet is foglalhat, mint a GSM 6.10 felvétel. 

§ Format (formátum): Hangminőség beállítása. A jobb minőségű hang 
több helyet foglal. 

5. Érintse meg az OK gombot! 
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HP Image Zone for PCs 
 
A HP Image Zone for PCs segítségével lehetősége nyílik a HP iPAQ-on készült 
fényképek megtekintésére, kinyomtatására és szerkesztésére. A programot a HP 
iPAQ-hoz kapott CD lemezen találhatja meg. 
 
A HP Image Zone for PCs programmal az alábbiakra nyílik lehetősége: 
 

• Fényképek és videó felvételek kezelése 
• Fényképek szerkesztése 
• Multimédiás CD-k készítése 
• Fényképek felhasználása a HP Instant Share-ben nyomtatásra 
• Fényképek elküldése családtagoknak és barátoknak a HP Instant Share 

segítségével 
• A HP iPAQ-on készült MotionJPEG videók megtekintése 

 
A HP Image Zone for PCs számítógépre való telepítéséhez a következőkre van 
szükség: 
 

• Operációs rendszer 
o Microsoft Windows 98 
o Microsoft Windows 2000 Professional 
o Microsoft Windows Millenium Edition 
o Microsoft Windows XP SP1 vagy újabb 

• Microsoft Internet Explorer 5.0 vagy újabb 
• CD-ROM meghajtó 
• Legalább 256 színű VGA vagy kompatibilis grafikus kártya 
• Billentyűzet 
• Microsoft egér vagy kompatibilis beviteli eszköz 
• 500MB merevlemez terület 
• 600MHz Pentium III, K6, vagy AMD Athlon processzor vagy jobb 
• 115MB RAM 

 
A HP Image Zone for PCs telepítéséhez helyezze be a CD-t a CD-ROM 
meghajtóba! A HP Image Zone CD automatikusan elindul. 
 
Ha a HP Imagez Zone CD nem indul el automatikusan, kattintson a Start > Run 
menüpontra! Az Open: mezőbe írja be: D:\ (a D a CD meghajtó betűjele). 
Válassza a Setup.exe-t, majd kattintson duplán az OK-ra a telepítő elindításához! 
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MEGJEGYZÉS: A H.263/MPEG4 videó fájlok lejátszásához további programokra 
lehet szükség. 
 
A HP Image Zone for PCs használatával kapcsolatban bővebb információt a 
telepítés után az online Súgóban találhat. Kattintson a Start > Programs > HP 
Image Zone menüpontra, vagy kattintson duplán a HP Image Zone ikonra az 
asztalon! A HP Image Zone for PCs főmenüjéből kattintson duplán a Help-re! 
 

HP Image Transfer 
 
A HP Image Transfer és a Microsoft ActiveSync 3.7.1 segítségével automatikusan 
átviheti a fényképeket és a videókat a HP iPAQ-ról a számítógépre, ahol 
kinyomtathatja vagy megoszthatja családtagjaival és barátaival. A HP Image 
Transfer segítségével a következőkre nyílik lehetősége: 
 

• Fényképek és videó fájlok átvitele a HP iPAQ-ról a PC-re 
• Átvitel SD vagy MMC kártyáról a PC-re 
• Az átviteli beállítások módosítása 

 
MEGJEGYZÉS: A képek átviteléhez először telepítenie kell a Microsoft ActiveSync 
3.7.1-et, hogy kapcsolatot hozhasson létre a HP iPAQ és a számítógép között. 
 
A HP Image Transfer telepítése: 
 

1. A készülékhez kapott CD-n válassza a Software and Accessories > Desktop 
Software menüpontot, majd kapcsolja be az Install this jelölőnégyzetet a 
HP Image Transfer neve mellett! 

2. Kattintson a képernyő tetején található Install Now gombra, és kövesse a 
képernyőn látható utasításokat! 

 
Ha a HP Image Transfer telepítve van és az ActiveSync felismerte, az ActiveSync 
ablakban megjelenik az Image (Kép) jelölőnégyzet. 
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A HP Image Transfer beállítások engedélyezése illetve módosítása: 
 

1. Indítsa el az ActiveSync-et a számítógépen, ha még nem fut! 
2. Kattintson duplán az Image-re a Details (Részletek) ablak alatt, vagy 

válassza az ActiveSync menüjéből az Options menüpontot! 
3. A Sync options fülön válassza az Image lehetőséget, majd a kattintson a 

Settings gombra! 
 
MEGJEGYZÉS: Ha engedélyezi a képátvitelt, az ActiveSync-ben beállított 
ütemezések és szabályok a képátvitelre is vonatkoznak. A beállításoktól függően a 
képek a kapcsolat teljes időtartama alatt átvitelre kerülnek, csak a kapcsolódás 
létrejöttekor kerülnek átvitelre, vagy csak külön kérésre. 
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A HP Image Transfer segítségével a következő módon vihet át, nyomtathat és 
oszthat meg képeket: 
 

• A Mobile Device (Mobil eszköz) beállításnál látható, hogy honnan próbál 
meg képeket átmásolni a HP iPAQ-ról. Ha a memóriakártyáról is másolni 
szeretne, kapcsolja be az Include camera images on storage cards 
jelölőnégyzetet! 

• A Computer (Számítógép) beállításnál létrehozhat alkönyvtárakat, ahová a 
képeket menti. Például beállíthatja, hogy ugyanolyan nevű alkönyvtárba 
kerüljenek a képek a számítógépen, amilyen könyvtárban a HP iPAQ-on 
vannak. Ha olyan könyvtárból másol képeket, amelynek alkönyvtárai is 
vannak, a Sate to: mezőben megadott könyvtár alatt az alkönyvtárak is 
létrejönnek. Beállíthatja azt is, hogy a képeket tartalmazó könyvtár neve az 
a hónap legyen, amikor készültek (month taken), vagy az aktuális dátum 
(current date). 

• A Which images would you like to transfer? pontban háromféle lehetőséget 
állíthat be, hogy mely képeket szeretné átmásolni: 

o A legutóbbi átvitel óta készült képeket 
o Minden képet 
o Másolás után képek törlése a HP iPAQ-ról 

 
MEGJEGYZÉS: A HP iPAQ Imaget Transfer képernyőn bizonyos beállítások csak 
akkor módosíthatóak, ha a HP iPAQ csatlakoztatva van a számítógéphez. Ha a 
HP iPAQ nincs csatlakoztatva, kap egy figyelmeztetést, hogy bizonyos 
beállításokat nem lehet megváltoztatni és bizonyos beállítások nem elérhetőek. 
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Nyomtatás 
 
A HP Mobile Printing és a HP Instant Share segítségével kinyomtathatja a 
fényképeit és megoszthatja a videóit. 
 

A HP Mobile Printing használata 
 
A HP Mobile Print segítségével nyomtatók széles skáláján kinyomtathatja a HP 
iPAQ-kal készült fényképeit 
 
MEGJEGYZÉS: A HP iPAQ-on található HP Image Zone segítségével is 
kinyomtathatja fényképeit. Ha e-mail üzeneteket, Word dokumentumokat és 
egyebeket kíván nyomtatni, telepítse a HP Mobile Printing for Pocket PC teljes 
változtatát a mellékelt CD lemezről a HP iPAQ-ra! 
 
Nyomtatás a HP Image Zone-ból: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernyőn a Photos elemet! 

2. Érintse meg a kinyomtatni kívánt fényképet! 
 
MEGJEGYZÉS: Ha több fényképet is ki kíván nyomtatni, érintse meg a Tools > 
Select > Range menüpontot! Érintse meg a nyomtatandó tartomány első és utolsó 
fényképét! Ha ki vannak jelölve a képek, mindegyiken megjelenik egy zöld 
zászló. 
 

3. Érintse meg a File > Print menüpontot! 
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4. Válassza a HP Mobile Printing lehetőséget! 
 

 
 

5. Érintse meg a Next gombot! 
6. Válassza a Configure lehetőséget, majd az Add gombot! 
7. Válassza ki a kívánt nyomtatót, majd érintse meg a Next-et! 

 

 
 

8. Kövesse a képernyőn látható utasításokat a nyomtató beállításához! (A 
program kérni fog bizonyos adatokat a nyomtatóról. A nyomtató 
beállításával kapcsolatban bővebb információt a HP Image Zone 
Súgójában talál.) 

 
MEGJEGYZÉS: Minden nyomtatóhoz csak egyszer kell elvégeznie a fenti 
beállításokat. Nem szükséges meghajtóprogramokat telepítenie, amikor hozzáad 
egy nyomtatót a listához. 



  

Használati útmutató  - 67 - 

 
MEGJEGYZÉS: A betárcsázós és a vezetéknélküli Internet csatlakozás 
használatához, az e-mail küldéshez/fogadáshoz, a vállalati hálózat 
használatához és egyéb vezetéknélküli kommunikációhoz, mint például a 
Bluetooth-képes eszközök használatához elképzelhető, hogy külön megvásárolható 
eszközökre van szükség a WLAN infrastruktúra és a külön megkötött szerződés 
mellett. Érdeklődjön a szolgáltatónál a szolgáltatás rendelkezése állásával és a 
lefedettséggel kapcsolatban. Elképzelhető, hogy bizonyos Web tartalmak nem 
érhetőek el. Bizonyos tartalmak eléréséhez elképzelhető, hogy külön programot 
kell telepíteni. 
 
 
Nyomtató kiválasztása 
 
A Printer Selection (Nyomtató kiválasztása) képernyőn választhat nyomtatót, 
beállíthatja a nyomtatót és módosíthatja a nyomtatási beállításokat. Ha nincs 
nyomtató a listában, vagy az a nyomtató, amelyre nyomtatni szeretne, nincs a 
listában, érintse meg a Configure... gombot a nyomtató hozzáadásához! Ha egy 
nyomtató neve szürkén jelenik meg, az azért van, mert a HP Mobile Print nem 
támogatja a kiválasztott dokumentum típust. 
 
MEGJEGYZÉS: Rendelkezésre állhatnak egyéb programok, amelyek lehetővé 
teszik, hogy a HP Mobile Print segítségével kinyomtassa ezt a dokumentumtípust. 
 
Nyomtató kiválasztása: 
 

1. Válasszon egy nyomtatót a listából! 
2. Érintse meg a Print gombot! Ha meg kívánja változtatni a nyomtatás 

beállításait a nyomtatás előtt, nézze meg ezen fejezet „Nyomtatási 
beállítások” részét. 
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A Print (Nyomtatás) gomb megérintése után a dokumentum kinyomtatódik. A 
dokumentum állapotának megtekintéséhez, valamint a nyomtatás törléséhez nyissa 
meg a Print Manager-t! 
 
Nyomtatás infravörös nyomtatóra 
 
Ellenőrízze, hogy a készülék és a nyomtató infravörös portja lássák egymást! 
 
Nyomtatás Bluetooth nyomtatóra 
 
Ellenőrízze, hogy a kiválasztott Bluetooth nyomtató hatótávolságon belül van-e és 
a Bluetooth be van-e kapcsolva! 
 
Nyomtatás 802.11-es hálózati nyomtatóra 
 
Ellenőrízze, hogy van-e aktív hálózati kapcsolat és hogy a kiválasztott nyomtató 
ugyanahhoz a hálózathoz csatlakozik-e! 
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Nyomtatási beállítások 
 
A nyomtatási beállítások megváltoztatása: 
 

1. Válasszon ki egy nyomtatót a Printer Selection (Nyomtató kiválasztása) 
képernyőn! 

2. Érintse meg a Print Options gombot! 
 

 
 

A Print Options segítségével a következőket állíthatja be: 
 
Copies (Másolatok) Példányszám. 
Quality (Minőség) Nyomtatási minőség. Megjegyzés: Egyes nyomtatók 

érzékelik a kinyomtatott anyag típusát és felülírják ezt a 
beállítást. 

Paper size (Papírméret) Papírméret. Megjegyzés: Ha nem olyan méretű papírt 
helyez be, mint amit megadott, nem kap hibaüzenetet. A 
dokumentum a megadott mérethez lesz formázva és 
nyomtatva. 

Color setting (Színek) Színes (Color) és fekete-fehér (Black and White) 
nyomtatás választása a legördülő menüből. 

 
Az opciók beállítása után elmentheti a kiválasztott nyomtatóhoz a beállításokat a 
Save Settings jelölőnégyzet bekapcsolásával. Ekkor a jövőben is ezek a 
beállítások lesznek érvényesek nyomtatáskor. 
 

3. Érintse meg a Print gombot a dokumentum kinyomtatásához! 



  

Használati útmutató  - 70 - 

Beállítás 
 
A Configuration (Beállítás) képernyő segítségével hozzáadhat és törölhet 
nyomtatókat, módosíthatja a nyomtató vagy a rendszer beállításait. 
 
A Configuration (Beállítás) képernyő megnyitása: 
 

1. Indítsa el a Print Manager-t vagy érintse meg a Configure... gombot a 
Printer Selection (Nyomtató kiválasztása) képernyőn! 
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Nyomtató hozzáadása 
 
Nyomtató hozzáadásához érintse meg az Add... gombot a Configuration 
képernyőn! 
 

 

 
A nyomtató csatlakoztatása 
 
A nyomtató kiválasztása előtt a HP Mobile Print-nek tudnia kell, hogyan 
csatlakozik a nyomtatóhoz. A HP Mobile Print az infravörös (IR), a Bluetooth, a 
hálózati (Network-based) és a szolgáltatás alapú (Service-based) kapcsolatokat 
támogatja. Elképzelhető, hogy többféleképpen is lehet csatlakozni egy adott 
nyomtatóhoz, de egy időben csak egyfajta csatlakozás lehet beállítva. Például a 
HP Deskjet 995c támogatja az infravörös és a Bluetooth kapcsolódást is, így 
bármelyik beállítható ehhez a nyomtatóhoz. Beállíthat most egy Bluetooth 
kapcsolatot a nyomtatáshoz, később pedig infravöröset ugyanahhoz a 
nyomtatóhoz. 
 
A kapcsolat típusa függ a nyomtató által támogatott kapcsolat típusoktól. Ha meg 
akarja állapítani, hogy egy nyomtató támogatja-e az infravörös illetve a Bluetooth 
kapcsolatot, keresse meg rajta az infravörös portot, vagy a készüléken lévő 
Bluetooth rádiós egységet! Ha ezek nem találhatóak, megpróbálhatja hálózaton 
vagy nyomtató szolgáltatáson keresztül csatlakoztatni a nyomtatót. 
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• Bluetooth kapcsolat – Gyorsabb az infravörösnél, de a Bluetooth kapcsolat 
beállítása készülékenként változó. Bővebb információt a „Bluetooth 
nyomtató hozzáadása” részben találhat. 

• Infravörös kapcsolat – Az infravörös kapcsolat a leglassabb, de a 
legkönnyebben használható. Bővebb információt az „Infravörös nyomtató 
hozzáadása” részben találhat. 

• Hálózati kapcsolat – Hálózati kapcsolat létrehozása némileg bonyolultabb 
az infravörös és a Bluetooth kapcsolat létrehozásánál, de ez a 
leggyorsabb. Bővebb információt a „Hálózati nyomtató hozzáadása” 
részben találhat. 

 
Ha eldöntötte, milyen kapcsolatot használ, válassza ki azt a Choose Kind of 
Printer listából és érintse meg a Next gombot! A következő képernyő típusa attól 
függ, hogy milyen kapcsolat típust választott. 
 
 
Bluetooth nyomtató hozzáadása 
 
A Bluetooth kapcsolat létrehozása készülékenként változik. A Bluetooth egység 
lehet beépített, vagy opcionális tartozék. Folytatás előtt ismerkedjen meg a HP 
iPAQ-on és a Bluetooth nyomtatón rendelkezésre álló lehetőségekkel! 
 
A Bluetooth-szal kapcsolatban bővebb információt a 9. fejezetben („A Bluetooth 
használata”) találhat. 
 
Bluetooth nyomtatók keresése: 
 

1. A Next gomb megérintése után a Specify Bluetooth Printer (Bluetooth 
nyomtató megadása) képernyőn választhat a Search for a Bluetooth printer 
near me (Közeli Bluetooth nyomtató keresése) és az Add a Bluetooth printer 
(Bluetooth nyomtató hozzáadása) lehetőségek közül. 
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A Search for a Bluetooth printer near me (Közeli Bluetooh nyomtató keresése) 
lehetőség megkeresi a közelben lévő Bluetooth nyomtatókat és automatikusan 
beállítja a kapcsolatot. Az Add a Bluetooth printer (Bluetooth nyomtató 
hozzáadása) lehetőség választása esetén  be kell állítania a Bluetooth kapcsolatot 
a Bluetooth Manager segítségével. 
 

2. Bluetooth nyomtatók felfedezése 
A Next gomb megnyomása után a „Searching for devices...” („Készülékek 
keresése”) üzenet jelzi, hogy a HP Mobile Print keres és megjeleníti a megtalált 
Bluetooth nyomtatók listáját. 
 

 
 

A Stop megérintésével leállíthatja a keresést és választhat a már felfedezett 
nyomtatók közül. A keresés befejezése után válasszon egy nyomtatót, és érintse 
meg a Next gombot! 



  

Használati útmutató  - 74 - 

 
 

3. Adja meg a Bluetooth nyomtatót az üres mezők kitöltésével! 
 

 
 

Mfg: Válassza ki a nyomtató gyártóját a legördülő listából! 
 
Model: Válassza ki a nyomtató modell családot! A nyomtató neve és modellje 
általában megtalálható a nyomtatón. (Amennyiben nem található a listában a 
nyomtató családja, válassza a hozzá legközelebb állót és próbáljon meg 
nyomtatni. Ha nem sikerül, próbálkozzon másik nyomtató családdal, míg nem 
sikerül a nyomtatás.) 
 
Printer Address: Ez a mező automatikusan kitöltésre kerül, értéke „BT” (Bluetooth). 
 
My Printer Name: Adjon meg egy egyedi nevet a nyomtató azonosítására! 
Ajánlott olyan nevet választani, ami utal a nyomtató típusára és a használt 
kapcsolatra, például „Józsi DJ 995c Bluetooth nyomtatója”. 
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Enable Raw File Types: Ez haladó beállítás és a legtöbb esetben figyelmen kívül 
hagyhatja. Ez az opció lehetővé teszi, hogy bizonyos fájl típusokat közvetlenül el 
lehessen küldeni a nyomtató formátumában, mint például nyers PCL, JPG vagy PS 
fájlokat. 
 
Set As Default: Ha bekapcsolja ezt a jelölőnégyzetet, ez lesz az alapértelmezett 
nyomtató. 
 
Print Test Page: Ellenőrízheti a nyomtató beállításait és működését: teszt oldal 
nyomtatása. 
 

4. Érintse meg a Finish gombot a nyomtató hozzáadásához! 
 
 
Infravörös nyomtató hozzáadása 
 
Infravörös nyomtató hozzáadása: 
 

1. Válasszon ki egy infravörös nyomtatót, majd érintse meg a Next gombot! 
Megnyílik az IR Printer Identification (Infravörös nyomtató azonosítása) 
képernyő, és azt kéri, hogy helyezze a HP iPAQ infravörös portját a 
nyomtató infravörös portjához. 

2. Helyezze a készülék infravörös portját a nyomtató infravörös portjához, 
majd érintse meg az OK gombot! Megjelenik a Specify IR Printer (Infravörös 
nyomtató megadása) képernyő. Az Mfg és a Model mezők automatikusan 
kitöltésre kerülnek, ha sikerül azonosítani a nyomtatót. 

3. Adja meg az infravörös nyomtatót az üres mezők kitöltésével! 
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Mfg: Válassza a Hewlett-Packard-ot a legördülő listából. A HP Mobile Print 
jelenleg csak Hewlett-Packard nyomtatókat támogat. 
 
Model: Válassza ki a nyomtató modell családot! A nyomtató neve és modellje 
általában megtalálható a nyomtatón. (Amennyiben nem található a listában a 
nyomtató családja, válassza a hozzá legközelebb állót és próbáljon meg 
nyomtatni. Ha nem sikerül, próbálkozzon másik nyomtató családdal, míg nem 
sikerül a nyomtatás jó minőségben.) 
 
Printer Address: Ez a mező automatikusan kitöltésre kerül, értéke „IR”. 
 
My Printer Name: Adjon meg egy egyedi nevet a nyomtató azonosítására! 
Ajánlott olyan nevet választani, ami utal a nyomtató típusára és a használt 
kapcsolatra, például „Józsi DJ 995c IR nyomtatója”. 
 
Enable Raw File Types: Ez haladó beállítás és a legtöbb esetben figyelmen kívül 
hagyhatja. Ez az opció lehetővé teszi, hogy bizonyos fájl típusokat közvetlenül el 
lehessen küldeni a nyomtató formátumában, mint például nyers PCL, JPG vagy PS 
fájlokat. 
 
Set As Default: Ha bekapcsolja ezt a jelölőnégyzetet, ez lesz az alapértelmezett 
nyomtató. 
 
Print Test Page: Ellenőrízheti a nyomtató beállításait és működését: teszt oldal 
nyomtatása. 
 

4. Érintse meg a Finish gombot a nyomtató hozzáadásához! 
 
 
Hálózati nyomtató hozzáadása 
 

1. Válasszon egy hálózati nyomtatót, majd érintse meg a Next gombot! 
Megjelenik a Specify Network Printer (Hálózati nyomtató megadása) 
képernyő. 

2. Adja meg a hálózati nyomtatót az üres mezők kitöltésével! 
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Mfg: Válassza a Hewlett-Packard-ot a legördülő listából! A HP Mobile Print 
jelenleg csak Hewlett-Packard nyomtatókat támogat. 
 
Model: Válassza ki a nyomtató modell családot! A nyomtató neve és modellje 
általában megtalálható a nyomtatón. (Amennyiben nem található a listában a 
nyomtató családja, válassza a hozzá legközelebb állót és próbáljon meg 
nyomtatni. Ha nem sikerül, próbálkozzon másik nyomtató családdal, míg nem 
sikerül a nyomtatás jó minőségben.) 
 
Printer Address: Adja meg a nyomtató hálózati címét. A cím általában a 
következő formátumú: 
 
\\szerver\nyomtató_megosztott_neve 
 
MEGJEGYZÉS: A Windows CE eszközök nem érik el az UNC formátumú nevet 
használó eszközöket, ha a dokkolón vannak. Ebben az esetben használjon IP 
címet. 
 
 
My Printer Name: Adjon meg egy egyedi nevet a nyomtató azonosítására! 
Ajánlott olyan nevet választani, ami utal a nyomtató típusára és a használt 
kapcsolatra. 
 
Enable Raw File Types: Ez haladó beállítás és a legtöbb esetben figyelmen kívül 
hagyhatja. Ez az opció lehetővé teszi, hogy bizonyos fájl típusokat közvetlenül el 
lehessen küldeni a nyomtató formátumában, mint például nyers PCL, JPG vagy PS 
fájlokat. 
 



  

Használati útmutató  - 78 - 

Set As Default: Ha bekapcsolja ezt a jelölőnégyzetet, ez lesz az alapértelmezett 
nyomtató. 
 
Print Test Page: Ellenőrízheti a nyomtató beállításait és működését: teszt oldal 
nyomtatása. 
 

3. Érintse meg a Finish gombot a nyomtató hozzáadásához! 
 
MEGJEGYZÉS: A betárcsázós és a vezetéknélküli Internet csatlakozás 
használatához, az e-mail küldéshez/fogadáshoz, a vállalati hálózat 
használatához és egyéb vezetéknélküli kommunikációhoz, mint például a 
Bluetooth-képes eszközök használatához elképzelhető, hogy külön megvásárolható 
eszközökre van szükség a WLAN infrastruktúra és a külön megkötött szerződés 
mellett. Érdeklődjön a szolgáltatónál a szolgáltatás rendelkezése állásával és a 
lefedettséggel kapcsolatban. Elképzelhető, hogy bizonyos Web tartalmak nem 
érhetőek el. Bizonyos tartalmak eléréséhez elképzelhető, hogy külön programot 
kell telepíteni. 
 
 
Nyomtató eltávolítása a listából 
 
Ha el kíván távolítani egy nyomtatót a listából, jelölje ki a Configuration 
képernyőn, majd érintse meg a Remove gombot! 
 

 
 

Mivel véglegesen eltávolítja a nyomtatót, a készülék megkéri, hogy erősítse meg a 
törlést: 
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Érintse meg a Yes gombot! A nyomtató eltávolításra kerül a HP iPAQ-ról. 
 
Nyomtató módosítása a listában 
 
A Configuration képernyőn válassza ki a módosítandó nyomtatót, majd érintse 
meg a Modify... gombot! 
 

 
 
A következő képernyő attól függően változik, hogy milyen típusú nyomtatót 
választott. 
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Végezze el a kívánt módosításokat, majd érintse meg az Update gombot a 
módosítások mentéséhez, vagy a Cancel gombot a módosítások elvetéséhez! 
 
 
Rendszerbeállítások megváltoztatása 
 
A Configuration képernyőn elvégezheti a rendszer beállítások módosítását az 
alábbiakban bemutatott módon. 
 

 
 

Érintse meg a Configuration képernyő alján a System fület! Megjelenik a System 
Configuration (Rendszerbeállítások) képernyő az aktuális beállításokkal. 
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Ha szükséges, módosítsa a Bluetooth COM portot a HP iPAQ által használtra. A 
kimenő COM port azonosítása: 
 

1. A Start menüben érintse meg az iPAQ Wireless menüpontot vagy a 
képernyő alján, a parancssorban az iPAQ Wireless ikont! 

2. Az iPAQ Wireless képernyőn érintse meg a Bluetooth Settings gomb > 
Services fület! 

3. Érintse meg a Serial Port > Advanced... gombot! 
4. Végezze el a beállításokat! 
5. Érintse meg a jobb felső sarokban található OK gombot a változtatások 

elmentéséhez és a képernyő bezárásához! 
 

Print Manager 
 
Print Manager – áttekintés 
 
A Print Manager a HP Mobile Print által elküldött nyomtatási feladatokat kezeli. Ez 
az alkalmazás végzi el a nyomtatást. Ebben a programban tekintheti meg, hogy 
milyen nyomtatási feladatokat küldött el, melyek hajtódtak végre, milyen 
alapértelmezett tartalom átalakítók (Content Transformation Provider) vannak 
beállítva, és lehetőséget ad a nyomtatók beállítására. 
 
Az alapok 
 
A Print Manager elindításához érintse meg a Start > Programs > Print Manager 
menüpontot! 
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Az aktuális feladatok képernyő 
 
A Current Print Jobs (Aktuális feladatok) képernyő megjeleníti a HP Mobile Print-
nek elküldött nyomtatási feladatok listáját. A listában minden elem egy 
nyomtatásra várakozó feladatot jelent, és mutatja a nyomtatás sorrendjét. (Egy 
nyomtatási feladat több dokumentumot is tartalmazhat.) A szolgáltatásnak elküldött 
nyomtatási feladatok akkor lesznek elküldve, amikor a nyomtatási feladatot a 
nyomtató megkapja. Minden feladat mellett látható a nyomtató neve egy „+” vagy 
egy „-” jel mellett. A „+” megérintésével megnyithatja a listát és megtekintheti a 
feladat tulajdonságait. 
 
MEGJEGYZÉS: A feladatok a nyomtató neve alapján vannak azonosítva, ezért egy 
nyomtató többször is megjelenhet a listában. 
 

 
 

 
A részletek (Details) gomb 
 
A Details (részletek) gomb megmutatja, mely feladat áll éppen nyomtatás alatt, 
éppen milyen állapotban van, hová kerül kinyomtatásra, és milyen kapcsolaton 
keresztül. 
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A kinyomtatandó tétellel kapcsolatos részletes nézet megnyitásához válassza ki a 
tételt, majd érintse meg a Details... gombot! 
 
 
A törlés (Cancel) gomb 
 
Törölheti a dokumentum nyomtatását, ha a Current Print Jobs képernyőn megérinti 
a dokumentumot, majd a Cancel gombot. Az éppen nyomtatás alatt álló 
dokumentum nyomtatásánal törlése eltarthat pár percig. Az éppen nem nyomtatás 
alatt álló dokumentum nyomtatásának a törlése gyorsabb. 
 
Egy egész nyomtatási feladat törléséhez érintse meg a feladat nevét, majd a 
Cancel gombot! Az ebben a feladatban szereplő, még ki nem nyomtatott 
dokumentumok nyomtatása törlődik. 
 
 
A szünet/folytatás (Pause/Continue) gomb 
 
A Pause (szünet) vagy a Continue (folytatás) gomb megérintése átmenetileg 
felfüggeszti vagy újraindítja a nyomtatást. A Pause (szünet) megérintése után a 
gomb Continue (folytatás)-ra változik, és felfüggeszti a még ki nem nyomtatott 
dokumentumok nyomtatását a Continue megérintéséig. A Pause megérintésekor 
éppen nyomtatott dokumentum nyomtatása nem áll le, hanem befejeződik, ha nem 
törli a Cancel megérintésével. A nyomtatási listában következő dokumentum nem 
kerül kinyomtatásra a Continue megérintéséig. 
 
Ha hiba történik az éppen nyomtatás alatt álló dokumentumok egyikében, minden 
nyomtatási feladat automatikusan felfüggesztésre kerül és megjelenik egy kérdés, 
hogy mit kíván tenni. Ha úgy dönt, hogy kijavítja a hibát a folytatás előtt, a 
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nyomtatás továbbra is felfüggesztve marad. Érintse meg a Continue gombot a 
nyomtatás folytatásához a hiba kijavítása után! A nyomtatás a legutolsó 
dokumentummal folytatódik, amelyikben a hiba történt. 
 
 
Az Eszközök (Tools) menü 
 
Érintse meg a képernyő alján a Tools menüt az alábbi menü megnyitásához: 
 

 
 

Érintse meg a Past Print Jobs menüpontot a Past Print Jobs (Régi nyomtatási 
feladatok) képernyő megnyitásához! Itt a régi nyomtatási feladatokkal 
kapcsolatban találhat információkat. Érintse meg a Configuration menüpontot a 
nyomtató beállításainak megtekintéséhez! Érintse meg a Content Transformation 
Prefs menüpontot a tartalom átalakítók megtekintéséhez! Érintse meg a Logging 
menüpontot a Napló (Logging) megtekintéséhez! 
 
 
A régi nyomtatási feladatok (Past Print Jobs) képernyő 
 
A Past Print Jobs képernyőn a régi nyomtatási feladatok listája található. A 
feladatok mellett egy „+” vagy egy „-” jel mellett látható a nyomtató neve, 
amelyiken ki lett nyomtatva. Ha kibont egy tételt, láthatja a kinyomtatott 
dokumentumok listáját. 
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A részletek (Details) gomb 
 
Válasszon egy dokumentumot egy kibontott feladat listából, majd érintse meg a 
Details gombot a kinyomtatott tétel részletes adatainak megtekintéséhez! Ez a 
nézet megmutatja, melyik dokumentum lett kinyomtatva, mi volt a végső állapota, 
hová lett kinyomtatva, és melyik kapcsolaton keresztül lett kinyomtatva. 
 

 
 

 
A lista törlése (Clear List) gomb 
 
Érintse meg a Clear List gombot a Past Print Jobs képernyőn a lista törléséhez! 
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A beállítások (Configuration) képernyők 
 
A Configuration képernyő segítségével hozzáadhat, módosíthat és törölhet 
nyomtatókat, valamint megváltoztathatja a rendszer beállításait. Bővebb 
információt ezen fejezet „Beállítások” részében találhat. 
 
 
A Content Transformation Preferences képernyő 
 
Egy dokumentum kinyomtatásához azt át kell alakítani a cél eszköz számára 
felismerhető formátumra. Az alkalmazásfejlesztők feltelepíthetik a saját Content 
Transformation (CT, tartalom átalakító) moduljaikat, amely segítségével a fájlaik 
kinyomtathatóvá válnak. A Content Transformation Preferences képernyő 
megnyitásához érintse meg a Content Transformation Prefs menüpontot a Tools 
menüben! 
 
A Content Transformation Preferences képernyő két listából áll. A felső lista mutatja 
azokat a típusokat, amelyek kinyomtathatóak. Az alsó lista mutatja azokat a 
modulokat, amelyek átalakítját az adott fájl típust nyomtatható formátumra. 
Amennyiben egy nyomtatni képes alkalmazás nem választja ki magának, hogy 
melyik modult használja az adott típus kinyomtatásához, az alsó listában kijelölt 
modult fogja használni. A fájl típushoz a modul hozzárendeléséhez válassza ki a 
fájl típust a felső listából, majd a modult az alsó listából! 
 
Például egy bmp (bitmap) fájl kinyomtatható a HP vagy a WestTek által kínált CT 
modul segítségével. Amennyiben a program nem módosítja ezt a beállítást, a bmp 
fájlokat a WestTek modul segítségével fogja kinyomtatni, mivel az az aktuális 
beállítás. 
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A napló (Logging) képernyő 
 

 
 

A napló segítségével a HP Mobile Print egy naplófájlba rögzíti az esetleges 
problémák megoldásához szükséges információkat. 
 

• Off – kikapcsolja a naplózást 
• Low: Errors – csak a hibák kerülnek naplózásra 
• Medium: Warnings – több adat feljegyzése a történtekről 
• High: Informational – még több adat fejlegyzése a történtekről 

 
A naplózást általában kikapcsolhatja. A részletesebb naplózás befolyásolja a 
teljesítményt. 
 
 
Értesítések 
 
Ha nyomtatás közben nincs megnyitva a Print Manager, a címsorban értesítés 
jelenik meg. 
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Értesítés a nyomtatásról 
 

 
 

A nyomtatásról értesítés jelenik meg, ha egy feladat nyomtatásra kerül. Ha 
megérinti az értesítést, megjelenik egy buborék, amelynek segítségével könnyen 
megnyithatja a Print Manager-t az aktuális nyomtatási feladat állapotának 
megtekintéséhez. Érintse meg a Go To Print Manager gombot a Print Manager 
megnyitásához! 
 
 
Az értesítések beállítása 
 
Elvégezhet bizonyos beállításokat az értesítésekkel kapcsolatban a Start > Settings 
> Sounds & Notifications menüpont megérintésével és a Notifications fül 
választásával. 
 

 
 

Az nyomtatással kapcsolatos értesítések beállításai láthatóak. Bár teljesen nem 
kapcsolható ki ez az értesítés, de a viselkedése módosítható. Például a Play sound 
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jelölőnégyzet bekapcsolásával és egy hang fájl kiválasztásával beállítható, hogy 
minden alkalommal hangjelzést adjon, ha megjelenik vagy megváltozik az 
értesítő. Alapértelmezés szerint nem jeleníti meg a képernyőn az üzenetet. A 
Display message on screen bekapcsolásával ez nem változik meg. A Flash light for 
<időtartam> segítségével beállítható, hogy a készüléken található jelzőfény 
mennyi ideig villogjon a jelzés létrejöttekor. 
 
 
A hiba dialógusablak 
 
Hiba esetén a rendszer megkérdezi, hogy törölje-e a dokumentum nyomtatását, 
várjon, amíg a felhasználó kijavítja a hibát, vagy próbálja meg újra a nyomtatást.  
Ha ki kívánja javítani a problémát, érintse meg a Go to Print Manager gombot! A 
nyomtatás felfüggesztődik, amíg nem áll készen a folytatásra. A hiba kijavítása 
után a Print Manager-ben a Continue megérintésével folytathatja a nyomtatást. A 
nyomtatás a listában található következő dokumentummal folytatódik. 
 
 
A File Explorer használata fényképek nyomtatására 
 
A HP iPAQ-ról a File Explorer segítségével is nyomtathat fényképeket. A HP Mobile 
Printing Utility automatikusan létrehozza a támogatást az „érintés-és-tartás” 
nyomtatáshoz. 
 
Fénykép nyomtatása a File Explorer segítségével: 
 

1. Érintse meg és tartsa a tollat egy támogatott típusú fájlon! 
 
Megjelenik egy felbukkanó menü, amelyben szerepel a „Print” (nyomtatás) 
lehetőség. 
 

2. Érintse meg a menüben a Print menüpontot! 
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Nyomtatás a HP Instant Share segítségével 
 
A HP Instant Share segítségével beállíthatja, hogy a fényképek automatikusan 
kinyomtatásra kerüljenek, ha csatlakoztatja a HP iPAQ-ot a PC-hez. 
 
Fénykép nyomtatása a HP Instant Share Printing segítségével: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernyőn a Photos elemet! 

2. Válassza ki a kinyomtatni kívánt fényképet! 
3. Érintse meg a képernyő alján a parancssorban a File menüpontot! 
4. Érintse meg a Print (Nyomtatási) ablakban a Print lehetőséget, majd 

válassza a HP Instant Share Printing-et! 
5. Érintse meg a Next gombot! 
6. Állítsa be, hány példányt kíván nyomtatni! 
7. Érintse meg a Save gombot! 

 
Amikor legközelebb csatlakoztatja a készüléket a PC-hez, a HP Image Zone 
automatikusan kinyomtatja a fényképeket. 
 
MEGJEGYZÉS: A HP Instant Share működéséhez telepítenie kell a számítógépre a 
HP Image Zone for PCs programot. 
 
 
Nyomtatás memóriakártyáról 
 
Ha úgy kívánja kinyomtatni a fényképeit, hogy a memóriakártyát behelyezi egy 
HP nyomtatóba, a Move To card (Áthelyezés kártyára) funkciót kell használnia. 
Így a fényképek a HP nyomtató lehetőségeinek kihasználásához lehető legjobb 
könyvtárstruktúrába kerülnek. 
 
Fájl áthelyezése a memóriakártyára: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernypn a Photos lehetőséget! 

2. Válassza ki az áthelyezni kívánt fényképe(ke)t! 
 
MEGJEGYZÉS: Több fénykép mozgatásához érintse meg a Tools > Select > Range 
menüpontot! Érintse meg az áthelyezni kívánt tartomány első és utolsó fényképét! 
A kiválasztott fényképeken egy zöld zászló jelenik meg. 
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3. Érintse meg a képernyő alján a parancssorban a File menüpontot! 
4. Érintse meg a Move to > Card lehetőséget! 
5. Érintse meg a Yes gombot annak megerősítésére, hogy valóban át 

akarja helyezni a fájlokat! A HP Image Zone ellenőrzí, hogy a kártyán 
rendelkezésre áll-e kellő nagyságú szabad terület, és hogy minden 
kijelölt fájlt át lehet-e helyezni. 

6. Érintse meg a Move gombot! 
 
A képek a memóriakártyán a DCIM/100HPIPQ könyvtárba kerülnek. 
 
 
Megosztás 
 
A HP Image Zone és a HP Instant Share segítségével megoszthatja a képeit. 
Többek közt a következő szolgáltatások állnak rendelkezésére: 
 

• Fényképek elküldése e-mailben 
• Fényképek feltöltése 
• Nyomtatás 

 
A megosztás folyamatát az alábbi kép mutatja be. 
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1. Készítsen fényképeket a HP iPAQ Photosmart kamera segítségével! 
Jelölje ki a kinyomtatni vagy megosztani kívánt fényképeket! 

2. Szinkronizálja a HP iPAQ-ot a PC-vel! 
3. A fényképek automatikusan átkerülnek a számítógépre a My 

Documents/My Pictures mappából és az SD memóriakártyáról. 
4. A fényképek azonnal kinyomtatásra kerülnek, vagy el lesznek küldve a 

megadott e-mail címre. 
5. A HP Instant Share e-mail fogadója kap egy linket, amely segítségével 

megnézheti az Ön fényképeit a HP Instant Share weboldalon. Itt 
megtekinthetik és kinyomtathatják a fényképeket, válaszolhatnak az Ön 
e-mailjére, vagy továbbküldhetik a fényképeket másoknak. 

 
A HP Instant Share és a HP iPAQ Photosmart kamera használata: 
 

1. Hozzon létre egy ingyenes hozzáférést (ezt a HP Passport használatával 
csak egyszer kell megtennie)! 

2. Állítsa be a HP iPAQ-on a Share (Megosztás) menüben a célterületet 
(bármikor létrehozhat új beállítást, vagy módosíthatja a már meglévőt)! 

 
 
A Share (Megosztás) menü beállítása 
 
A HP Instant Share E-mail Share menü beállítása: 
 
MEGJEGYZÉS: A mellékelt CD-ről telepítenie kell a HP Image Zone for PCs 
programot a Share (Megosztás) menü beállítása előtt. 
 

1. Csatlakoztassa a HP iPAQ-ot a számítógéphez és végezzen 
szinkronizációt! 

2. Kapcsolódjon az Internethez! 
3. Kattintson duplán a számítógépen a HP Instant Share Setup ikonjára! 
4. Érintse meg a nyitóképernyőn a Start gombot! 
5. A HP Instant Share Destinations (Célterület) képernyőn érintse meg a 

Create gombot célterület létrehozásához! 
6. A Go Online (Csatlakozás) képernyőn érintse meg a Next gombot! 
7. Válassza ki a területet (régiót), hogy lássa, milyen szolgáltatások állnak 

rendelkezésre az Ön területén, majd a Feltételek (Acceptance of Terms) 
résznél kapcsolja be az I Agree (Elfogadom) jelölőnégyzetet! 

8. Érintse meg a Next gombot a folytatáshoz! 
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9. Adja meg a Sign-in with HP Passport (Bejelentkezés HP Passport-tal) 
képernyőn a felhasználói azonosítóját (HP Passport userid) és a 
jelszavát (Password)! Ha nem rendelkezik felhasználói azonosítóval és 
jelszóval, hozzon létre egyet! Kövesse a képernyőn látható linket! A HP 
Instant Share használatához mindenképpen szükséges egy Passport 
hozzáférés létrehozása. 

10. Érintse meg a Next gombot az Instant Share Services 
(Szolgáltatások) menü megnyitásához! 

11. A Share (Megosztás) képernyőn válassza ki a használni kívánt 
szolgáltatást (például e-mail vagy feltöltés weboldalra)! 

12. Kövesse a képernyőn látható utasításokat! 
13. Érintse meg a Save to my product lehetőséget a megadott 

célterületek elmentéséhez! 
14. Érintse meg az OK-t a mentéshez! Ennek hatására bezáródik a HP 

Instant Share beállító ablak. 
 
 
Fényképek megjelölése a célállomással 
 
A HP Image Zone lehetővé teszi, hogy megjelölje a fényképeket, hogy 
megoszthassa őket a HP Instant Share segítségével. A megjelölt fényképeket a HP 
Instant Share elküldi a legközelebbi kapcsolódás során. 
 
MEGJEGYZÉS: A HP Instant Share működéséhez telepítenie kell a HP Image Zone 
for PCs-t a számítógépre. 
 
Fénykép megjelölése: 
 

1. A Start menüben érintse meg a Programs > HP Image Zone menüpontot, 
vagy a Launch képernyőn a Photos elemet! 

2. Érintse meg a megosztani kívánt fénykép kisképét! 
 
MEGJEGYZÉS: Több fénykép megosztásához érintse meg a Tools > Select > Range 
menüpontot! Érintse meg a kijelölendő tartomány első és utolsó fényképét! A 
kijelölt fényképeken egy zöld zászló jelenik meg. 
 

3. Érintse meg a képernyő alján a parancssorban a File menüt! 
4. Érintse meg a Send-et a Send (Küldés) ablakban, és válassza a HP 

Instant Share E-Mail lehetőséget! 
5. Érintse meg a Next gombot! 
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6. A Share (Megosztás) menüben érintse meg a kiválasztott célállomás(ok) 
melletti jelölőnégyzete(ke)t! 

7. Érintse meg a Save-et! 
 
Amikor legközelebb összeköti a HP iPAQ-ot a PC-vel, a HP Instant Share 
automatikusan elküldi a képeket. 
 
 
E-mail csatolt állományok küldése 
 
E-mailben is elküldheti a fényképeket a HP Image Zone segítségével. 
 
Fényképek elküldése e-mailben a HP Image Zone-ból: 
 

1. Érintse meg az elküldendő fénykép kisképét! 
2. Érintse meg a File > Send > E-mail Attachment menüpontot, majd a Next 

gombot! 
3. Adja meg a címzett e-mail címét, vagy érintse meg a menüsorban a 

Contacts (Névjegyzék) ikont és válassza ki a címzett névjegyét! 
 
MEGJEGYZÉS: A csatolt fénykép az e-mail végén jelenik meg. 
 

4. Írja be a levél tárgyát és/vagy az üzenetet, majd érintse meg a Send-et! 
 
 

Fájlok küldése infravörös kapcsolaton 
 
A HP Image Zone-ból infravörös kapcsolaton is küldhet fájlokat más, infravörös 
porttal rendelkező eszközökre. 
 
Fénykép küldése az infravörös kapcsolaton: 
 

1. Érintse meg az elküldendő fénykép kisképét! 
2. Érintse meg a File > Send > Infrared menüpontot, majd a Next gombot! 
3. Helyezze el úgy a két készüléket, hogy az infravörös portok lássák 

egymást! 
4. Érintse meg a Send gombot! 
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Ötletek jobb fényképek készítéséhez 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak bizonyos HP iPAQ 
modelleken áll rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban 
(Accessories Brochure) talál bővebb információt a HP Photosmart kameráról. 
 
A lehető legjobb kép készítése érdekében fényképezéskor tartsa szem előtt a 
következőket: 
 

• Válassza a Best (legjobb) tömörítési beállítást, ha a kép sok apró 
részletet vagy sok színt tartalmaz! 

• Úgy fényképezzen, hogy ne jelenlenek meg világos fények a képen! 
• Állítsa be a fehéregyensúlyt a körülményeknek megfelelően! A 

következő esetekben válassza a None lehetőséget: 
• A beltéren készített fényképek elszíneződtek (kékesek vagy sárgásak) 
• A kép nagyrészt egyetlen domináns színből áll 
• Nincs fehér szín a képen 

 
A HP Photosmart kamerával kapcsolatban bővebb információt a készüléken 
található Súgóban talál. A Súgó elindításához a Launch képernyőn érintse meg a 
Start > Help > HP Photosmart menüpontot! 
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Ismerkedés az iPAQ Mobile Media-val 
 
 

Az iPAQ Mobile Media lehetőségei 
 
Az iPAQ Mobile Media a HP iPAQ rx3000-es sorozatú készüléken megtalálható 
előtelepítve. Az iPAQ Mobile Media segítségével tallózhat a zenék és videók 
között és lejátszhatja őket, valamint tallózhat a képek között vezetéknélküli 
hálózaton keresztül, bárhol a lakásban. Vezeték nélkül hallgathatja vagy nézheti a 
HP iPAQ-on a számítógépen tárolt digitális tartalmakat a streaming (áramoltatás) 
segítségével. Távirányítóként használhatja a HP iPAQ-ot a szórakoztató 
elektronikai berendezések vezérléséhez. 
 
Az iPAQ Mobile Media segítségével az alábbiakra nyílik lehetősége: 
 

• A HP iPAQ-on tárolt digitális tartalom lejátszása (Local Media mód) 
• A Wi-Fi hálózatba kötött számítógépeken található tartalom 

áramoltatása (streaming) a HP iPAQ-ra (Media Stream mód) 
• A Wi-Fi hálózatba kötött számítógépeken található digitális tartalom 

lejátszása és vezérlése (Media Control mód) 
• A számítógépen található digitális tartalom átvitele a HP iPAQ-ra a Wi-

Fi hálózaton keresztül (Media Copy mód) 
• Szórakoztató elektronikai eszközök távvezérlése (Home Control mód) 

 
A Local Media és a Home Control mód bármikor használható. A Media Control, 
Media Stream és a Media Copy mód használatához a HP iPAQ-on kívül a 
következőkre van szükség: 
 

• Működő Wi-Fi hálózat 
• Legalább egy, a hálózatba bekötött, Windows XP-t futtató számítógép 

(Home, Professional, Media Center vagy Tablet Edition) 
• A használni kívánt Windows XP PC-ken a Mobile Media for PC 

programnak kell futnia. (A Mobile Media for PC programot a 
készülékhez kapott CD-ről telepítheti.) 

 



  

Használati útmutató  - 98 - 

Az iPAQ Mobile Media-ról bővebb információt az online Súgóban találhat. A 
Súgó elindításához érintse meg a Start > Help > iPAQ Mobile Media menüpontot! 
 
A következő táblázatban megtalálja az iPAQ Mobile Media-ban látható ikonokat 
és gombokat. 
 
Ikon Leírás 

 
Media Control – a Wi-Fi hálózatba bekötött PC-n található digitális 
tartalom lejátszása és vezérlése. 

 
Media Stream – A Wi-Fi hálózatba bekötött PC-n található digitális 
tartalom áramoltatása a HP iPAQ-ra. 

 
Local Media – A HP iPAQ-on tárolt digitális tartalom lejátszása. 

 
Media Copy – A Wi-Fi hálózatba bekötött számítógépeken található 
digitális tartalom másolása a HP iPAQ-ra. 

 
Home Control – Szórakoztató elektronikai berendezések távvezérlése. 

 
A következő táblázat bemutat néhány, a menüben található ikont és az alapvető 
funkciójukat. 
 
Ikon Leírás 

 
Visszatér az iPAQ Mobile Media főmenübe. 

 
A List View (Listanézet) és a Controls View (Vezérlőelem nézet) között 
vált. 

 Médiafájlokat keres, ha a kiválasztott média szerver támogatja a 
keresést. 

 Megnyitja a Súgót. 

 
Megnyitja a Customize (Testreszabás) menüt. (Ez a menü módfüggő, 
az iPAQ Media módtól függő lehetősegeket tartalmazza.) 

 A helyi illetve a média szerverrel kapcsolatos információk 
megnyitása. 

 A használni kívánt média szerver kiválasztása. 
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Az iPAQ Mobile Media beállítása 
 
Az iPAQ Mobile Media előtelepítve megtalálható a HP iPAQ rx3000-es sorozatú 
készüléken. Az iPAQ Mobile Media elindításához érintse meg a Launch 
képernyőn a Start > Programs > iPAQ Mobile Media menüpontot! A Mobile Media 
gomb ( ) megnyomásával is elindíthatja a programot. 
 
A főmenü megjeleníti az iPAQ Mobile Media lehetséges üzemmódjait. A Local 
Media és a Home Control üzemmód bármikor használható. A Media Control, a 
Media Stream és a Media Copy mód a Wi-Fi hálózatot használja, és az ikonok 
szürkék az alábbi esetekben: 
 

• A Wi-Fi ki van kapcsolva a HP iPAQ-on. 
• A HP iPAQ Wi-Fi beállításai nem megfelelőek, így nem lehet csatlakozni 

a hálózathoz. 
• A vezetéknélküli hálózat hatótávolságán kívül tartózkodik. 
• A hálózathoz csatlakozó PC-ken nincs telepítve a Mobile Media for PC 

program, vagy nem fut. 
 

 
 

A Media Control, a Media Stream és a Media Copy módok csak a vezetéknélküli 
hálózatban használhatóak. A HP iPAQ beépített Wi-Fi hálózati kártyával 
rendelkezik, de a Wi-Fi hálózat használatához működő Wi-Fi hálózatra is szükség 
van. 
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A HP iPAQ beállítása a vezetéknélküli hálózathoz való csatlakozáshoz: 
 

1. Érintse meg az iPAQ Wireless ikont ( ) a Launch vagy a Today 
képernyő jobb alsó sarkában a Wi-Fi bekapcsolásához! 

2. Érintse meg a Wi-Fi gombot a bekapcsolásához! Az ikon sárgává 
változik a Wi-Fi bekapcsolt állapotában, ha pedig van kapcsolat, zöldre 

vált. Ha van kapcsolat, a menüsorban az ikon is látható. 
 
Ha most használja először a Wi-Fi hálózatot, olvassa el a 8-as fejezetet („A Wi-Fi 
használata”)! 
 

3. Érintse meg a Start > Settings > Connections fület, majd a Connections > 
Advanced fület! Válassza a Networks lehetőséget és állítsa be a 
„Programs that automatically connect to a private network should 
connect using” … (Internet szolgáltató) (Az automatikusan hálózathoz 
kapcsolódó programok a következő szolgáltatót használják: ) beállítást! 

 

 
 

4. Érintse meg az OK-t a Settings képernyőn, majd a Connections 
képernyőn, majd érintse meg a Network Card (Hálózati kártyák) ikont! 
Válassza ki a használni kívánt hálózat nevét a listából és érintse meg, 
majd ellenőrízze, hogy a munkahelyi (Work) hálózathoz csatlakozik-e! 
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5. Érintse meg az OK-t, amíg vissza nem ér a Launch képernyőhöz! Érintse 
meg a Mobile Media ikont az iPAQ Mobile Media elindításához! 

 
 

Az iPAQ Mobile Media telepítése a számítógépre 
 
A Media Control, a Media Stream és a Media Copy lehetőségek használatához 
telepítenie kell a Mobile Media komponenseket a számítógépre. A telepítés után 
az iPAQ Mobile Media a következő lehetőségekkel bővül: 
 

• Digitális tartalom áramoltatása a számítógépről a HP iPAQ-ra a Wi-Fi 
hálózaton keresztül (Media Stream mód) 

• Digitális tartalom lejátszása és vezérlése a Wi-Fi hálózatba kötött 
számítógépeken (Media Control mód) 

• Digitális tartalom lejátszása a hálózathoz csatlakoztatott uPnP média 
vevőn vagy lejátszón. A rendelkezésre álló lehetőségek az uPnP média 
vevő vagy lejátszó képességeitől függenek. 

• Digitális tartalom átvitele a számítógépről a HP iPAQ-ra a Wi-Fi 
hálózaton keresztül (Media Copy mód). 

 
MEGJEGYZÉS: A Mobile Media for PCs csak Windows XP (Home, Professional, 
Media Center, Tablet Edition) operációs rendszert futtató gépen használható. Nem 
telepíthető Windows 2000-t, Windows ME-t, Windows 98-at vagy Windows 95-öt 
használó számítógépre. 
 
 



  

Használati útmutató  - 102 - 

Rendszerkövetelmények 
 
A Mobile Media megfelelő használatához a következőkre van szükség: 
 

• 802.11 b/g Wi-Fi hálózat (a számítógépnek a hálózatba kötve kell 
lennie) 

• Microsoft Windows XP Home, Professional, Media Center vagy Tablet 
Edition 

• Microsoft ActiveSync 3.7.1 vagy újabb 
• 37-300MB lemezterület (a kiválasztott opcióktól illetve a rendszer 

konfigurációjától függően) 
• Ajánlott 256MB RAM 

 
 
A Mobile Media for PC telepítése: 
 

1. Tegye a HP iPAQ-hoz kapott CD-t a számítógép CD meghajtójába! 
2. A fő menüben válassza az Install Mobile Media for PC menüpontot! 
3. Kövesse a telepítő utasításait! 

 
A Mobile Media for PCs három alkalmazást telepít a számítógépre: 
 

• NevoMedia Server – A zenék, fényképek és videók összegyűjtésére és 
rendezésére való, valamint ezeknek a HP iPAQ-ra való áramoltatására, 
másolására, valamint a számítógépen a NevoMedia Player segítségével 
történő lejátszásukra. 

• NevoMedia Player – A digitális tartalmak lejátszása a számítógépen. 
• Nevo Backup – A Home Control beállítások elmentése és visszaállítása 

abban az esetben, ha elvesznének. 
 
A Mobile Media for PC telepítő befejeződése után a rendszer megkéri, hogy 
indítsa el a NevoMedia Server-t és a NevoMedia Backup-ot. Ezeket most is és 
később is elindíthatja a Start > All Programs > Hewlett-Packard > Mobile Media 
for PC menüpont alatt a számítógépen. Alapértelmezés szerint ez a három 
program automatikusan elindul a számítógép bekapcsolásakor és a tálcán futnak 
ikonizálva, amíg meg nem nyitja őket. 
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A NevoMedia Server első elindításakor megjelenik a NevoMedia Collection 
(Tartalom összegyűjtése) varázsló, amelynek segítségével gyorsan megkeresheti és 
elrendezheti a számítógépen található digitális média fájlokat. Alapértelmezés 
szerint az Express Setup indul el és a My Music, My Pictures ls My Video 
könyvtárakban keresi a média fájlokat. Ha máshol tárolja ezeket, válassza a 
Cutsom Setup lehetőséget! 
 
Ha jelentős mennyiségű média fájlt tárol a számítógépen, annak a katalogizálása 
néhány percet is igénybe vehet. 
 

Ha végzett, a NevoMedia Server készen áll. Kattintson az  ikonra a tálcán a 
NevoMedia Server megnyitásához! Ha a NevoMedia Server engedélyezett, az 
ikon jobb alsó sarkában egy zöld kör látható. 
 

A NevoMedia Player is elindul és a tálcán látható. Kattintson az  ikonra a 
program megnyitásához! Válassza a View menüből a Full Screen menüpontot a 
teljes képernyős nézethez! 
 

 
 

Végezze el a fenti lépéseket minden olyan Windows XP-s számítógépen, amelyet 
el akar érni az iPAQ Mobile Media segítségével! 
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A digitális média használata az iPAQ Mobile Media-val 
 
Az iPAQ Mobile Media lejátsza a hálózatba kötött számítógépeken és a HP 
iPAQ-on tárolt zenét és a videót, valamint megjeleníti a képeket. Az iPAQ Mobile 
Media használata előtt hasznos megismerni, hogyan érdemes a számítógépen és 
a HP iPAQ-on elrendezni a média fájlokat. Azt is jó tudni, hogy mely 
formátumokat támogatja az iPAQ Mobile Media. 
 
 

A támogatott média formátumok 
 
Az iPAQ Mobile Media a következő, nem másolásvédett média formátumokat 
támogatja: 
 

• Zene – .wma (Windows Media Audio) és .mp3 (minden üzemmódban a 
Media Stream mód kivételével). Az MP3 fájlok áramoltatása a 
számítógépről a HP iPAQ-ra nem támogatott. 

 
MEGJEGYZÉS: Az iPAQ Mobile Media nem játszik le másolásvédett média 
fájlokat. 
 

• Videó – .wmv (Windows Media Video) és .avi 
• Kép – .jpeg, .gif, .png, .bmp és .tif 

 
A nem támogatott formátumú fájlok is megjelennek a rendelkezésre álló média 
tartalmak között, de az iPAQ Mobile Media nem tudja lejátszani, hanem 
figyelmezteti Önt, hogy nem támogatott tartalmat próbált meg lejátszani. Az ilyen 
fájlok lejátszásához először át kell alakítania őket támogatott formátumra, vagy 
más, olyan alkalmazással kell lejátszania, ami támogatja ezt a formátumot. 
 
Ha másolásvédett zenével rendelkezik (vásárolta, vagy Ön tette másolásvédetté), 
olvassa el az „A Windows Media Player használata másolásvédett zene átvitelére 
és lejátszására” című részt! 
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A digitális tartalom elrendezése a számítógépen 
 
Alapértelmezés szerint a NevoMedia Server a My Documents könyvtár My Music, 
My Pictures és My Videos alkönyvtáraiban keresi a média fájlokat. Ha a 
telepítéskor az Express Setup lehetőséget választotta a Media Collection 
varázslónál, ezek a mappák már a könyvtárban vannak. 
 
Ha más könyvtárakban is vannak média fájlai, azokat át kell helyeznie a My 
Documents mappába, vagy a jelenlegi helyüket hozzá kell adni a könyvtárhoz. 
 
Új mappa hozzáadása a könyvtárhoz: 
 

1. Győződjön meg róla, hogy a NevoMedia Server fut! Ha nem fut, indítsa 
el a Start > All Programs > Hewlett-Packard > Mobile Media for PC > 
NevoMedia Server menüpontban! 

2. Kattintson duplán a NevoMedia Server ( ) ikonra a tálcán! 
3. Válassza a Media Collection-t, és kattintson a Run Media Collection 

Wizard lehetőségre! 
 

 
 

4. Kövesse a varázsló utasításait és válassza a Custom Setup lehetőséget! 
5. Válassza ki a megfelelő helyet a Folder View képernyőn! 
6. Kattintson a Next-re a mappa könyvtárhoz adásához! 
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Zenei CD-k és videók másolása 
 
Ahhoz, hogy a digitális médiához hozzáférjen az iPAQ Mobile Media 
segítségével, azt a számítógépen kell tárolnia és szerepelnie kell a NevoMedia 
Server könyvtárában. 
 
A nem a számítógépen tárolt videók és képek megtekintéséhez, valamint zene 
hallgatásához ezeket először át kell vinnie a számítógépre. 
 
 
Zene 
 
Hagyományos zenei CD másolása a számítógépre: 
 

1. Kattintson a Start > All Programs > Windows Media Player menüpontra! 
2. Tegye be a CD-t a számítógép CD-ROM meghajtójába! 
3. A Media Guide nézetben válassza a Copy from CD lehetőséget! 

Alapértelmezés szerint a CD a My Music könyvtárba másolódik .wma 
formátumban. 

 
MEGJEGYZÉS: A CD-ről lemásolt zene ellátható másolásvédelemmel. A 
másolásvédelem alapértelmezés szerint engedélyezett a Windows Media Player-
ben. A másolásvédelem engedélyezéséhez kattintson a Tools > Options > Copy 
Music fülre! A másolásvédett zenét az iPAQ Mobile Media nem képes lejátszani. 
A másolásvédett zenét csak a Windows Media Player tudja lejátszani. 
 
A zenei CD-ről lemásolt zenét a szerzői jogi törvények védik és Ön felelős a 
megfelelő felhasználásukért. 
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Házi videó 
 
Házi videó átvitele a számítógépre a Windows Movie Maker használatával: 
 

1. Indítsa el a Windows Movie Makert a Start > All Programs > Windows 
Movie Maker menüpontban! Ha nincs telepítve a Windows Movie 
Maker 2, töltse le az ingyenes változatot a Microsoft Windows Update 
oldalról a http://windowsupdate.microsoft.com oldalról! 
A következő utasítások a Windows Movie Maker 2-re vonatkoznak. 

2. Csatlakoztassa a videókamerát a számítógéphez! Ha a kamera nem 
csatlakoztatható közvetlenül a számítógéphez, elképzelhető, hogy 
kiegészítő hardver eszközök vásárlására van szükség. Bővebb 
információért olvassa el a kamera használati utasítását és a Windows 
Movie Maker 2 Súgó „Capturing Video” fejezetét! 

3. Indítsa el a kamerán a lejátszást a Play gombbal, majd a Windows 
Movie Maker 2-ben a felvételt a Capture-rel! 

4. Szerkessze a filmet, és adjon hozzá effekteket, ha kívánja! 
5. Fejezze be a film szerkesztését! 
6. Válassza a Save to my Computer lehetőséget! 

 

 
 

• Ha úgy akarja elmenteni a filmet, hogy a számítógépen lehessen 
lejátszani, kattintson a File > Save Movie File > My Computer > 
Next pontra! A Save Movie (Film elmentése) varázslóban adjon 
meg egy fájl nevet és a helyet, ahová a filmet menteni kívánja! 
Kattintson a Next-re! A film elmentése után kattintson a Finish-re! 

• Ha úgy akarja elmenteni a filmet, hogy a HP iPAQ-en lehessen 
lejátszani, a Save Movie (Film elmentése) varázslóban kattintson 

http://windowsupdate.microsoft.com
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a Show more choices… linkre, majd az Other settings: 
beállításnál válassza a Video for Pocket PC lehetőséget a 
legördülő menüből! 

 

 
 
MEGJEGYZÉS: A film digitalizálásával kapcsolatban bővebb információt a 
Windows Movie Maker súgójában találhat. A Windows Movie Maker 
segítségével alakíthatja át a videó fájlokat .wmv formátumúvá, hogy az iPAQ 
Mobile Media le tudja játszani. Használja a Windows Movie Maker 2-es vagy 
újabb verzióját! 
 
A HP Image Zone segítségével átviheti a fényképeket a számítógépre. A HP Image 
Zone-ról bővebb információt az 5. fejezetben („A digitális képkezelési funkciók 
használata”) találhat. 
 
MEGJEGYZÉS: A HP Image Zone alapértelmezés szerint a My Documents/My 
Pictures könyvtárba mentett képeket jeleníti meg. 
 
 

A digitális média elrendezése a HP iPAQ-on 
 
Az iPAQ Mobile Media segítségével megtekintheti és lejátszhatja a hálózatba 
kötött PC-ken található digitális médiát, valamint áramoltathatja ezeket a HP iPAQ-
ra. Ha nem éri el a hálózatot, és a Local Media módot használja, a HP iPAQ-on 
tárolt médiát is lejátszhatja, ehhez azonban először át kell másolnia a tartalmat a 
HP iPAQ-ra. 
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Digitális média – nem másolásvédett tartalom 
 
Többféle módon is vihet át tartalmat a HP iPAQ-ra.Tartalom átmásolása a 
hálózatba kötött számítógépről a HP iPAQ-ra: 
 

• Az iPAQ Mobile Media Media Copy módjában. A Media Copy mód 
részletesen be van mutatva ebben a fejezetben. 

• A Microsoft ActiveSync segítségével. A szinkronizáció engedélyezése: 
 

1. Indítsa el a Microsoft ActiveSync-et! 
2. A Tools menüben válassza az Options menüpontot! 
3. Jelölje ki a Files dobozt! 
4. A Settings dobozban adja meg, honnan kívánja szinkronizálni a 

fájlokat! (A számítógépen My Documents könyvtárban létrejön egy 
Pocket PC My Documents könyvtár.) 

5. Húzza át és helyezze ebben a mappába a média fájlokat! (Amikor 
a HP iPAQ-ot csatlakoztatja a PC-hez és az ActiveSync fut, a fájlok 
átmásolódnak.) 

 
 

• SD (Secure Digital) memóriakártya használatával. Ha a számítógépén 
van SD kártya olvasó: 

 
1. Helyezzen be egy SD kártyát! 
2. Másolja át a kívánt fájlokat erre a kártyára! 
3. Helyezze be az SD kártyát a HP iPAQ-ba, hogy az iPAQ Mobile 

Media elérje! (Az SD kártya külön kapható.) 
 
Local Media módban a média fájlok a fő memóriában tárolódnak a My Documents 
mappában (és nem az SD kártyán vagy az iPAQ File Store-ban). Ha máshol 
található média fájlokhoz kíván hozzáférni, módosítania kell az iPAQ Mobile 
Media beállításait, hogy az a megfelelő helyre mutasson. A beállítások 
módosítása: 
 

1. Indítsa el az iPAQ Mobile Media-t Local Media módban! 
2. Érintse meg a bal alsó sarokban a Wrench (Csavarkulcs) menüt, és 

válassza a Storage Settings menüpontot! 
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3. Érintse meg a + (plussz) jelet a My Documents mappa kibontásához, és 
válassza ki, mely könyvtárban keresse az iPAQ Mobile Media a 
fájlokat! 

 
MEGJEGYZÉS: A HP Image Zone alapértelmezés szerint a My Documents könyvtár 
My Pictures alkönyvtárában tárolja a képeket a HP iPAQ-on. Ha ezeket a képeket 
a HP Mobile Media segítségével kívánja megnézni, módosítania kell a 
beállításokat, hogy erre a könyvtárra mutasson. 
 
 

Másolásvédett zene (.wma formátum) 
 
Másolásvédett .wma formátumú zene átmásolásához és lejátszásához a Windows 
Media Player-t kell használnia. 
 
Másolásvédett .wma zene átmásolása a HP iPAQ-ra: 
 

1. Helyezze a HP iPAQ-ot a dokkolóra és kösse rá a szinkronizációs 
kábelt! 

2. Kösse össze a dokkolót és a számítógépet a szinkronizációs kábellel! 
3. Indítsa el a számítógépen a Windows Media Player-t! 
4. A Media Guide nézetben válassza a bal oldali menüből a Copy to CD or 

Device menüpontot! 
5. Az Items to Copy legördülő menüből válassza ki az átmásolni kívánt 

tételeket! 
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6. Válassza ki a készüléket az Items on Device legördülő menüből! 
 

 
 

7. Válassza ki, hová kívánja másolni az anyagot, majd válassza a jobb 
felső sarokban a Copy-t! 

 
MEGJEGYZÉS: Az iPAQ Mobile Media segítségével semmilyen módban sem 
játszhat le másolásvédett zenét, és a Media Copy mód segítségével sem másolhat 
másolásvédett zenét. Ha másolásvédett médiát kíván a HP iPAQ-ra másolni, 
használja a Windows Media Player-t a számítógépen! Ha másolásvédett tartalmat 
kíván lejátszani a HP iPAQ-on, a Windows Media Player-t kell használnia a HP 
iPAQ-on is. 
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A NevoMedia Server használata 
 
A NevoMedia Server összegyűjti és rendszerezi a fényképeket, zenét és videókat, 
és lehetővé teszi, hogy az iPAQ Mobile Media segítségével vezérelje, vagy a 
NevoMedia Player-rel lejátsza őket. A NevoMedia Server alapértelmezés szerint 
elindul a tálcán a számítógép bekapcsolásakor. Megnyithatja, ha duplán kattint 
az ikonra, vagy a jobb egérgomb segítségével megnyithat egy korlátozott 
lehetőségeket nyújtó kontextus menüt. 
 
 

A NevoMedia Server lehetőségei 
 
A NevoMedia Server fő menüje sok lehetőséget nyújt. 
 

 
 

A File menü 
 
A NevoMedia Server File menüjében két lehetőség áll rendelkezésére: 
 
MEGJEGYZÉS: A mappa neve oszlop melletti mappa ikon azt jelzi, hogy a 
könyvtár minden alkönyvtára át lett nézve. Ha ez az ikon nincs jelen, az azt 
jelenti, hogy csak az adott könyvtár lett átnézve. 
 

• Átnevezés (Rename) – Megváltoztathatja a média szerver nevét. Amikor 
a HP iPAQ-ról kapcsolódik a szerverhez, az új név jelenik meg a Media 
Server Selection (Média szerver választás) területen. 

• Kilépés (Exit) – Kilépés a NevoMedia Server-ből, és az ikon eltávolítása 
a tálcáról. 
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A View menü 
 
Két lehetőség áll rendelkezésére a NevoMedia Server View menüjében: 
 

• Listázás (List) – A NevoMedia által médiatartalmak keresése közben 
átnézett helyi könyvtárak egyszerű listája. 

• Részletek (Details) – A médiát tartalmazó mappák részletes nézete a 
számítógépen. A következőket láthatja: 
• Mappa nevek: a médiát tartalmazó könyvtár neve, általában My 

Music, My Pictures vagy My Videos. 
• Alkönyvtárak: a könyvtár által tartalmazott alkönyvtárak száma. 
• Fájlok: a könyvtárban (és nem alkönyvtáraiban) található fájlok 

száma. 
• Figyelem: jelzi, hogy a NevoMedia Server figyeli az adott 

könyvtárat, hogy történik-e benne változás (új média hozzáadása 
vagy média törlése). Az alapértelmezett beállítás az Igen. Ha 
kikapcsolja, a NevoMedia Server nem figyeli a könyvtárban 
végbemenő változásokat. 

• Állapot: négy lehetséges állapot van: 
• Szinkronizált: az adott könyvtáron minden feldolgozás lezajlott. 
• Feldolgozás alatt: az adott könyvtár feldolgozása folyamatban 

van. 
• Várakozik: az adott könyvtár feldolgozásra vár. 
• Megszakított: az adott könyvtár feldolgozás alatt volt, de valaki 

megszakította. 
• Szinkronizálási dátum: a fájlok legutóbbi szinkronizálásának dátuma. 
• Létrehozási dátum: a fájlok könyvtárhoz adásának dátuma. 
• Elérési út: a számítógépen a média könyvtár teljes elérési útja. 

 
MEGJEGYZÉS: Beállíthatja, hogyan jelenjenek meg a részletes nézetben az 
adatok. Mozgassa az egeret a kategória neve felé, és amikor az egér kétvégű 
nyíllá változik, húzza jobbra és balra az oszlopot a szélességének 
megváltoztatásához! Az oszlop címére való dupla kattintással megváltoztathatja a 
megjelenítés sorrendezését. 
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A Media Collection (Médiagyűjtemény) menü 
 
A NevoMedia Server Media Collection (Médiagyűjtemény) menüjében négy 
lehetőség áll rendelkezésére: 
 

• A Media Collection (médiagyűjtemény) varázsló futtatása – média 
hozzáadása az adatbázishoz a Media Collection varázsló segítségével. 

• Quick Add (gyors hozzáadás) – A NevoMedia Server média fájlokat 
keres a My Music, a My Pictures, a My Videos könyvtárakban, valamint 
az Ön által megadott könyvtárakban. 

• Scan (keresés) – média fájlok keresése egy megadott könyvtárban. 
• Remove (eltávolítás) – adott könyvtár eltávolítása a NevoMedia Server 

adatbázisából. 
 
 

A Tools (Eszközök) menü 
 
A NevoMedia Server Tools (Eszközök) menüjében öt lehetőség áll rendelkezésére: 
 

• Disable NevoMedia Server (A NevoMedia Server letiltása) – kapcsolja 
be ezt a lehetőséget a NevoMedia Server letiltásához. 

 
MEGJEGYZÉS: Ha letiltja a NevoMedia Server-t, a Media Control, a Media Stream 
és a Media Copy módok is letiltásra kerülnek a HP iPAQ-on (az ikonjuk szürkévé 
változik). 
 

• Launch NevoMedia Player at Startup (A NevoMedia Player elindítása a 
rendszer indulásakor) – kapcsolja be ezt a lehetőséget, ha azt akarja, 
hogy a NevoMedia Server elindulásakor a NevoMedia Player is 
automatikusan elinduljon. Ez az opció alapértelmezés szerint be van 
kapcsolva. 

• Database Tools (Adatbázis eszközök) – ebben a menüben adatbázis-
specifikus opciókat talál: 
• Validate Database (Adatbázis érvényesítése) – használja ezt a 

pontot az adatbázis érvényesítésére tartalom törlése illetve 
mozgatása után! 

• Drop All Rows (Tartalom törlése) – a NevoMedia Server 
adatbázisának törlése. Bár az adatok törlődnek, a könyvtárlista 
megmarad. Az adatok törlése után jelölje ki az összes könyvtárat és 
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hajtson végre keresést (a Scan (Keresés) ikon, vagy a Media 
Collection > Scan menüpont segítségével)! 

 
MEGJEGYZÉS: A Drop All Rows (Tartalom törlése) csak az adatbázis tartalmát törli, 
de a média fájlokat nem törli a számítógépről. 
 

• Rebuild Database (Adatbázis újraépítése) – a NevoMedia Server 
adatbázisának újraépítése. Ez a pont ugyanazt hajtja végre, mintha 
törölné az adatbázist, majd keresést hajta végre, de újra is 
számozza az adatbázisban található tételeket. 

 
 

A Help (Súgó) menü 
 
A NevoMedia Server Help (Súgó) menüjében az alábbi három lehetőség áll 
rendelkezésére: 
 

• NevoMedia Server Help (NevoMedia Server Súgó) – a NevoMedia 
Server súgó megtekintése. 

• Check for NevoMedia Server Updates (NevoMedia Server frissítések 
keresése) – a myNevo weboldal megnyitása és termékfrissítés keresése. 

• About NevoMedia Server (NevoMedia Server névjegy) – a NevoMedia 
Server adatainak (például verziószám) megtekintése. 
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NevoMedia Server ikonok 
 
A NevoMedia Server gyakran használt funkcióit az ikonokkal is elérheti. 
 
MEGJEGYZÉS: Először ki kell választania a média könyvtárat, különben az ikon 
inaktív és szürkén jelenik meg. 
 
Ikon Leírás 

 
A NevoMedia Collection varázsló megnyitása. 

 
A kiválasztott könyvtárak törlése a NevoMedia Server 
adatbázisából. 

 
Új média keresése a kiválasztott könyvtárban. 

 
Lista nézet és Vezérlés nézet közti váltás. 

 
Jelzi, hogy a NevoMedia Server le van tiltva. 

 
Ha a NevoMedia Server engedélyezett, ezzel az ikonnal 
letilthatja, majd újra engedélyezheti. 

 
 
 

A Context (Környezetfüggő) menü 
 
A Context menüt a számítógépen a tálcáról nyithatja meg. Ha a NevoMedia 
Server engedélyezve van, de az ablakot becsukta, egy ikon jelenik meg a 
számítógépen a tálcán. Kattintson a jobb egérgombbal az ikonra az alábbi 
menüpontok eléréséhez: 
 

• Open NevoMedia Server (A NevoMedia Server megnyitása) 
• Disable NevoMedia Server (A NevoMedia Server letiltása) 
• Quick Add… (Gyors hozzáadás) 
• Media Collection Wizard (Médiagyűjtemény varázsló) 
• Scan All (Átvizsgálás) 
• Exit (Kilépés) 
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Az általános NevoMedia Server feladatok végrehajtása 
 

Könyvtár átvizsgálása 
 
A Media Collection (Médiagyűjtemény) varázsló használatakor a NevoMedia 
Server automatikusan átvizsgálja a számítógépen a média könyvtárakat, valamint 
minden „figyelt” („watch”) változást átvezet az adatbázisba. Időnként ajánlott 
ezeket a könyvtárakat átvizsgálni a fájlok és könyvtárak frissítése érdekében. Az 
átvizsgálást kézileg is kezdeményezheti az ikonok illetve a legördülő menü 
használatával. 
 
Könyvtár átvizsgálása: 
 

1. Válassza ki az átvizsgálni kívánt könyvtárat! 
 
MEGJEGYZÉS: Az átvizsgálás funkció inaktív, ha nem választott ki könyvtárat. A 
funkció inaktív voltát az ikon vagy menüpont szürke állapota jelzi. 
 

2. Kattintson a Media Collection > Scan menüpontra! (A NevoMedia Server 
megkeresi a kiválasztott könyvtárban található új média fájlokat. Az 
átvizsgálás ideje alatt a NevoMedia Server le van tiltva.) 

 
 

A média lista frissítése 
 
A NevoMedia Server automatikusan frissíti az adatbázisát, ha új fájlt másol, vagy 
fájlt töröl az adatbázishoz hozzáadott könyvtárba vagy könyvtárból. Kézileg is 
átvizsgálhatja a könyvtárakat az új média fájlok után kutatva. 
 
MEGJEGYZÉS: Először hozzá kell adnia a könyvtárat a NevoMedia Server 
adatbázisához. 
 

1. A lista vagy a részletes nézetben válasszon ki egy könyvtárat! Több 
könyvtár kiválasztásához tartsa lenyomva a Ctrl gombot a kiválasztás 
során! 

2. Kattintson a Media Collection > Scan menüpontra! 
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A szerveren tárolt média adatainak megtekintése 
 
Ha a NevoMedia Server-en tárolt média részletes adataira kíváncsi, válassza a 
részletes nézetet (Details View)! Kétféleképpen tekintheti meg a részleteket: 
 

• Kattintással válthat a nézetek között. 
• Kattintson a View > Details menüpontra! (Listanézetre váltás: View > 

List.) 
 
MEGJEGYZÉS: Akár lista, akár részletes nézetben, ha duplán kattint egy 
könyvtárra, megjelenik a File Explorer ablak és megtekintheti a könyvtár tartalmát. 
 
 

Média könyvtárak eltávolítása 
 
Könyvtárakat az ikonok vagy a legördülő menü segítségével távolíthat el. 
Könyvtárak eltávolítása: 
 

1. Válassza ki az adatbázisból eltávolítani kívánt könyvtárat! 
 
MEGJEGYZÉS: Ha nem választott ki könyvtárat, az eltávolítás funkció inaktív. Az 
inaktív állapotot az ikon vagy a menüpont szürke volta jelzi. 
 

2. Kattintson a Media Collection > Remove menüpontra! (A Del billentyűt is 
megnyomhatja.) A megerősítő kérdésre válaszoljon Yes-t! 

 
MEGJEGYZÉS: A könyvtárak eltávolításakor a NevoMedia Server letiltódik az 
adatbázis frissítésének idejére. 
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A teljes gyűjtemény eltávolítása 
 
A teljes gyűjteményt az adatbázis eszközök segítségével távolíthatja el a 
NevoMedia Server-ből. 
 
Kattintson a Tools > Database Tools… menüpontra, majd válassza a Drop All Rows 
menüpontot! A figyelmeztető üzenetre válaszoljon OK-t! 
 
MEGJEGYZÉS: A teljes gyűjtemény eltávolítása esetén újra kell építenie az 
adatbázist, ha le szeretne játszani vagy a HP iPAQ-ra szeretne áramoltatni 
valamilyen médiát. 
 
 

Kilépés a NevoMedia Server-ből 
 
A NevoMedia Server-ből való kilépéshez válassza a File > Exit menüpontot! Ha 
bekapcsolta a Launch NevoMedia Player at Startup (NevoMedia Player indítása 
induláskor) lehetőséget, a NevoMedia Player is kilép a NevoMedia Server 
leállításakor. 
 
MEGJEGYZÉS: Csak az a NevoMedia Player változat lép ki a NevoMedia Server 
leállításakor, amelyik azzal együtt lett indítva. 
 
A programok újraindításához kattintson a Start > All Programs > Hewlett-Packard 
> Mobile Media for PC > NevoMedia Server menüpontra! 
 
 

A NevoMedia Player használata 
 
A NevoMedia Player segítségével a számítógépét digitális médialejátszóként 
használhatja: zenét és videót játszhat le, valamint képeket nézegethet. A 
NevoMedia Player csak a NevoMedia Server-hez hozzáadott tartalom 
lejátszására képes. A NevoMedia Player használata előtt a digitális médiát a 
NevoMedia Server-rel katalogizáltatnia kell, ezzel kapcsolatban bővebb 
információt a NevoMedia Server-ről szóló részben talál. 
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A NevoMedia Player lehetőségeit a fő menüből érheti el. Nézhet képeket, 
videókat valamint a zenéhez társított vizualizációs hatásokat. A vizualizációs 
hatásokat a Windows Media Player-ben állíthatja be. Az ablak tetején található 
legördülő menük segítségével hajthatja végre a műveleteket, vagy a Context 
(Környezetfüggő) menü segítségével. 
 

 
 

A NevoMedia Player a NevoMedia Server elindulásakor automatikusan elindul, 
ha nem változtatta meg a NevoMedia Server alapértelmezett beállítását. 
 
Kézzel is elindíthatja a NevoMedia Player-t a Start > All Programs > Hewlett-
Packard > Mobile Media for PC > NevoMedia Player menüpontban. 
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A NevoMedia Player lehetőségei 
 

A File menü 
 
A NevoMedia Player File menüjében két lehetőség áll rendelkezésére: 
 

• Rename (Átnevezés) – A média lejátszó nevének megváltoztatása. 
Amikor a HP iPAQ-ról csatlakozik a lejátszóhoz, az új név jelenik meg a 
Media Player részben. 

• Exit (Kilépés) – Kilépés a NevoMedia Player-ből. 
 
MEGJEGYZÉS: Ha a Close (Bezárás) ikonra kattint, a NevoMedia Player eltűnik, 
míg újból nem játszik le vele médiát. 
 
 

A View (Nézet) menü 
 
A NevoMedia Player View (Nézet) menüjében két lehetőség közül választhat: 
 

• Full Screen (Teljes képernyő) – váltás a teljes képernyős és a normál 
nézet között. A teljes képernyős módból való kilépéshez válassza a Full 
Screen menüpontot a Context menüből vagy kattintson duplán a 
NevoMedia Player ablakában! 

• Now Playing (Lejátszás) – adatok megjelenítése és elrejtése (média 
címe, időtartam, előadó, mappa). 

 
MEGJEGYZÉS: A View menüben a lejátszás alatt álló média típusa és címe is 
megjelenik. A View menü segítségével választhat a lejátszás alatt lévő médiák 
között. 
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A Help (Súgó) menü 
 
A NevoMedia Player Help (Súgó) menüjében három lehetőség közül választhat: 
 

• NevoMedia Player Help Topics (NevoMedia Player súgó tartalom) – a 
NevoMedia Player súgójának megnyitása. 

• Check for Updates (Frissítések keresése) – a myNevo weboldal 
megnyitása és termékfrissítés keresése. 

• About NevoMedia Player (NevoMedia Player névjegy) – adatok a 
NevoMedia Player-ről, mint például verziószám. 

 
 

A Context (Környezetfüggő) menü 
 
A Context (Környezetfüggő) menü megnyitásához kattintson a jobb gombbal a 
NevoMedia Player programban! A következő lehetőségek állnak rendelkezésére: 
 

• Full Screen (Teljes képernyő) 
• Rename (Átnevezés) 
• Kiválaszthatja a lejátszani kívánt médiát. 

 
 
 

Általános NevoMedia Player feladatok végrehajtása 
 

Többféle média párhuzamos lejátszása 
 
A NevoMedia Player segítségével párhuzamosan lejátszhat különböző típusú 
médiákat. Például lejátszhat egy zenét a nyaralás fényképeinek nézegetése 
közben. 
 
A HP iPAQ segítségével kiválaszthatja a lejátszani kívánt médiát. A médialejátszó 
kiválasztása után válassza ki a megtekinteni kívánt médiát! A View (Nézet) 
menüben kövesse a következő lépéseket: 
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1. Válassza a View-t a View menü megnyitásához! 
2. A lejátszás alatt álló médiák közül kattintson egyre annak a 

kiválasztásához! 
 
 

Váltás teljes képernyős és normál mód között 
 
A digitális média fájlokat megtekintheti a normál képernyőméretben, vagy 
átméretezheti az ablakot a sarkok húzásával, valamint teljes képernyős módba 
válthat (View > Full Screen menüpont, a lejátszó ablaka betölti a képernyőt). 
 
Váltás teljes képernyős módból normál módba: 
 

1. Kattintson a jobb gombbal a képernyőn a környezetfüggő menü 
megnyitásához! 

2. Válassza a Full Screen menüpontot! A lejátszó ablaka normál méretűvé 
válik. 

 
MEGJEGYZÉS: A NevoMedia Player indulásakor normál képernyő módban indul. 
A NevoMedia Player-ből való kilépéshez vissza kell térnie normál képernyős 
módba. 
 
 

A lejátszás alatt lévő média adatainak megtekintése 
 
A View (Nézet) menü Now Playing menüpontjában megtekintheti a lejátszás alatt 
álló média adatait. 
 
A funkció eléréséhez kattintson a View > Now Playing menüpontra! 
 

• A funkció melletti pipa jelzi, hogy a Now Playing funkció be van 
kapcsolva. Kikapcsolásához kattintson a Now Playing-re! A Now 
Playing bekapcsolt állapotában a NevoMedia Player adatokat jelenít 
meg a lejátszás alatt álló fájlról. Az, hogy milyen adatok jelennek meg, 
a média típusától függenek: 
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• Zene 

• Cím 
• Időtartam 
• Előadó 
• Album 

• Kép 
• Cím 
• Mappa 

• Videó 
• Cím 
• Mappa 

 
Ha a Now Playing mellett nincs pipa, az azt jelzi, hogy a funkció ki van 
kapcsolva. Bekapcsolásához kattintson a Now Playing-re! 
 
MEGJEGYZÉS: Alapértelmezés szerint a Now Playing funkció be van kapcsolva. 
 
 
 

Kilépés a NevoMedia Player-ből 
 
A NevoMedia Server bezárásakor a NevoMedia Player automatikusan kilép, ha 
nem változtatta meg a NevoMedia Server alapértelmezett beállítását. 
 
MEGJEGYZÉS: A NevoMedia Server beállításaival kapcsolatban bővebb 
információt a NevoMedia Server súgójában találhat: Start > Help > Nevo. 
 
A NevoMedia Player-ből való kilépéshez kattintson a File > Exit menüpontra! 
 
MEGJEGYZÉS: Ha a Close (Bezárás) ikonra kattint, a NevoMedia Player el lesz 
rejtve, míg újra médiát nem játszik le vele. 
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A NevoBackup használata 
 
A NevoBackup a NevoMedia Server-rel és a NevoMedia Player-rel kerül 
telepítésre, amikor a mellékelt CD-ről telepíti a Mobile Media for PC-t. Ez a 
program megakadályozza, hogy elvesszenek a Universal Remote Control 
(Univerzális Távirányító) beállításai az akkumulátor lemerülése illetve a HP iPAQ 
teljes újraindítása esetén. 
 
A NevoBackup telepítése után, ha fut, a két legutóbb használt 
szórakoztatóelektronikai eszközhöz tartozó beállítások automatikusan elmentésre 
kerülnek, amikor a HP iPAQ-ot a dokkolóba helyezi. A két elmentett beállítás neve 
Current Configuration (Aktuális konfiguráció) és Previous Configuration (Előző 
beállítás). A varázsló segítségével egyéni mentési pontokat is megadhat egy adott 
konfiguráció elmentéséhez. A NevoBackup a számítógép bekapcsolásakor 
automatikusan elindul. A NevoBackup-ot elindíthatja, ha jobb gombbal kattint a 

tálcán az ikonra ( ), vagy a Start > All Programs > Hewlett-Packard > Mobile 
Media for PC > NevoBackup menüpontban. 
 
MEGJEGYZÉS: A NevoBackup működéséhez a Microsoft ActiveSync-nek telepítve 
kell lennie. 
 
A NevoBackup-nak két alapvető funkciója van: Create a custom backup of my 
current Nevo Configuration (Egyedi mentés készítése az aktuális Nevo 
beállításokról) és Restore my Nevo configuration to an earlier backup (Nevo 
beállítások visszaállítása egy korábbi mentésnek megfelelően). A két legutóbbi 
beállítás automatikusan elmentésre kerül. 

Egyedi mentés létrehozása 
 

1. Helyezze a HP iPAQ-ot a dokkolóra vagy csatlakoztassa hozzá a 
szinkronizációs kábelt! 

2. Kattintson a tálcán a jobb egérgombbal a NevoBackup ikonra ( ), 
és válassza az Open menüpontot! 

3. A Welcome képernyőn nyomja meg a Next gombot! 
4. A Backup Tasks képernyőn válassza a Create a custom backup of my 

current Nevo configuration lehetőséget, majd nyomja meg a Next 
gombot! 
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5. Adjon egy kifejező nevet az elmentendő beállításoknak, majd nyomja 
meg a Next gombot a mentéshez! 

6. Visszakerül a Backup Tasks képernyőre, ahol végrehajthat másik 
feladatot, vagy a Cancel gombbal kiléphet a NevoBackup-ból. 

 

 
 

Korábbi mentés visszaállítása 
 

1. Helyezze a HP iPAQ-ot a dokkolóra vagy csatlakoztassa a 
szinkronizációs kábellel! 

2. Kattintson a tálcán a jobb egérgombbal a NevoBackup ikonra ( ), 
majd válassza az Open menüpontot! 

3. A Welcome képernyőn nyomja meg a Next gombot! 
4. A Backup Tasks képernyőn válassza a Restore my Nevo configuration to 

an earlier backup lehetőséget! 
5. Válassza ki a listából a megfelelő mentést, majd nyomja meg a Next 

gombot! 
6. A Restore képernyőn nyomja meg a Next gombot a visszaállításhoz! 
7. Visszakerül a Backup Tasks képernyőre, ahol végrehajthat másik 

feladatot, vagy a Cancel gombbal kiléphet a NevoBackup-ból. 
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Az iPAQ Mobile Media elindítása 
 
Az iPAQ Mobile Media elindításához a Launch vagy a Today képernyőn érintse 

meg a Start > iPAQ Mobile Media menüpontot! A Mobile Media gomb ( ) 
megnyomásával is elindíthatja az iPAQ Mobile Media-t. 
 
Az iPAQ Mobile Media elindításakor a vezetéknélküli hálózaton megkeresi a 
rendelkezésre álló média szervereket és lejátszókat. 
 
Ha új média szerver vagy lejátszó válik elérhetővé, megjelenik egy ikon a 
menüsorban. Az ikon megérintésekor megjelenik a rendelkezésre álló média 
szerverek és lejátszók listája. Média szerver vagy lejátszó leállításáról szintén a 
menüsorból, ugyanezzel az ikonnal értesülhet. Az ikon megérintésekor megjelenik 
az elérhetetlenné vált média szerver vagy lejátszó neve. 
 

Az iPAQ Mobile Media irányítása 
 
Az iPAQ Mobile Media fő menüjében a következő lehetőségek állnak 
rendelkezésére: 
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MEGJEGYZÉS: Az iPAQ Mobile Media elindításakor elképzelhető, hogy akár 60 
másodpercet is várnia kell minden ikon aktiválódásához akkor is, ha minden jól 
be van állítva. 
 
MEGJEGYZÉS: A mód ikonok megérintésekor a Mobile Media a képernyő közepén 
egy „foglalt” ikont jelenít meg az üzemmód elindítása közben. Ez az ikon lehet 
egy mappa, médialejátszó, rádió antenna, hangjegy, kép, videófilm, vagy a 
Mobile Media ikon. 
 
 

A Media Play képernyők irányítása 
 
Média típus (zene, kép, videó) kiválasztásakor megjelenik a média List View 
(Listanézet) képernyő, ahonnan könnyen elérheti a média fájlokat. 
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Irányítás a felbukkanó menükkel 
 
Az iPAQ Mobile Media a felbukkanó menük segítségével is irányítható. Például 
egy ilyen menü a Select Media Server (Médiaszerver kiválasztása) menü. 
 
Másik tétel kiválasztása: 
 

 
 

• Érintse meg a toll használatával! 
• Használja a tapipadot! 

 
 

Irányítás a listanézettel 
 
Ha a listanézetből kíván lejátszani zenét, egyszerűen érintse meg a kívánt zenét! 
Könnyen válthat a listanézet (List View) és a vezérlő nézet (Control View) között a 

képernyő jobb felső sarkában található  és az  ikonok megérintésével. 
 
Vezérelheti is a zene lejátszását. A következő táblázat mutatja a lehetőségeket: 
 
Gomb Leírás 

 Zene lejátszásának megállítása. 

 
Hangerő szabályozása. 

 Hang elnémítása. 



  

Használati útmutató  - 130 - 

 
 

Irányítás a vezérlő nézettel 
 
A vezérlő nézet további lehetőségeket kínál a lejátszás vezérlésére. Az alábbi 
táblázat mutatja a zene lejátszása közben rendelkezésére álló vezérlőket. 
 
Ikon Leírás 

 Lejátszás elindítása (ha nincs folyamatban lejátszás, egyébként 
lejátszás felfüggesztése). 

 Lejátszás felfüggesztése (ha a lejátszás folyamatban van, 
egyébként lejátszás indítása). 

 Ugrás a következő számra. 
 Ugrás az előző számra. 
 Véletlenszerű választás a listából. 
 Az utolsó szám lejátszása után a lejátszás újraindítása. 

 
Időtartam szabályozása. 

 
 

A tárolás helyének kiválasztása 
 
A letöltött médiát tárolhatja közvetlenül a HP iPAQ-on, vagy egy opcionális 
bővítőkártyán (SD kártya). A bővítőkártyákkal és a tárhellyel kapcsolatban bővebb 
információt a „Bővítőkártyák” című részben találhat. A tárolás helyének beállítása: 
 

1. A My Videos képernyőn válassza a Local Library legördülő menüt! 
Megjelenik a Storage Settings (Tárolási beállítások) képernyő. 

2. Válassza ki, hol kívánja tárolni a média fájlokat! Az alábbiak közül 
választhat: 

 
• My Documents (alapértelmezett) 
• iPAQ File Store 
• SD kártya (javasolt) 

 
3. Érintse meg az OK-t! 

 
MEGJEGYZÉS: A kiválasztott mappában rendelkezésre álló tárhelyet megtekintheti 
a Download eszköztárban. 
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Gyorslinkek 
 
A gyorslinkek (Quick Links) segítségével áttekintheti a kiválasztott média fájl 
struktúráját, hogy egyetlen érintéssel átválthasson más könyvtárakra. A gyorslinkek 
megnyitása: 
 

1. A listanézetben érintse meg a Quick Links (Gyorslinkek) nyilat! 
Megnyílik a Quick Links (Gyorslinkek) menü. 

2. Érintse meg a kívánt könyvtárat vagy tételt! 
 

 
 

Lejátszott tétel 
 
A Gyorslinkekhez hasonlóan a Currently Playing (Lejátszott tétel) felbukkanó 
menüben megtekintheti a lejátszott média típusát és címét. Ebben a menüben 
kiválaszthatja, hogy milyen médiát kíván vezérelni. A Currently Playing felbukkanó 
menü megnyitása: 
 

1. Vezérlő nézetben (Control View) érintse meg a Currently Playing nyilat! 
Megnyílik a Currently Playing (Lejátszott tétel) menü. 

2. Másik média vezérléséhez érintse meg a címét! 
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Digitális média lejátszása a HP iPAQ-on 
 
Kétféleképpen játszhat le digitális médiát a HP iPAQ-on: 
 

• A helyi könyvtárban tárolt média lejátszása (Local Media mód) 
• Média áramoltatása a média szerverről a HP iPAQ-ra (Media Stream 

mód) 
 
 

Helyben tárolt média lejátszása (Local Media mód) 
 
Helyben tárolt média lejátszásához azt először el kell tárolnia a helyi könyvtárban. 
Elképzelhető, hogy a HP iPAQ-on van elég hely a média tárolására, de lehet, 
hogy vásárolnia kell egy Secure Digital (SD) kártyát. 
 
MEGJEGYZÉS: A helyi média alapértelmezett tároló helye a \My Device\My 
Document mappa. 
 
MEGJEGYZÉS: Mivel a HP iPAQ-nak a programok futtatásához helyre van 
szüksége, ajánlott, hogy a média tárolásához vásároljon egy Secure Digital (SD) 
kártyát. A bővítőkártyákról bővebb információt a 11. fejezetben („Bővítőkártyák”) 
találhat. 
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A média helyének beállítása 

1. A Local Media mód beállításához érintse meg az  ikont a Mobile 
Media képernyőn! Megjelenik a Local Media képernyő. 

2. Érintse meg a képernyő alján található felbukkanó menüt! 
3. A felbukkanó menüben válassza ki a média helyét a kívánt opció 

megérintésével: 
 

 
 

MEGJEGYZÉS: Az egyszerre használt médiák egyetlen, egyszintű könyvtárban 
kerülnek tárolásra. Hierarchikus fájl struktúra létrehozása esetén a pontos helyet 
adja meg a Customize menü Storage Settings (Tárolás beállításai) pontjában! 
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A helyi média testreszabása 
 

A  felbukkanó menüben az üzemmódtól függően különböző lehetőségek 
állnak a rendelkezésére. A Local Media Customize menüben a következőkre nyílik 
lehetősége: 
 
Menü opció Funkció 
Change Display on Play 
(Kijelzés változtatása 
lejátszáskor) 

Állítsa be, hogy a Mobile Media automatikusan vezérlő 
nézetre váltson a lejátszás elindításakor! A funkció ismételt 
megérintésével visszaállíthatja az eredeti állapotot. 

Play All (Minden 
lejátszása) 

Minden zene lejátszása a kiválasztott könyvtárból. 

Refresh Servers and 
Players (Szerverek és 
lejátszók frissítése) 

A média szerverek és lejátszók listájának frissítése. 

Refresh Folder (Mappa 
frissítése) 

A helyi könyvtárban található tételek listájának frissítése, 
vagy a kijelölt mappa frissítése. 

Storage Settings… 
(Tárolási beállítások) 

A Storage Settings (Tárolási beállítások) képernyő 
megnyitása. 

Delete (Törlés) Média törlése a helyi könyvtárból. MEGJEGYZÉS: Törlés 
előtt ki kell választania a média típusát (zene, képek vagy 
videók). A média törlésével kapcsolatban bővebb 
információt a „Média törlése” című részben találhat. 

About iPAQ Mobile 
Media (iPAQ Mobile 
Media névjegy) 

Az iPAQ Mobile Media-val kapcsolatos információk 
megjelenítése, mint például verziószám. Érintse meg a 
Close-t a képernyő bezárásához! 

 
 

Zene lejátszása 
 
Miután elmentette a zenét a HP iPAQ-ra, meg is hallgathatja. 
 

1. A Local Media képernyőn érintse meg a My Music pontot! Megjelenik a 
My Music menü. 

 



  

Használati útmutató  - 135 - 

 
 

2. Lejátszás indítása: 
a) Keresse meg a zenét, majd érintse meg, vagy 
b) ha a felbukkanó menü, valamint a felfelé és a lefelé nyilak 

segítségével mozog, nyomja meg a tapipadot! 
 
 

Zene lejátszás vezérlése 
 
Kétféle My Music képernyőnézetből választhat: lista nézet (List View) és vezérlő 
nézet (Control View): 
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MEGJEGYZÉS: A helyi média lejátszásakor a My Music képernyő alapértelmezés 
szerint vezérlő nézetben van, ha a Custiomize menü Change Display to Play pontja 
engedélyezve van. Ha azt akarja, hogy a listanézet legyen az alapértelmezett, 
kapcsolja ki a Change Display on Play opciót a Customize menüben! 
 

Képek megnézése 
 
A HP iPAQ-on sok különböző formátumú képet megnézhet. 
 
MEGJEGYZÉS: A képek megnézése előtt hozzá kell adnia őket a helyi 
könyvtárhoz. 
 

1. A Local Media képernyőn érintse meg a My Pictures pontot! Megjelenik 
a My Pictures menü: 

 

 
 

2. Érintse meg a megnézni kívánt képet! 
 
MEGJEGYZÉS: A média megnyitásakor a nézet automatikusan vezérlő nézetre vált, 
mert a Change Display on Play opció alapértelmezés szerint be van kapcsolva. 
 
MEGJEGYZÉS: A média helyét a My Pictures képernyőn is megváltoztathatja. Ha 
így tesz, megjelenik a Local Media képernyő és ismét ki kell választania a My 
Pictures pontot. 
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A képek vezérlése 
 
A My Music képernyőhöz hasonlóan a My Pictures képernyőnek is két különböző 
nézete van: a lista és a vezérlő nézet. 
 

 
 

MEGJEGYZÉS: A Local Media elindításakor a My Pictures képernyő vezérlő 
nézetben jelenik meg. Ha a lista nézetet szeretné alapértelmezett beállítássá tenni, 
kapcsolja ki a Customize menüben a Change Display on Play pontot! 
 
 
Ikon Leírás 

 Előző kép 
 Következő kép 
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Irányítás a vezérlő nézetben 
 
A vezérlő nézet további eszközöket bocsájt a rendelkezésére: 
 
Ikon Leírás 

 A kép elforgatása. 

 Kép megtekintése teljes képernyőn. A vezérlő nézethez való 
visszatéréshez érintse meg a képernyőt. 

 Előző kép. 
 Következő kép. 

 
 
MEGJEGYZÉS: Ha teljes képernyős módban van, és fekvő módban kíván megnézni 
egy képet, nyomja meg a tapipad gombját lefelé irányba! Nyomja meg ismét, ha 
vissza kíván térni álló módba! 
 
 

Videók lejátszása 
 
Videókat is lejátszhat a HP iPAQ segítségével. 
 

1. A Local Media képernyőn érintse meg a My Videos pontot! Megjelenik a 
My Videos menü. 
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2. Érintse meg a lejátszani kívánt videót! 

 
MEGJEGYZÉS: Az iPAQ Mobile Media a Pocket PC képernyőjére készült .wma 
videókat tudja lejátszani. A videók megfelelő elmentéséről bővebb információt a 
„Zenei CD-k és videók másolása” című részben találhat. 
 
MEGJEGYZÉS: A média elindításakor a képernyő automatikusan vezérlő nézetbe 
vált, mert a Change Display on Play opció alapértelmezés szerint be van 
kapcsolva. 
 
MEGJEGYZÉS: A média helyét a My Videos képernyőről is megváltoztathatja. Ha 
így tesz, megjelenik a Local Media képernyő és ismét ki kell választania a My 
Videos pontot. 
 
 

A videó lejátszás irányítása 
 
A My Videos képernyőnek szintén két nézete van: lista nézet és vezérlő nézet. 
 

 
 

MEGJEGYZÉS: A Local Media elindításakor a My Videos képernyő vezérlő 
nézetben jelenik meg. Ha a lista nézetet kívánja alapértelmezetté tenni, kapcsolja 
ki a Customize menüben a Change Display on Play opciót! 
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Média törlése 
 
Törölheti a helyben tárolt média fájlokat egyenként, vagy a kiválasztott helyen 
tárolt összes média fájlt. 
 

1. A Local Media képernyőn érintse meg a My Music, a My Pictures vagy a 
My Videos pontot attól függően, milyen médiát kíván törölni! 

2. Érintse meg a  ikont! 
3. A felbukkanó menüben érintse meg a Delete (Törlés) menüpontot! 

Megjelenik a következő képernyő: 
 

 
 

A csavarkulcs ikon villogni kezd. Ha ki kíván lépni a törlés üzemmódból, érintse 
meg a villogó csavarkulcsot, majd a Cancel Delete menüpontot! 
 
MEGJEGYZÉS: Csak a kiválasztott helyen található média fájlokat látja. 
 
 

Egyes számok törlése 
 

1. Érintse meg a jelölőnégyzeteket a törölni kívánt számok kijelöléséhez! 

2. Érintse meg az  ikont! 
3. A törlés módból való kilépéshez érintse meg a villogó csavarkulcsot, 

majd a Cancel Delete menüpontot! 



  

Használati útmutató  - 141 - 

Minden média törlése adott helyről 
 

1. Érintse meg az  ikont! 

2. Érintse meg az  ikont! 
3. A törlés módból való kilépéshez érintse meg a villogó csavarkulcsot, 

majd a Cancel Delete menüpontot! 
 
 

Média áramoltatása (Media Stream mód) 
 
A Media Stream mód segítségével a média szerverről a HP iPAQ-ra 
áramoltathatja a média fájlokat. 
 

1. A Media Stream mód eléréséhez érintse meg az  ikont a Mobile 
Media képernyőn! Megjelenik a Media Stream képernyő: 
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Média szerver kiválasztása 
 
A média áramoltatásához ki kell választania egy média szervert. 
 

1. Érintse meg a Media Stream képernyő alján a média szerver 
kiválasztása nyilat! Megjelenik a Select Media Server felbukkanó menü. 

2. Az elérhető média szerverek listájából válasszon egyet a szerver 
nevének megérintésével! 

 
 

A Media Stream beállítása menü 
 

A  menüpont az aktuális módtól függő lehetőségeket kínál. A Media Stream 
esetében az alábbi lehetőségek állnak rendelkezésére: 
 
Menüpont Leírás 
Edit Media Server… 
(Média szerver 
szerkesztése) 

A média szerverrel kapcsolatos adatok szerkesztése: 
1. Válasszon egy média szervert a legördülő 

menüből! 
2. Érintse meg a Name doboz belsejét! Megjelenik az 

aktuális beviteli panel. 
3. Adjon meg egy új média szerver nevet! 
4. Érintse meg az Update gombot! 
5. Érintse meg a Close-t! 

Edit Media Player… 
(Médialejátszó 
szerkesztése) 

A Media Stream módban nem elérhető. 

Change Display on 
Play (Kijelzés váltása 
lejátszáskor) 

Ha be van kapcsolva, a Mobile Media lejátszáskor 
automatikusan vezérlő nézetre vált. A funkció 
kikapcsolásához kapcsolja ki ezt az opciót. 

Play All (Minden 
lejátszása) 

Minden zene lejátszása a kiválasztott könyvtárban. 

Search… (Keresés) Média keresése, ha a kiválasztott média szerver támogatja a 
keresést. Bővebb információt a „Média keresése” című 
részben találhat. 

Cancel Search… 
(Keresés leállítása) 

Kilépés keresés módból. 



  

Használati útmutató  - 143 - 

Download… (Letöltés) A Media Copy mód megnyitása. 
Cancel Download… 
(Letöltés megszakítása) 

Kilépés letöltés módból. 

Refresh Servers and 
Players (Szerverek és 
lejátszók frissítése) 

A média szerverek és lejátszók listájának frissítése. 

Refresh Folder A kiválasztott könyvtár tartalmának frissítése. 
 

Zene lejátszása 
 

1. A Media Stream képernyőn érintse meg a My Music pontot! Megjelenik 
a My Music menü. 

 
Ha választott már NevoMedia Server-t, a My Music lista nézet könyvtárak szerint 
van rendezve. 
 
Az alábbiak szerint rendezhető a zene: 
 

• Albumok 
• Előadó / album 
• Előadó / cím 
• Műfaj / előadó 
• Műfaj / cím 
• Minden cím 

 

Navigáció a Media Stream könyvtárakban 
 

1. Érintse meg a kívánt könyvtárat! 
2. A lejátszás elindítása: 

• Keresse meg és érintse meg a kívánt zenét! 
• Ha a felfelé és lefelé billentyűkkel navigál, nyomja meg a tapipad 

közepét! 
 
MEGJEGYZÉS: Media Stream módban az .mp3 formátumú zenék lejátszása nem 
támogatott. Csak nem másolásvédett, .wma formátumú zene áramoltatható a HP 
iPAQ-ra. 
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A zene lejátszásának irányítása 
 
Két különböző My Music képernyő nézet közül választhat: lista és vezérlő nézet. 
 

 
 

MEGJEGYZÉS: A lejátszás megkezdésekor a My Music képernyő vezérlő nézetbe 
vált. Ha azt kívánja, hogy a lista nézet legyen az alapértelemezett, kapcsolja ki a 
Customize menüben a Change Display on Play opciót! 
 
 

Képek megnézése 
 
Az áramoltatott képek a média szerveren vannak tárolva és a HP iPAQ-on nézi 
meg őket. Képek áramoltatása: 
 

1. A Media Stream képernyőn érintse meg a My Pictures pontot! 
Megjelenik a My Pictures menü. 

 
Media Stream módban a My Pictures listanézet könyvtárak szerint van 
rendezve. 

 
2. Érintse meg a kívánt könyvtárat! 
3. Keresse meg a megnézni kívánt képet és érintse meg! 
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MEGJEGYZÉS: A média elindításakor a képernyő automatikusan vezérlő nézetbe 
vált, mert alapértelmezés szerint a Change Display on Play opció be van 
kapcsolva. 
 
MEGJEGYZÉS: Ha teljes képernyős módban el akarja forgatni a képet, nyomja 
meg a tapipadot lefelé! Nyomja meg mégegyszer az eredeti nézetbe való 
visszatéréshez! 
 
 

Videók lejátszása 
 
A HP iPAQ-ra a Media Stream módban videót is áramoltathat. 
 

1. A Local Media képernyőn érintse meg a My Videos pontot! Megjelenik a 
My Videos menü. 

2. Keresse meg a lejátszani kívánt videót és érintse meg! 
 
MEGJEGYZÉS: Az iPAQ Mobile Media csak a Pocket PC képernyőjére készített 
.wmv formátumú videókat tudja lejátszani. A videók elmentésével kapcsolatban 
bővebb információt a „Zenei CD-k és videó másolása” című részben találhat. 
 
 

Média keresése 
 
Media Stream módban a kiválasztott szerveren kereshet zenét, képeket és 
videókat, ha a média szerver ezt támogatja. A következők szerint kereshet: 
 

• Title (cím) – a megadott kifejezést a címben keresi 
• Artist (előadó) – a megadott kifejezést az előadó adatainál keresi. Ez 

magában foglalja az album nevét és címét is. 
• All (minden) – az eredménylista tartalmaz minden olyan fájlt és 

könyvtárat, amely tartalmazza a megadott kifejezést. Például ha a „Pat” 
kifejezést adta meg, az eredménylista tartalmazza az alábbiakat: 
• Minden előadót, akinek a nevében szerepel a „Pat”, például Pat 

Benatar vagy Pat Metheny 
• Minden albumot, amiben szerepel a „Pat” kifejezés 
• Minden olyan számot, amelynek a címében szerepel a „Pat” 

kifejezés 
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• Minden albumot és számot, amely címében szerepel a „Pat” 
kifejezés 

 
Média keresése: 
 

1. A Media Stream képernyőn érintse meg az  ikont! Megjelenik a 
Media Search (Média keresés) eszköztár: 

 

 
 

MEGJEGYZÉS: A Search benyomva marad a keresés befejezéséig. 
 

2. Érintse meg a legördülő menüt, majd válassza ki a keresési módot (Title, 
Artist, All)! 

 
MEGJEGYZÉS: Az alapértelmezett keresési beállítás a Title. 
 

3. Érintse meg az üres doboz belsejét, és megjelenik az aktuális beviteli 
eszköz. A beviteli eszközökről bővebben a „Bevitel eszközök” című 
részben olvashat. 

4. Írja be a keresés paramétereit! 

5. Érintse meg az  ikont! Megjelenik a Search Results (Keresés 
eredménye) ablak. 

 
MEGJEGYZÉS: A feldolgozás közben leállíthatja a keresést a Search ikon 
megérintésével. 
 
 

Más eszközökön található média lejátszása (Media Control) 
 
A NevoMedia Control és a HP iPAQ segítségével egy média szerveren vagy uPnP 
(universal plug-and-play) digitális médialejátszón található médiát is lejátszhatja. A 
médiát bármely felismert média szerverről kiválaszthatja. 
 
MEGJEGYZÉS: Elképzelhető, hogy akár 60 másodpercet is igénybe vesz, hogy az 
iPAQ Mobile Media felismerje az uPnP szervert. Ha nem látja a szerveren tárolt 
összes médiát, válassza a Refresh servers and players lehetőséget! 
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A NevoMedia Control-t a Mobile Media képernyőről a Media Control pont 
megérintésével érheti el. Megjelenik a Media Control képernyő. 
 
 

Médiaszerver kiválasztása 
 
Válassza ki, melyik szerverről kívánja elérni a médiát: 
 

1. Érintse meg a Media Stream képernyő alján a média szerver 
kiválasztása nyilat! 

2. A felbukkanó menüből válasszon egy média szervert! 
 
 

Médialejátszó kiválasztása 
 
Válassza ki, melyik médialejátszón kívánja lejátszani a médiát: 
 

1. A Media Control képernyőn érintse meg a médialejátszó választása 

területet ( )! 
2. Az elérhető médialejátszók listájából válasszon egyet! 

 
A médiát a kiválasztott lejátszó játsza le. 
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A Media Control beállítása 

A Media Control Customize menüben ( ) a következőkre nyílik lehetősége: 
 
Menüpont Leírás 
Edit Media Server… 
(Média szerver 
szerkesztése) 

A média szerverrel kapcsolatos adatok szerkesztése: 
1. Válasszon egy média szervert a legördülő 

menüből! 
2. Érintse meg a Name doboz belsejét! Megjelenik 

az aktuális beviteli panel 
3. Adjon meg egy új média szerver nevet! 
4. Érintse meg az Update gombot! 
5. Érintse meg a Close-t! 

Edit Media Player… 
(Médialejátszó 
szerkesztése) 

A médialejátszóval kapcsolatos adatok szerkesztése: 
1. Válasszon egy médialejátszót a legördülő 

menüből! 
2. Érintse meg a Name doboz belsejét! Megjelenik 

az aktuális beviteli panel 
3. Adjon meg egy új média lejátszó nevet! 
4. Érintse meg az Update gombot! 
5. Érintse meg a Close-t! 

Change Display on Play 
(Kijelzés váltása 
lejátszáskor) 

Ha be van kapcsolva, a Mobile Media lejátszáskor 
automatikusan vezérlő nézetre vált. A funkció 
kikapcsolásához kapcsolja ki ezt az opciót. 

Play All (Minden 
lejátszása) 

Minden zene lejátszása a kiválasztott könyvtárban. 
MEGJEGYZÉS: Ha mind a NevoMedia Server-t, mind a 
NevoMedia Player-t használja, a média lejátszása a HP 
iPAQ kikapcsolása illetve készenléti állapotba kerülése 
esetén is folytatódik. 

Search… (Keresés) Média keresése, ha a kiválasztott média szerver 
támogatja a keresést. Bővebb információt a „Média 
keresése” című részben találhat. 

Cancel Search… Kilépés keresés módból. 
Download… (Letöltés) A Media Copy mód megnyitása. 
Cancel Download… 
(Letöltés megszakítása) 

Kilépés letöltés módból. 

Refresh Servers and 
Players 

A média szerverek és lejátszók listájának frissítése. 

Refresh Folder A kiválasztott könyvtár tartalmának frissítése. 
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Zene lejátszása 
 

1. A Media Control képernyőn érintse meg a My Music pontot! Megjelenik 
a My Music menü. 

 
Ha választott már NevoMedia szervert, a listanézet könyvtárak szerint van 
rendezve. A zene a következők szerint rendezhető: 
 

• Album 
• Előadó / album 
• Előadó / cím 
• Műfaj / előadó 
• Műfaj / cím 
• Minden cím 

 

Navigáció a Media Control zene mappákban 
 

1. Érintse meg a kívánt mappát! 
2. A lejátszás elindítása: 

• Keresse meg és érintse meg a számot, vagy 
• navigáljon a felfelé és lefelé nyilakkal, és nyomja meg a tapipadot! 

 

A zene lejátszás vezérlése 
 

 
 

Lista nézet   Vezérlő nézet 
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MEGJEGYZÉS: A lejátszáskor a képernyő automatikusan vezérlő nézetre vált. A 
vezérlő nézetről visszaválthat lista nézetre. Ha listanézetben kíván zenét 
lejátszani, érintse meg a kívánt zenét a listában! 
 

Képek megnézése 
 
Egyszerre nézegethet képeket a HP iPAQ-on és más digitális média lejátszókon. 
 

1. A Media Control képernyőn érintse meg a My Pictures pontot! 
Megjelenik a My Pictures menü. 

 
Media Control módban a My Pictures könyvtárak szerint van rendezve. 

 
2. Érintsen meg egy könyvtárat! 
3. Keresse meg a megnézni kívánt képet és érintse meg! 

 
MEGJEGYZÉS: A média elindításakor a képernyő automatikusan vezérlő nézetre 
vált, mert alapértelmezés szerint a Change Display on Play opció be van 
kapcsolva. 
 
MEGJEGYZÉS: Ha teljes képernyős módban van, és el akarja forgatni a képet, 
nyomja meg a tapipadot lefelé! Nyomja meg ismét, ha vissza akar térni az eredeti 
nézethez! 
 

Videók lejátszása 
 
Videókat is lejátszhat a HP iPAQ segítségével a felismert média lejátszókban. 
 

1. A Media Control képernyőn érintse meg a My Videos pontot! Megjelenik 
a My Videos menü. 

 
Media Control módban a My Videos könyvtárak szerint van rendezve. 
 

2. Érintse meg a kívánt könyvtárat! 
3. Keresse meg a lejátszani kívánt videót és érintse meg! 
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MEGJEGYZÉS: A média elindításakor a képernyő automatikusan vezérlő nézetre 
vált, mert alapértelmezés szerint a Change Display on Play opció be van 
kapcsolva. 
 

Média keresése 
 
Media Control módban a kiválasztott szerveren kereshet zenét, képeket és videót, 
ha a média szerver támogatja a keresés funkciót. A következők szerint kereshet: 
 

• Title (cím) – a megadott kifejezést a címben keresi 
• Artist (előadó) – a megadott kifejezést az előadó adatainál keresi. Ez 

magában foglalja az album nevét és címét is. 
• All (minden) – az eredménylista tartalmaz minden olyan fájlt és 

könyvtárat, amely tartalmazza a megadott kifejezést. Például ha a „Pat” 
kifejezést adta meg, az eredménylista tartalmazza az alábbiakat: 
• Minden előadót, akinek a nevében szerepel a „Pat”, például Pat 

Benatar vagy Pat Metheny 
• Minden albumot, amiben szerepel a „Pat” kifejezés 
• Minden olyan számot, amelynek a címében szerepel a „Pat” 

kifejezés 
• Minden albumot és számot, amely címében szerepel a „Pat” 

kifejezés 
 
Média keresése: 
 

1. A Media Control képernyőn érintse meg az  ikont! Megjelenik a 
Media Search (Média keresés) eszköztár. 

 
MEGJEGYZÉS: A Search benyomva marad a keresés befejezéséig. 
 

2. Érintse meg a legördülő menüt, majd válassza ki a keresési módot (Title, 
Artist, All)! 

 
MEGJEGYZÉS: Az alapértelmezett keresési beállítás a Title. 
 

3. Érintse meg az üres doboz belsejét, és megjelenik az aktuális beviteli 
eszköz. A beviteli eszközökről bővebben a „Bevitel eszközök” című 
részben olvashat. 
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4. Írja be a keresés paramétereit! 

5. Érintse meg az  ikont! Megjelenik a Search Results (Keresés 
eredménye) ablak. 

 
MEGJEGYZÉS: A feldolgozás közben leállíthatja a keresést a Search ikon 
megérintésével. 
 
 

Média letöltése (Media Copy) 
 
Media Copy módban letöltheti a médiát a HP iPAQ-ra, hogy később megnézhesse. 
 
A Media Copy módot háromféleképpen érheti el: 
 

• A Mobile Media képernyőn érintse meg a  jelet! 

• A Media Stream képernyőn érintse meg az  ikont, majd a 
Download… menüpontot! 

• A Media Control képernyőn érintse meg az  ikont, majd a 
Download… menüpontot! 

 
 



  

Használati útmutató  - 153 - 

A Media Copy beállítása 
 

A Media Copy Customize menüben ( ) a következőkre nyílik lehetősége: 
 
Menüpont Leírás 
Edit Media Server… 
(Média szerver 
szerkesztése) 

Media Copy módban nem elérhető. 

Edit Media Player… 
(Médialejátszó 
szerkesztése) 

Media Copy módban nem elérhető. 

Search… (Keresés) Média keresése, ha a kiválasztott média szerver támogatja a 
keresést. 

Cancel Search… 
(Keresés leállítása) 

Kilépés keresés módból. 

Download… (Letöltés) A Media Copy mód megnyitása. 
Cancel Download… 
(Letöltés megszakítása) 

Kilépés Media Copy módból. 

Refresh Servers and 
Players (Szerverek és 
lejátszók frissítése) 

A média szerverek és lejátszók listájának frissítése. 

Refresh Folder (Mappa 
frissítése) 

A kiválasztott könyvtár tartalmának frissítése. 

Storage Settings 
(Tárolási beállítások) 

Megnyitja a Storage Settings képernyőt. 

About iPAQ Mobile 
Media (iPAQ Mobile 
Media névjegy) 

Megjeleníti az iPAQ Mobile Media-val kapcsolatos adatokat, 
mint például a verziószámot. Érintse meg a Close-t a 
bezárásához. 

 

A média szerver kiválasztása 
 
Válassza ki, melyik szerverről kívánja letölteni a médiát! 
 

1. Érintse meg a Media Copy képernyő alján a média szerver választása 
nyilat! 

2. Válasszon egy média szervert a listából! 
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MEGJEGYZÉS: Minden, a NevoMedia Server-től eltérő média szerver valószínűleg 
egyedi könyvtárszerkezettel rendelkezik. 
 
 

Zene letöltése 
 

1. A Media Copy képernyőn érintse meg a My Music pontot! Megjelenik a 
My Music menü. 

 
Ha választott már NevoMedia szervert, a My Music lista könyvtár szerint rendezve 
jelenik meg. A következők alapján választhat a zenéből: 
 

• Album 
• Előadó / album 
• Előadó / cím 
• Műfaj / előadó 
• Műfaj / cím 
• Minden cím 

 

A letöltendő zene kiválasztása 
 

1. Válassza ki a mappát illetve az albumot a megérintésével! Megjelenik 
egy jelölőnégyzet a szám nevétől balra. 
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MEGJEGYZÉS: Csak egyenként jelölhet ki számokat. Nem jelölhet ki teljes 
könyvtárakat. 
 

2. Érintse meg a letölteni kívánt számokat! 
• Ha nincs elég hely a kiválasztott mappában, a helyet jelző torta 

teliként jelenik meg és a Media Copy nem engedélyezi fájlok 
kiválasztását. 

• Ha olyan számot választ, amely már szerepel a letöltés céljaként 
kijelölt mappában, megjelenik a File Name dialógusablak: 

 

 
 

• Válasszon egy lehetőséget, majd érintse meg az OK gombot! 

3. Érintse meg az  ikont! Megjelenik a Download Status (Letöltés 
állapota) képernyő. 

4. A letöltés megszakításához érintse meg a Cancel gombot! 
5. Ha a Media Copy végzett a letöltéssel, érintse meg a Close-t! 
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Képek letöltése 
 

1. A Media Copy képernyőn érintse meg a My Pictures pontot! Megjelenik 
a My Pictures menü. 

 
Media Copy módban a My Pictures lista könyvtárak szerint van rendezve. 
 
 
A letöltendő képek kiválasztása 
 

1. Érintse meg a kívánt mappát! A képek neve mellett megjelenik egy 
jelölőnégyzet.  

 
MEGJEGYZÉS: Csak egyenként jelölhet ki képeket. Nem jelölhet ki teljes 
könyvtárat. 
 

2. Érintse meg a letölteni kívánt képeket! 
• Ha nincs elég hely a kiválasztott mappában, a helyet jelző torta 

teliként jelenik meg és a Media Copy nem engedélyezi fájlok 
kiválasztását. 

• Ha olyan számot választ, amely már szerepel a letöltés céljaként 
kijelölt mappában, megjelenik a File Name dialógusablak: 

• Válasszon egy lehetőséget, majd érintse meg az OK gombot! 

3. Érintse meg az  ikont! Megjelenik a Download Status (Letöltés 
állapota) képernyő. 

4. A letöltés megszakításához érintse meg a Cancel gombot! 
5. Ha a Media Copy végzett a letöltéssel, érintse meg a Close-t! 
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Videók letöltése 
 

1. A Media Copy képernyőn érintse meg a My Videos pontot! Megjelenik a 
My Videos menü. 

 
Media Copy módban a My Videos lista könyvtárak szerint van rendezve. 

 
2. Érintse meg a kívánt mappát! 

 

A letöltendő videók kiválasztása 
 
MEGJEGYZÉS: Bármilyen típusú videót letölthet a HP iPAQ-ra, de csak a Pocket PC-
re készült .wmv-t tudja lejátszani. 
 

1. Érintse meg a kívánt mappát! A képek neve mellett megjelenik egy 
jelölőnégyzet.  

 
MEGJEGYZÉS: Csak egyenként jelölhet ki videókat. Nem jelölhet ki teljes 
könyvtárat. 
 

2. Érintse meg a letölteni kívánt videókat! 
• Ha nincs elég hely a kiválasztott mappában, a helyet jelző torta 

teliként jelenik meg és a Media Copy nem engedélyezi fájlok 
kiválasztását. 

• Ha olyan számot választ, amely már szerepel a letöltés céljaként 
kijelölt mappában, megjelenik a File Name dialógusablak: 

• Válasszon egy lehetőséget, majd érintse meg az OK gombot! 

3. Érintse meg az  ikont! Megjelenik a Download Status (Letöltés 
állapota) képernyő. 

4. A letöltés megszakításához érintse meg a Cancel gombot! 
5. Ha a Media Copy végzett a letöltéssel, érintse meg a Close-t! 
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Szórakoztatóelektronikai berendezések távirányítása (NevoHome 
Control) 
 
A NevoHome Control és a HP iPAQ segítségével távirányíthatja a 
szórakoztatóelektronikai eszközeit. Személyre szabhatja a NevoHome Control-t az 
alábbi módokon: 

• Testreszabhatja a Control (Vezérlő) képernyőt 
• Létrehozhat Favorites (Kedvencek) listát 
• Létrehozhat szobákat 
• Létrehozhat különböző felhasználókat 
• Létrehozhat tevékenységeket 

 

A NevoHome Control indítása 

A NevoHome Control indításához érintse meg a Launch képernyőn az  ikont, 
vagy a Start > Programs > iPAQ Mobile Media menüpontot! 
 

A NevoHome Control vezérlő képernyőjének használata 
 
A NevoHome Control vezérlőképernyőjén három fő fület talál: 
 

• Home (Otthon) fül – A NevoHome Control fő képernyője. Hozzáadhat, 
törölhet és testreszabhat eszközöket, felhasználókat, szobákat és 
tevékenységeket. 
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A „keréken” vannak alapértelmezett helyek az általános 
szórakoztatóelektronikai eszközök számára („alap eszközök”) a beállítás 
megkönnyítése érdekében. 
Az alap eszközök még az „üres” szobákban is megtalálhatóak a 
szobák könnyebb beállítása érdekében. 

 

MEGJEGYZÉS: A NevoHome Control alapértelmezett felhasználója Victoria. 
Módosíthatja az adatait (bővebben: „Felhasználó adatainak szerkesztése” rész), 
vagy létrehozhat új felhasználót (bővebben: „Új felhasználó létrehozása” rész). 

 
• Controls (Vezérlő) fül – innen vezérelheti a létrehozott eszközöket, 

testreszabhatja az eszközök beállításait és új vezérlési módokat tanulhat 
meg infravörös távirányítóktól. 

• Favorites (Kedvencek) fül – létrehozhat és módosíthat „Kedvencek” listát. 
 
Vannak ikonok, amelyek minden NevoHome Control képernyőn közösek. A 
következő táblázat bemutat néhányat ezek közül az ikonok közül: 
 
Ikon Leírás 

 
A Súgó megnyitása. 

 
A Customize (Testreszabás) menü megnyitása. A menüben eltérő 
lehetőségek állnak a rendelkezésére a kiválasztott fül 
függvényében. 

 
Megnyitja a Key Guides (Vezérlőgomb) felbukkanó menüt. A 
kiválasztott módtól függően az egyik ikon jelenik meg. Bővebb 
információt lentebb találhat. 
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A Vezérlőgomb beállítása 
 
A Key Guides (Vezérlőgomb) menü segítségével beállíthatja a vezérlőgomb 
távirányító funkcióját. Három különböző módon állíthatja be: 
 

• Navigation (navigáció) – a vezérlőgomb listákban görget felfelé, lefelé, 
balra vagy jobbra. 

• Controls (vezérlés) – hangerő növelése és csökkentése, csatornaszám 
növelése és csökkentése, a hang elnémítása. 

• Transport (beállítás) – a vezérlőgomb a videó, videó kiegészítők, PVR, 
DVD, CD lejátszás, pillanat-állj, stop, előre- és hátratekerés funkcióit 
látja el. 

 
A vezérlőgomb beállítása: 
 

1. Érintse meg az  ikonok egyikét! 
2. A felbukkanó menüben válassza ki a Navigation, Controls, Transport 

funkciók egyikét! A vezérlőgomb ikon azonnal megváltozik. 
 
 

Készülék hozzáadása 
 
Mielőtt irányítani tudná a szórakoztatóelektronikai eszközeit a NevoHome Control 
segítségével, hozzá kell őket adnia. 
 
Három különböző módon adhat hozzá eszközt. A Home fülön érintse meg: 
 

• az egyik alap eszköz ikonját, majd az  ikont! 

• az , majd az  ikont! 

• az  ikont, majd az Add Device menüpontot! Megjelenik a Device 
Wizard Initialization képernyő. 

 
1. Érintse meg a Next gombot a folytatáshoz! 
2. Válassza ki a hozzáadni kívánt eszközt a Device legördülő menüből, 

majd érintse meg a Next gombot! Megjelenik a Device Setup Methods 
képernyő. Ezen a képernyőn négy lehetősége van: 
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• Select Brand (Márka kiválasztása) – használja ezt a lehetőséget, ha 
a márkája alapján kívánja beállítani a készüléket. A NevoHome 
Control automatikusan megkeresi a kiválasztott márkához tartozó 
készülékkódokat. 

• Enter Device Code (Készülékkód megadása) – használja ezt a 
lehetőséget, ha tudja a készülék kódját. 

• Browse Device Code (Készülékkód tallózása) – használja ezt a 
lehetőséget a rendelkezésre álló készülékkódok közti tallózáshoz. 

• Select Brand downloaded from myNevo.com (A myNevo.com-ról 
letöltött márka használata) – használja ezt a lehetőséget, ha nem 
találja a készülékének megfelelő kódot. 

3. Válassza ki a használni kívánt beállítási eljárást, és kövesse a 
képernyőn látható utasításokat! Ha végzett, érintse meg a Next gombot! 

4. Válassza ki a készülékhez rendelendő képet, majd érintse meg a Next 
gombot! 

5. Adjon egy nevet a készüléknek és érintse meg a Done gombot! Az 
újonnan létrehozott eszköz megjelenik a keréken. 

 
 

Készülékkódok letöltése 
 
A myNevo.com-ról is tölthet le készülékkódokat. Először regisztrálnia kell a 
NevoHome Control-t a myNevo.com-on. A regisztrációhoz szükséges adatok, 
például a szériaszám megkeresése: 
 

1. A Home fülön érintse meg az  ikont! 
2. Érintse meg az About Nevo… menüpontot! 

 
A készülékkódok letöltéséhez adja meg az alábbi adatokat a myNevo.com-on: 
 

• A készülék típusa 
• A készülék márkája 

 
MEGJEGYZÉS: Bővített gomb funkciókat is letölthet, valamint gomb grafikákat és 
hálózati logókat a myNevo.com-ról. 
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Készülék távirányítása 
 

Több készülék távirányítása néhány érintéssel 
 
Készülék távirányítása: 
 

1. A Home fülön érintse meg az irányítandó készülékez! A kerék tetejére 
kerül a kiválasztott készülék. 

 
MEGJEGYZÉS: A felül lévő eszköznél van a „fókusz”, a vezérlőgombok és a 
kedvencek erre az eszközre érvényesek. Ha másik készüléket kíván irányítani vagy 
testreszabni, érintse meg az adott készüléket. 
 

2. A bekapcsoláshoz érintse meg a  jelet! 
3. A teljes irányítás érdekében: 

• Éritnse meg a Controls fület, vagy 
• érintse meg ismét a készülék ikonját! 

4. Érintse meg a kiválasztott vezérlő gombot! 
5. A további lapok eléréséhez érintse meg a képernyő alján látható 

nyilakat! Hozzá is adhat vezérlő lapokat. 
 
 

A vezérlőképernyő testreszabása 
 
A vezérlőképernyő kinézete a kiválasztott eszköz típusától és márkájától függ. 
Például kábelTV vevő távirányítóján nincs felvétel gomb. A vezérlő képernyőt 
testreszabhatja új gombok hozzáadásával, a gombok kinézetének és helyének 

megváltoztatásával, valamint új oldalak hozzáadásával. A testreszabást a  
menüben érheti el. 
 
MEGJEGYZÉS: Mivel a vezérlő képernyő eszközfüggő, testreszabás előtt válassza 
ki a megfelelő eszközt! 
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Gomb hozzáadása 
 
Három különböző módon adhat hozzá új gombot: 
 

• Készülék funkció hozzáadása 
• Gomb megtanulása másik távirányítótól 
• Automatikus tevékenység hozzáadása 

 
 
Új gomb hozzáadása: 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben: 

• érintse meg az Add Key (Gomb hozzáadása), vagy 
• az Express Learning (Tanulás) lehetőséget! 

3. A Key Wizard Initialization képernyőn érintse meg a Next gombot! 
4. A Key Action Selection képernyőn válassza ki, hogyan kívánja 

hozzáadni a gombot, majd érintse meg a Next gombot! 
5. Kövesse a képernyőn látható utasításokat, majd érintse meg a Next 

gombot! 
6. Adjon nevet a gombnak, majd érintse meg a Next gombot! Eldöntheti, 

hogy kívánja-e, hogy a gomb neve megjelenjen az ikonja alatt. 
7. A Key Button/Symbol Selection képernyőn: 

• Válassza ki a Button legördülő menüből, hogyan nézzen ki az új 
gomb! 

• Válassza ki a Symbol legördülő menüből a gomb ikonját, majd 
érintse meg a Done gombot! 

 
Az új gomb megjelenik a vezérlő képernyőn. 
 
MEGJEGYZÉS: A myNevo.com-ról is tölthet le új gomb kinézeteket. Ha új gomb 
kinézeteket szeretne letölteni, nézze meg a http://www.mynevo.com weboldalt! 
 
 

http://www.mynevo.com
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Gomb szerkesztése 
 
Ugyanazon három módon szerkesztheti a gombot, ahogyan újat hozhat létre. 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza az Edit Key… menüpontot. A 

csavarkulcs ikon elkezd villogni. Ha ki kíván lépni a szerkesztő módból, 
érintse meg a villogó csavarkulcs ikont és válassza a Cancel Edit 
menüpontot! 

3. Érintse meg a szerkeszteni kívánt gombot! 
4. A Key Wizard Initialization képernyőn érintse meg a Next gombot! 
5. A Key Action Selection képernyőn válassza ki, hogyan kívánja 

szerkeszteni a gombot, majd érintse meg a Next gombot! 
6. Kövesse a képernyőn látható utasításokat, majd érintse meg a Next 

gombot! 
7. Ha kívánja, adjon új nevet a gombnak, majd érintse meg a Next 

gombot! 
8. A Key Button/Symbol Selection képernyőn: 

• Ha kívánja, válasszon új képet a Button legördülő menüben! 
• Ha kívánja, válasszon új ikont a Symbol legördülő menüben! 

9. Érintse meg a Done gombot! 
 
 

Gomb másolása 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza a Move Key… menüpontot. A csavarkulcs 

ikon elkezd villogni. Ha ki kíván lépni a mozgatás módból, érintse meg a 
villogó csavarkulcsot és válassza a Cancel Move menüpontot! 

3. Érintse meg a mozgatni kívánt gombot! 
4. Érintse meg a Control képernyőt egy üres helyen, ahová a gombot helyezni 

kívánja! 
 
MEGJEGYZÉS: Ha másik oldalra kívánja helyezni a gombot, érintse meg a 
képernyő jobb alsó részén látható nyilakat. 
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Gomb törlése 
 
Nem használt gomb törlése: 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza a Delete Key… menüpontot! A csavarkulcs 

ikon elkezd villogni. Ha ki akar lépni a gomb törlése módból, érintse meg a 
villogó csavarkulcsot és válassza a Cancel Delete menüpontot! 

 
MEGJEGYZÉS: Amíg a csavarkulcs villog, megjelenik egy „mini súgó” a 
NevoHome Control testreszabása során. 
 

3. Érintse meg a törölni kívánt gombot! 
4. A Confirm Key Delete képernyőn érintse meg a Yes-t a törlés 

megerősítésére! 
 
MEGJEGYZÉS: Ha a gomb törlése után meggondolja magát, a  „Gomb 
hozzáadása” részben látott módon újból hozzáadhatja. 
 

Nevek megjelenítése 
 
Beállíthatja, hogy megjelenjen-e a gombok neve az ikonjuk alatt. A nevek 
megjelenítésének beállítása: 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza a Display Labels menüpontot! Megjelenik 

egy pipa. 
3. A nevek elrejtéséhez ismételje meg az 1-es és 2-es lépést! A pipa eltűnik. 
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Tanulás 
 
A tanulás segítségével gyorsan „megtaníthatja” a készüléknek egy távirányító 
segítségével a távirányító gombjait, és nem kell végrehajtania a Gomb 
hozzáadása műveleteket. A tanulás megnyitása: 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza az Express Learning menüpontot! 

 
MEGJEGYZÉS: Amíg a csavarkulcs ikon villog, kiléphet a tanulás módból a villogó 
csavarkulcs, majd a Cancel Express Learning menüpont megérintésével. 
 
MEGJEGYZÉS: Amíg a csavarkulcs villog, megjelenik egy „mini súgó” a 
NevoHome Control testreszabása során. 
 

3. Érintse meg azt a gombot, amelyhez új infravörös kódot kíván rendelni! 
4. Helyezze el úgy a HP iPAQ-ot, hogy rálátása legyen az infravörös 

távirányítóra! 
5. Nyomja meg és tartsa lenyomva a megtanítandó gombot! Megjelenik egy 

mini súgó, amely arról értesíti, hogy a Nevo feldolgozást végez. 
 
MEGJEGYZÉS: Ahhoz, hogy a NevoHome Control megtanulja az adott gombot, a 
Nevo gombjának kiválasztása után 5 másodpercen belül meg kell nyomnia a 
távirányító gombját. 
 

6. Ismételje meg a 3-5 lépéseket minden megtanítani kívánt gombra! 
 

Lapok hozzáadása és törlése 
 
Hozzáadhat és törölhet lapokat a Control képernyőhöz / képernyőről. Lap 
hozzáadása: 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza az Add Blank Page menüpontot! 

 
Lap törlése: 
 



  

Használati útmutató  - 167 - 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza a Delete Page… menüpontot! 
3. A Confirm Control Page Delete megerősítő kérdésre válaszoljon Yes-t! 

 
 

A Kedvencek beállítása 
 
A NevoHome Control segítségével maximum 16 oldalnyi személyre szabott 
kedvenc funkciót gyűjthet össze, hogy néhány érintéssel könnyedén elérje őket. 
 
MEGJEGYZÉS: A kedvencek felhasználófüggőek, ezért a lista létrehozása előtt 
ellenőrízze, hogy a megfelelő felhasználót állította-e be! 
 
A Kedvencek lista létrehozása: 
 

1. Érintse meg az  ikont! Megjelenik a Favorites (Kedvencek) képernyő. 
2. Itt használhatja a hálózati ikonokat, vagy kézzel hozhat létre bejegyzéseket 

a Customize menü segítségével. 
 
 

Kedvenc létrehozása az ikonokkal 
 
A NevoHome Control alapból rendelkezik az általánosan elterjedt csatornák 
logóival. Önnek csak annyit kell tennie, hogy beállítja őket úgy, hogy hozzájuk 
rendelk egy csatornaszámot. Így egyetlen érintéssel eléri a kedvenc csatornáit. 
 
A kedvencek szoba- és készülékfüggőek, ezért mielőtt létrehozza a kedvenc 
csatornáihoz a kedvenceket, győződjön meg az alábbiakról: 
 

• a megfelelő szoba van kiválasztva, 
• a megfelelő készülék van kiválasztva. 

 
A kedvencek beállítása: 
 

1. Érintse meg a hozzáadni kívánt hálózat ikonját! Megjelenik a Favorites 
Wizard Initialization képernyő. 
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2. Érintse meg az Easy Channel Setup (Könnyű csatornabeállítás) vagy a 
Custom Favorites Setup (Egyedi kedvencek beállítás) lehetőséget, majd a 
Next gombot! 

 
 

Könnyű csatornabeállítás 
 
Ha az Easy Channel Setup lehetőséget választja, megjelenik a Master Control 
Channel Device képernyő. 
 
A Master Control varázsló segítségével beállíthatja, normális körülmények között 
hogyan vált csatornát. A következő táblázat bemutatja a lehetőségeket: 
 
Feladat Leírás 
2 Digits (2 számjegy) A távirányítóval 2 számjegy megadásával válthat 2 jegyű 

csatornára. 
3 Digits (3 számjegy) A távirányítón 3 számjegyet kell megadnia 

csatornaváltáshoz. 
4 Digits (4 számjegy) A távirányítón 4 számjegyet kell megadnia 

csatornaváltáshoz. 
+10/100 or --/---- 
required (+10/100 
vagy --/--- szükséges) 

A 10-nél illetve 100-nál nagyobb számok megadásához 
meg kell nyomnia a +10/100 vagy a --/--- gombot. 

„Enter” required after 
the digits (a 
számjegyek után 
enter kell) 

A távirányítón meg kell nyomnia egy Enter gombot a 
csatornaváltáshoz. MEGJEGYZÉS: Akkor is ajánlott a 
használata, ha az enter megnyomásával gyorsabb a 
csatornaváltás. 

 
1. Ellenőrízze a beállításokat, majd érintse meg a Next gombot! 
2. Adja meg a hozzáadni kívánt kedvenchez tartozó csatornaszámot, majd 

érintse meg a Test gombot! 
3. Érintse meg a Next gombot! 
4. Adjon egy nevet a kedvencnek, majd érintse meg a Next gombot! 
5. Válassza ki a kedvenchez rendelendő ikont, majd érintse meg a Done 

gombot! 
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Egyedi csatorna beállítása 
 
Ha a Custom Favorites Setup lehetőséget választotta, megjelenik a How to Record 
Keystrokes... képernyő. 
 

1. Kapcsolja be a Record a new sequence of keystrokes? jelölőnégyzetet, 
majd érintse meg a Next gombot! 

2. Rögzítse a kedvenchez tartozó gombnyomás sorozatot, majd érintse meg a 
Stop menüpontot a Customize (Csavarkulcs) menüben! 

 
MEGJEGYZÉS: Ha meg kell nyomnia az enter-t a csatornaszám kiválasztása után, 
ezt is tegye meg a rögzítés során. 
 

3. A rögzítés ellenőrzéséhez érintse meg a Customize (Csavarkulcs) menü Test 
pontját! 

4. Érintse meg a Customize (Csavarkulcs) menü Finish Wizard menüpontját! 
5. Adjon egy nevet a kedvencnek, majd érintse meg a Next gombot! 
6. Válassza ki a kedvenchez rendelendő ikont, majd érintse meg a Done 

gombot! 
 
MEGJEGYZÉS: Ha nem akar beállítani bizonyos kedvenceket, a hozzájuk tartozó 
hálózat ikon akkor is megjelenik a képernyőn. Törölheti, vagy áthelyezheti a nem 
használt ikonokat. 
 
MEGJEGYZÉS: További hálózati logókat tölthet le a myNevo.com oldalról. 
 
 

Kedvenc kézi létrehozása 
 

1. A képernyő alján található nyilak segítségével keressen egy olyan oldalt, 
amelyen van szabad terület! 

 
MEGJEGYZÉS: Ha szükséges, hozzon létre egy új üres lapot. 
 

2. Érintse meg az  ikont a Customize menü megnyitásához! 
3. A felbukkanó menüben válassza az Add Favorite… menüpontot! 

Megjelenik a Favorites Wizard Initialization képernyő. 
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4. Érintse meg az Easy Channel Setup vagy a Custom Favorites Setup 
lehetőségek egyikét, majd a Next gombot! 

5. Kövesse a képernyőn látható utasításokat! 
 
 

Kedvenc szerkesztése 
 

1. Érintse meg az  ikont a Customize menü megnyitásához! 
2. A felbukkanó menüben válassza az Edit Favorite… menüpontot! A 

csavarkulcs ikon elkezd villogni. Ha ki akar lépni szerkesztő módból, 
érintse meg a villogó csavarkulcsot, majd a Cancel Edit menüpontot! 

 
MEGJEGYZÉS: Amíg a csavarkulcs villog, megjelenik egy „mini súgó” a 
NevoHome Control testreszabása során. 
 

3. Érintse meg a szerkeszteni kívánt kedvencet! Megjelenik a Favorites Wizard 
Initialization képernyő. 

4. A Favorites Wizard Initialization képernyőn érintse meg az Easy Channel 
Setup vagy a Custom Favorites Setup lehetőségek egyikét, majd a Next 
gombot! 

5. Kövesse a képernyőn látható utasításokat! 
 
 

Kedvenc másolása 
 

1. Érintse meg az  ikont a Customize menü megjelenítéséhez! 
2. A felbukkanó menüben válassza a Copy Favorite… menüpontot! A 

csavarkulcs ikon elkezd villogni. Ha ki akar lépni másolás módból, érintse 
meg a villogó csavarkulcsot, majd a Cancel Edit menüpontot! 

 
MEGJEGYZÉS: Amíg a csavarkulcs villog, megjelenik egy „mini súgó” a 
NevoHome Control testreszabása során. 
 

3. Érintse meg a másolni kívánt kedvencet! 
4. Érintsen meg a képernyőn egy üres területet, ahová másolni kívánja a 

kedvencet! 
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MEGJEGYZÉS: Ha másik oldalra kívánja másolni a kedvencet, érintse meg a 
képernyő jobb alsó részén látható nyilakat! 
 

Kedvenc mozgatása 
 

1. Érintse meg az  ikont a Customize menü megjelenítéséhez! 
2. A felbukkanó menüben válassza a Delete Favorite… menüpontot! A 

csavarkulcs ikon elkezd villogni. Ha ki akar lépni törlés módból, érintse 
meg a villogó csavarkulcsot, majd a Cancel Delete menüpontot! 

 
MEGJEGYZÉS: Amíg a csavarkulcs villog, megjelenik egy „mini súgó” a 
NevoHome Control testreszabása során. 
 

3. Érintse meg a törölni kívánt kedvencet! 
4. A törlés megerősítésére válassza a Confirm Favorite Delete képernyőn a 

Yes-t! 
 
MEGJEGYZÉS: Más felhasználó kedvenceit is hozzáadhatja, valamint visszatérhet 
az alapértelmezett Kedvencek beállításhoz. 
 

Lapok hozzáadása és törlése 
 
Teljes Kedvencek lapokat is hozzáadhat vagy törölhet. Üres lap hozzáadása: 
 

1. Érintse meg az  ikont a Customize menü megjelenítéséhez! 
2. A felbukkanó menüben válassza az Add Blank Page menüpontot! 

 
Lap törlése: 
 

1. Érintse meg az  ikont a Customize menü megjelenítéséhez! 
2. A felbukkanó menüben válassza a Delete Page… menüpontot! 
3. A törlés megerősítésére válassza a Confirm Favorites Page Delete 

képernyőn a Yes-t! 
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Kedvencek lap hozzáfűzése 
 
Más felhasználó Kedvencek oldalát gyorsan hozzáadhatja a saját kedvenceihez, 
vagy legenerálhatja a beépített kedvencek listát. Kedvencek lap hozzáfűzése: 
 

1. Érintse meg az  ikont a Customize menü megjelenítéséhez! 
2. A felbukkanó menüben válassza a Add Favorite Pages… menüpontot! 

Megjelenik az Add Favorite Pages képernyő. 
3. Válasszon az alábbi lehetőségek közül: 

• Append built-in favorite list (beépített kedvencek lista hozzáfűzése), 
vagy 

• Append favorites from a user (másik felhasználó kedvenceinek 
hozzáfűzése), majd válasszon egy felhasználót a legördülő menüből! 

4. Érintse meg az OK gombot! 
 

Szoba hozzáadása 
 
Minden szobára különböző beállításokat hozhat létre. A NevoHome Control az 
adott szobának megfelelő eszközöket mutatja. 
 
MEGJEGYZÉS: Az alapértelmezett szoba a nappali. 
 
Szoba hozzáadása: 
 

1. A nyitó képernyőn érintse meg az  ikont! 
2. A felbukkanó menüben éritnse meg az Add Room... menüpontot! 
3. A Room Wizard (Szoba varázsló) képernyőn érintse meg a Next gombot! 
4. Válassza ki a szobához rendelendő képet, majd érintse meg a Next 

gombot! 
5. Adjon nevet a szobának! 
6. Válassza ki a területet, ahol van, a Region legördülő menüből, majd érintse 

meg a Done gombot! 
 
MEGJEGYZÉS: Ha beállította a szobához a területi beállítást, a szoba többi 
eszköze is azt a beállítást fogja használni. 
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Szoba szerkesztése 
 

1. A nyitó képernyőn érintse meg az  ikont! 
2. A felbukkanó menüből válassza ki a szerkeszteni kívánt szobát! 

3. Ismét érintse meg az  ikont! 
4. A felbukkanó menüben éritnse meg az Edit Room... menüpontot! 
5. A Room Wizard (Szoba varázsló) képernyőn érintse meg a Next gombot! 
6. Ha új képet kíván a szobához rendelni, válassza ki a képet, majd érintse 

meg a Next gombot! 
7. Ha új nevet kíván adni a szobának, adjon neki új nevet! 
8. Ha meg akarja változtatni a szoba területi beállítását, válasszon a Region 

legördülő menüből, majd érintse meg a Done gombot! 
 
MEGJEGYZÉS: Ha új eszközök felvételekor megváltoztatja a szoba területi 
beállítását, ez nem befolyásolja a már telepített eszközöket, csak a jövőben 
hozzáadandókat. 
 

Szoba törlése 
 

1. A nyitó képernyőn érintse meg az  ikont! 
2. A felbukkanó menüben érintse meg a törölni kívánt szobát! 

3. Ismét érintse meg az  ikont! 
4. A felbukkanó menüben éritnse meg a Delete Room... menüpontot! 
5. A Confirm Room Delete képernyőn érintse meg a Yes-t a törlés 

megerősítésére! 
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Felhasználó hozzáadása 
 
A NevoHome Control-ban lehetősége van különböző felhasználók létrehozására. 
Minden felhasználó létrehozhatja a saját Kedvencek listáját. 
 
MEGJEGYZÉS: Az alapértelmezett felhasználó a HP iPAQ tulajdonosi információi 
alapján jön létre. Ha állította be a tulajdonosi információkat, a NevoHome Control 
első elindításakor az alapértelmezett felhasználónév Victoria. 
 
Felhasználó hozzáadása: 
 

1. A nyitóképernyőn érintse meg az  ikont! 
2. A felbukkanó menüben érintse meg az Add User... menüpontot! 
3. A User Wizard (Felhasználó varázsló) képernyőn érintse meg a Next 

gombot! 
4. A Name User képernyőn adja meg a felhasználó nevét, majd érintse meg a 

Done gombot! Megjelenik az új felhasználó a nyitóképernyőn. 
 
MEGJEGYZÉS: A felhasználóneveknek egyedieknek kell lenniük. 

 

Felhasználók szerkesztése 
 

1. A nyitóképernyőn érintse meg az  ikont! 
2. A felbukkanó menüben válassza ki a szerkeszteni kívánt felhasználót! 

3. Ismét érintse meg az  ikont! 
4. A felbukkanó menüben érintse meg az Edit User... menüpontot! 
5. A User Wizard képernyőn érintse meg a Next gombot! 
6. A Name User képernyőn szerkessze a felhasználó nevét, majd érintse meg 

a Done gombot! Az új felhasználónév megjelenik a nyitóképernyőn. 
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Felhasználó törlése 
 

1. A nyitóképernyőn érintse meg az  ikont! 
2. A felbukkanó menüben válassza ki a szerkeszteni kívánt felhasználót! 

3. Ismét érintse meg az  ikont! 
4. A felbukkanó menüben érintse meg a Delete User... menüpontot! 
5. A Confirm User Delete képernyőn érintse meg a Yes-t a törlés 

megerősítésére! 
 
MEGJEGYZÉS: Ha meggondolta magát, ismét adja hozzá a felhasználót a 
„Felhasználó hozzáadása” részben látottaknak megfelelően. 
 

Tevékenységek létrehozása 
 
Megtaníthatja a NevoHome Control-nak, hogy egyszerre tevékenységek egy 
sorozatát hajtsa végre. Például egyetlen érintéssel bekapcsolhatja a rádiót, 
beállíthatja a kedvenc csatornáját és felkapcsolhatja a lámpát. Tevékenység 
létrehozása: 
 

1. Ellenőrízze, hogy a megfelelő felhasználó van-e kiválasztva! 

2. A nyitóképernyőn érintse meg az  ikont, majd az Add Activity... 

menüpontot, vagy az  ikont, majd az  ikont! 
3. Az Activity Wizard Initialization képernyőn érintse meg a Next gombot! 
4. A How to Record Keystrokes... képernyőn érintse meg a Next gombot! 
5. Kövesse a mini-súgó útmutatásait gombnyomások rögzítéséhez! 

 
MEGJEGYZÉS: Gombnyomások rögzítése alatt a Stop megérintése után 
újrakezdheti a rögzítést, vagy a Pause megérintésével felfüggesztheti, majd 
később a felfüggesztés pontjától folytathatja. 
 

6. Válassza ki a tevékenységhez társítani kívánt képet, és érintse meg a Next 
gombot! 

7. Adjon nevet a tevékenységnek! 
8. Ha kívánja, hogy a tevékenység végrehajtása után megjelenjen a 

tevékenységben az utolsó eszköz távirányítója, kapcsolja be a Display last 
Device page after running the Activity jelölőnégyzetet! Például ha a 
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tevékenység utolsó eleme egy TV csatorna bekapcsolása, a Nevo a 
tevékenység végrehajtása után megjeleníti a TV távirányítóját, hogy 
szükség esetén tudjon csatornát váltani. 

9. Ha végzett, érintse meg a Done gombot! 
 

Tevékenység szerkesztése 
 

1. Ellenőrízze, hogy a megfelelő felhasználó van-e kiválasztva! 

2. A nyitóképernyőn érintse meg az  ikont! 
3. A felbukkanó menüben válassza az Edit Activity... menüpontot! 
4. Az Activity Wizard Initialization képernyőn érintse meg a Next gombot! 
5. Ha új gomb lenyomásokat kíván rögzíteni, kövesse a mini-súgó utasításait! 

Ha nem, ugorja át ezt a lépést. 
 
MEGJEGYZÉS: Ellenőrízze, hogy a Record a new sequence of keystroker? 
jelölőnégyzet be van-e kapcsolva! 
 

6. Ha új képet kíván társítani a tevékenységhez, válassza ki, majd érintse meg 
a Next gombot! Ha nem, ugorja át ezt a lépést. 

7. Ha meg kívánja változtatni a tevékenység nevét, adjon meg egy új nevet! 
Ha nem, ugorja át ezt a lépést. 

8. Ha be vagy ki kívánja kapcsolni a Display last Device page after running 
the Activity jelölőnégyzetet, érintse meg! Ha nem, ugorja át ezt a lépést! 

9. Ha végzett, érintse meg a Done gombot! 
 

Tevékenység törlése 
 

1. Ellenőrízze, hogy a megfelelő felhasználó van-e kiválasztva! 

2. A nyitóképernyőn érintse meg az  ikont! 
3. A felbukkanó menüben válassza a Delete Activity... menüpontot! 
4. A Confirm Activity Delete képernyőn érintse meg a Yes-t a törlés 

megerősítésére! 
 
MEGJEGYZÉS: Ha a tevékenység törlése után meggondolja magát, kövesse a 
„Tevékenység hozzáadása” részben bemutatott lépéseket! 
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További funkciók letöltése 
 
A myNevo.com weboldalról további funkciókat tölthet le, amelyekkel bővítheti a 
NevoHome Control lehetőségeit, mint például további gomb funkciókat és 
grafikákat. Kétféle grafikát tölthet le: 
 

• TV csatorna logókat a Kedvencek lista számára 
• Vezérlő gomb terveket a vezérlőképernyő kinézetének módosítására 

 
Először regisztrálnia kell a NevoHome Control-t a myNevo.com weboldalon. A 
regisztrációhoz szükséges adatok, például a szériaszám eléréséhez tegye a 
következőket: 
 

1. A Home fülön érintse meg az  ikont! 
2. Érintse meg az About Nevo... menüpontot! 

 
MEGJEGYZÉS: A myNevo.com weboldalról további készülékkódok is letölthetőek. 
 

Grafika letöltése 
 
További grafika letöltéséhez adja meg a myNevo.com weboldalon a készülék 
adatait: 
 

• a készülék típusát, 
• a készülék márkáját. 
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Gomb funkciók letöltése 
 
Gomb funkciók letöltéséhez további adatokat kell megadnia a myNevo.com 
weboldalon. Ezekhez az adatokhoz a következő módon férhet hozzá: 
 

1. A nyitóképernyőn érintse meg az  ikont a Customize Room menü 
megnyitásához! 

2. Érintse meg a Display Device Codes... menüpontot! Megjelenik az aktuális 
felhasználó és szoba készülékkód listája. 

3. Ha végzett, érintse meg a Close gombot! 
 
Adja meg a készülék adatait a myNevo.com weboldalon: 
 

• a készülék típusát, és 
• a készülék márkáját. 

 
A NevoHome Control-lal kapcsolatban bővebb információt, ötleteket, 
problémamegoldási javaslatokat a Súgóban találhat. A Súgó megnyitásához 
érintse meg a Start > Help > Nevo menüpontot! 
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iPAQ Wireless Manager 
 
Az iPAQ Wireless Manager segítségével központilag kezelheti a HP iPAQ 
vezetéknélküli funkcióit. 
 
Az iPAQ Wireless képernyő gombjaival egyenként be- és kikapcsolhatja a 
vezetéknélküli funkciókat, vagy az All Off gomb segítségével egyszerre 
kikapcsolhatja az összes vezetéknélküli funkciót. A képernyőn egy Settings gomb 
is rendelkezésre áll a Wi-Fi és a Bluetooth beállításainak elérésére. 
 

 
 

• Az iPAQ Wireless képernyő megnyitásához érintse meg a Today vagy a 

Launch képernyő alján a parancssorban az iPAQ Wireless ikont ( )! 

o Az iPAQ Wireless ikonon megjelenik egy „x” ( ), ha minden 
vezetéknélküli funkció ki van kapcsolva. 

• Egy vagy több vezetéknélküli funkció bekapcsolásához érintse meg a kívánt 
gombo(ka)t! 

• Egy vagy több vezetéknélküli funkció kikapcsolásához érintse meg a kívánt 
gombo(ka)t, vagy az All Off gombot minden vezetéknélküli funkció 
kikapcsolásához! 
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Be- és kikapcsoló gombok 
 
Az All Off gomb kivételével minden be- és kikapcsoló gombon megtalálhatóak az 
alábbi elemek: 
 

• Szürke háttér és egy „x” az ikonon, ha az adott vezetéknélküli funkció ki 
van kapcsolva. 

• Sárga háttér, ha a vezetéknélküli funkció be van kapcsolva és van jel, de 
nincs kapcsolat. 

• Zöld háttér, ha a vezetéknélküli funkció be van kapcsolva, és van 
kapcsolat, vagy hozzá van rendelve egy másik készülék. 

 
MEGJEGYZÉS: Ha egy gomb nem reagál azonnal az érintésre, az valószínűleg 
azért van, mert a kiválasztott feladatot hajtja végre a készülék. 
 
Az All Off gombon az alábbi elemek jelennek meg: 
 

• Szürke háttér és egy „x” az ikonon, ha minden vezetéknélküli funkció ki van 
kapcsolva. 

• Zöld háttér, ha egy vagy több vezetéknélküli funkció be van kapcsolva. 
 

Settings gombok 
 
A három Settings (Beállítások) gomb (Wi-Fi beállítások, Bluetooth beállítások és 
Bluetooth Manager) lehet engedélyezett és tiltott állapotban. Engedélyezett 
állapotban a Settings gomb megnyomására megnyílik a megadott vezetéknélküli 
funkció beállítások ablaka. 
 

Wi-Fi Settings gomb 
 
Ez a gomb akkor engedélyezett, ha a Wi-Fi gomb bekapcsolt vagy kapcsolódott 
állapotban van. Érintse meg a Wi-Fi Settings gombot a Wi-Fi beállítások képernyő 
megnyitásához! 
 
MEGJEGYZÉS: A Wi-Fi beállításokról bővebben a 7. fejezetben („iPAQ Wireless 
Manager”) olvashat. 
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Bluetooth Settings gomb 
 
Ez a gomb akkor engedélyezett, ha a Bluetooth gomb be van kapcsolva. Érintse 
meg a Bluetooth Settings gombot a Bluetooth beállítások képernyő megnyitásához! 
A Bluetooth beállítások képernyőn lehetősége van profilok létrehozására és 
törlésére, valamint a hozzáférési beállítások megváltoztatására. 
 
MEGJEGYZÉS: A Bluetooth beállításokról bővebben a 9. fejezetben („A Bluetooth 
használata”) olvashat. 
 
 

Bluetooth Manager gomb 
 
Ez a gomb akkor engedélyezett, ha a Bluetooth gomb be van kapcsolva. Érintse 
meg a Bluetooth Manager gombot a Bluetooth Manager megnyitásához és a 
kapcsolatok beállításához! 
 
MEGJEGYZÉS: A Bluetooth Manager-rel kapcsolatban bővebben a 9. fejezetben 
(„A Bluetooth használata”) olvashat. 
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A Wi-Fi használata 

Ismerkedés 
 
A vezetéknélküli hozzáférés feleslegessé teszi a kábelek használatát az Internethez 
való csatlakozáshoz. Az adatátvitelhez egy hozzáférési pontra (Wireless Access 
Point) van szükség. A HP iPAQ kapcsolódni tud 802.11b WLAN hálózathoz, 
vagy közvetlenül egy másik, WLAN-t támogató készülékhez. A Wi-Fi segítségével 
az alábbiakra nyílik lehetősége: 
 
§ Hozzáférhet az Internethez 
§ Küldhet és fogadhat e-mailt 
§ Hozzáférhet a vállalati hálózathoz 
§ Biztonságos kapcsolatot létesíthet a VPN (Virtual Private Network, virtuális 

magánhálózat) segítségével 
§ Vezetéknélküli kapcsolatot létesíthet a hozzáférési pontokkal. 

 
MEGJEGYZÉS: A betárcsázós és a vezetéknélküli Internet csatlakozás 
használatához, az e-mail küldéshez/fogadáshoz, a vállalati hálózat 
használatához és egyéb vezetéknélküli kommunikációhoz, mint például a 
Bluetooth-képes eszközök használatához elképzelhető, hogy külön megvásárolható 
eszközökre van szükség a WLAN infrastruktúra és a külön megkötött szerződés 
mellett. Érdeklődjön a szolgáltatónál a szolgáltatás rendelkezése állásával és a 
lefedettséggel kapcsolatban. Elképzelhető, hogy bizonyos Web tartalmak nem 
érhetőek el. Bizonyos tartalmak eléréséhez elképzelhető, hogy külön programot 
kell telepíteni. 
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Ismerkedés a Wi-Fi-vel 
 
Ebben a részben megtanulhatja a Wi-Fi használatot, megismerheti, hogyan 
kapcsolódhat egy hálózathoz, hogyan adhatja meg a hálózati beállításokat, 
valamint hogyan kereshet hálózatokat. 

 

A Wi-Fi be- és kikapcsolása 
 
MEGJEGYZÉS: A Wi-Fi antenna a HP iPAQ tetején található. Ha a Wi-Fi 
bekapcsolása után letakarja a készülék tetejét, a jel erőssége romolhat. 
 
A Wi-Fi bekapcsolásához a Launch vagy a Today képernyőn érintse meg a 
Wireless ikont ( ), majd a Wi-Fi gombot! Ha a Wi-Fi be van kapcsolva, a 
vezetéknélküli LED (a készülék bal felső sarkában) kékre vált, a Wi-Fi gomb pedig 
zöldre vált. 
 
MEGJEGYZÉS: A vezetéknélküli hálózat eléréséhez be kell kapcsolnia a Wi-Fi-t. Ha 
a kék vezetéknélküli LED világít és a képernyő tetején a nyilak kapcsolatot jeleznek 
( ), akkor a HP iPAQ kapcsolódott egy hálózathoz. 
 
A Wi-Fi kikapcsolásához ismét érintse meg a Wi-Fi gombot! A Wi-Fi 
kikapcsolásakor a vezetéknélküli LED kialszik és a Wi-Fi gomb szürkére vált. 
 
Ötlet az akkumulátor kímélésére: Kapcsolja ki a Wi-Fi-t, ha nem használja! Ha a 
Wi-Fi be van kapcsolva, állítsa be a Wi-Fi energiatakarékos módot! Bővebb 
információt a 10. fejezetben („Az akkumulátor kezelése”) találhat. 
 
MEGJEGYZÉS: Bizonyos hozzáférési pontok és hálózatok nem támogatják a 
rendelkezésre álló energiatakarékos módok némelyikét vagy mindegyikét. Ha nem 
tud kapcsolódni egy adott vezetéknélküli hálózathoz, kapcsolja ki a Wi-Fi Power 
Save (energiatakarékos) módokat! 
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Automatikus kapcsolódás a hálózathoz 
 

1. A Wi-Fi bekapcsolásához a Launch vagy a Today képernyőn érintse meg a 
Wireless ikont ( ), majd a Wi-Fi gombot! 

2. Ha egy vagy több hálózat elérhetővé válik, megjelenik a Network Indicator 
ikon ( ) a menüsorban. Érintse meg a hálózatot, amelyhez csatlakozni 
kíván, majd válassza ki, hogy a hálózat az Internethez csatlakozik-e (ekkor 
nem használ proxyt), vagy a munkahelyi hálózathoz (ekkor használ 
proxyt)! 

 

 
 
 
MEGJEGYZÉS: Az iPAQ Mobile Media használatához a „Work” (munkahelyi 
hálózat) lehetőséget kell választania. Az iPAQ Mobile Media lehetőségeiről 
bővebben a Special Features Guide (Külünleges lehetőségek) útmutatóban 
olvashat. 
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3. Amennyiben a rendszer kéri a hálózati hozzáférés jelszavát (Network Key, 
WEP), írja be a biztonsági beállításokat és érintse meg a Connect 
(Kapcsolódás) gombot! 

 

 

 

Az új hálózati beállítások kézi megadása 
 
Felvehet egy vezetéknélküli hálózatot amikor a készülék érzékeli azt (a Network 
Indicator ikon megjelenik a menüsorban), vagy kézzel is megadhatja az adatait. 
A hálózat adatainak kézi megadása: 
 

1. A Wi-Fi bekapcsolásához a Launch vagy a Today képernyőn érintse meg a 
Wireless ikont ( ), majd a Wi-Fi gombot! 

2. Az iPAQ Wireless képernyőn érintse meg a Settings gombot! Megjelenik a 
Configure Wireless Networks (Vezetéknélküli hálózatok beállítása) 
képernyő. 
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3. Tekintse át a hálózatok listáját, és érintse meg a kívánt hálózatot, ha az 
látható! (Ha egy vagy több hálózat elérhető, azt a Network indicator 
(Hálózatjelző) ikon ( ) jelzi.) 

 

 
 
MEGJEGYZÉS: Amennyiben nem látható a hálózat neve, hozzá kell adnia az 
előnyben részsített (preferált) hálózatok listájához. Ha a Wi-Fi be van kapcsolva, 
érintse meg a Settings gombot, majd az Add New... lehetőséget a Configure 
Wireless Networks (Vezetéknélküli hálózatok beállítása) listában! Adja meg a 
hálózat nevét, majd válassza ki, hogy helyi (Work) hálózathoz, vagy az 
Internethez (Internet) csatlakozik-e! 

 

 
 
MEGJEGYZÉS: Az iPAQ Mobile Media használatához a „Work” (munkahelyi 
hálózat) lehetőséget kell választania. Az iPAQ Mobile Media lehetőségeiről 
bővebben a Special Features Guide (Külünleges lehetőségek) útmutatóban 
olvashat. 
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4. Érintse meg a Network Key fület, és adja meg a titkosítási beállításokat! 
 

 
 

5. Érintse meg a 802.1x fület, és adja meg a hálózat jellemzőit! 
 

 
 

6. Érointse meg az OK-t! (Ettől kezdve a hálózat elérhető a Configure Wireless 
Networks (Vezetéknélküli hálózat beállítása) listában.) 

7. Érintse meg az OK-t a Configure Wireless Networks képernyő bezárásához! 
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Hálózat keresése 
 
A készülék a már beállított hálózatokat részesíti előnyben, és ezek szerepelnek az 
iPAQ Wireless képernyő > Settings > Wireless Networks listában. Eldöntheti, hogy 
csak az előnyben részesített hálózatokhoz kíván csatlakozni, vagy hogy a 
készülék keressen más hálózatokat is és csatlakozzon hozzájuk. 
 
Hálózatok keresése: 
 

1. Az iPAQ Wireless képernyőn érintse meg a Settings > Wireless fület! 
2. A Networks to access dobozban válassza ki, milyen típusú hálózathoz 

kíván csatlakozni (All available (Bármilyen), Only access points (Csak 
hozzáférési pontok), Only computer-to-computer (Csak számítógépek 
közötti)! 

3. Ha csak már beállított hálózatokhoz kíván csatlakozni, kapcsolja ki az 
Automatically connect to non-preferred networks jelölőnégyzetet! 

 
MEGJEGYZÉS: Ha bekapcsolja az Automatically connect to non-preferred 
networks jelölőnégyzetet, a HP iPAQ detektálni fogja az új hálózatokat és 
felajánlja a lehetőséget, hogy beállítsa őket. 
 

A vezetéknélküli hálózat beállításainak kezelése 
 
A vezetéknélküli hálózatok kezelése során néha szükséges azok beállításainak 
megváltoztatása. A következő két részben megtalálja, hogyan tekintheti meg, 
szerkesztheti vagy törölheti a rendelkezésre álló vezetéknélküli hálózatok 
beállításait. 

Vezetéknélküli hálózat beállításainak megtekintése és módosítása 
 
Létező vagy elérhető vezetéknélküli hálózat beállításainak megtekintése és 
módosítása: 
 

1. Kapcsolja be a Wi-Fi-t! 
2. Az iPAQ Wireless képernyőn érintse meg a Settings > Wireless fület! 
3. A Wireless networks dobozban érintse meg a kívánt hálózat nevét! 
4. Módosítsa a beállításokat szükség szerint, majd érintse meg az OK gombot 

a beállítások elmentéséhez! 
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Vezetéknélküli hálózat eltávolítása 
 
Létező vagy detektált vezetéknélküli hálózat eltávolítása: 
 

1. Kapcsolja be a Wi-Fi-t! 
2. Az iPAQ Wireless képernyőn érintse meg a Settings > Wireless fület! 
3. A Wireless networks dobozban érintse meg és tartsa a tollat a törölni kívánt 

hálózat nevén! 
4. Érintse meg a Remove Settings menüpontot! 

 

A jel állapotának és erősségének felügyelete 
 
A HP iPAQ és a hozzáférési pont közti Wi-Fi kapcsolat állapotának megtekintése: 
 

1. Érintse meg a Connections ikont (  vagy ) a menüsorban! 
2. A Connectivity doboz megjelenésekor megnézheti a hálózat típusát (mint 

például minkahelyi vagy Internet), továbbá egy ikon jelzi a jel erősségét. 
 
MEGJEGYZÉS: A Signal Strength (jelerősség) ikon nem jelenik meg, ha nincs 
kapcsolat. 
 

3. A kapcsolat beállításainak módosításához érintse meg a Settings-t! 
4. A Connectivity dobozból való kilépéshez érintse meg a Hide gombot! 
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Haladó hálózati beállítások 
 
A következő részek bemutatják a hálózati beállítások módosítását. 
 

Fogalmak 
 
A Wi-Fi használatához ajánlott ismerni az alábbi fogalmakat. 
Fogalom Jelentés 
Titkosítás (WEP) vagy 
IEEE 802.1x 

A 802.11-es hálózatok illetéktelen használat elleni 
védelmét biztosító szolgáltatások. 

Eszköz-gép vagy ad-hoc 
(Device-to-computer 
vagy ad-hoc) 

Ebben az üzemmódban nincs szükség hozzáférési 
pontokra. Peer-to-peer hálózati kapcsolatokban 
használják. 

Domain Name System 
(DNS) 

A domain neveket IP címekre átfordító rendszer. A 
neveket könnyebb megjegyezni, mint például a 
www.horseshow.com nevet, mint egy xxx.xxx.xxx.xxx 
alakú IP címet. 

Elérési pont (Hotspot) Nyilvános vagy magán terület, ahol rendelkezésre áll 
egy hozzáférési pont, például könyvtárban vagy 
kávéházban. 

Infrastruktúra 
(Infrastructure) 

Ez a hozzáférési mód vezetéknélküli hozzáférési 
pontok segítségével kapcsolódik a hálózathoz. 

Internet Protocol (IP) cím Az Interneten küldött adatcsomagok feladóját és 
címzettjét azonosító szám. 

SSID vagy Hálózati név 
(Network Name) 

Az SSID a Service Set Identifier rövidítése. Ez egy 
legfeljebb 32 karakterből álló azonosító szám. A kis- és 
nagybetűk különbözőnek számítanak. 

Transmission Control 
Protocol/Internet 
Protocol (TCP/IP) 

Az Internet általánosan használt kommunikációs nyelve. 

Vezetéknélküli 
hozzáférési pont 
(Wireless Access Point) 

A hozzáférési pont vezetéknélküli hozzáférést biztosít a 
hálózathoz (plussz hardver eszköz). 

Windows Internet 
Naming Service (WINS) 

A munkaállomások és az IP címek összerendelésére 
szolgáló megoldás. 

 

http://www.horseshow.com
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IP cím megkeresése 
 
A vezetéknélküli hálózat által használt IP cím megkeresése: 
 

1. Ellenőrízze, hogy a Wi-Fi be van-e kapcsolva! 
2. Kapcsolódjon a megfelelő hálózathoz a Connections ikon (  vagy ), 

majd a Settings > Advanced fül > Select Networks gomb megérintésével! 
Ha már kapcsolódott egy hálózathoz, folytassa az 5. lépésnél! 

3. Érintse meg a hálózat nevét, amelyen keresztül kapcsolódni kíván az 
Internethez vagy egy virtuális magánhálózathoz (VPN)! Ha meg kívánja 
változtatni a hálózatot, vagy újat kíván létrehozni, érintse meg az Edit... 
vagy a New... gombot! Ha végzett, érintse meg az OK gombot! 

4. A Connections képernyőn állítsa be a tárcsázási szabályokat (Dialing Rules) 
és a kivételeket (Exceptions), majd nyomja meg az OK-t! 

5. Az iPAQ Wireless képernyőn érintse meg a Wi-Fi Settings gombot, majd a 
Network Adapters fület! 

6. Érintse meg a megfelelő csatolót a beállítások módosításához! Az IP cím az 
IP Address dobozban jelenik meg. 

 

A TCP/IP beállítások megváltoztatása 
 
MEGJEGYZÉS: A legtöbb Internet szolgáltató (ISP) és a legtöbb hálózat 
dinamikusan kiosztott IP címeket használ. Csak akkor kell módosítania a TCP/IP 
beállításokat, ha a szolgáltatója vagy a hálózat, amelyhez csatlakozik, nem 
dinamikus IP címeket használ. Ha bizonytalan, beszéljen a hálózati 
adminisztrátorával! 
 
A TCP/IP beállítások megváltoztatása: 
 

1. Kérdezze meg az Internet szolgáltatójától vagy a hálózati 
adminisztrátorától az IP címét (IP address), az alhálózati maszkot (subnet 
mask) és az alapértelmezett átjáró (default gateway) címét, ha szükséges. 

2. Bizonyosodjon meg róla, hogy a Wi-Fi be van kapcsolva. 
3. Az iPAQ Wireless képernyőn érintse meg a Settings > Network Adapters 

fület! 
4. A My network card connects to... legördülő menüben válassza ki, hogy 

hová csatlakozik (The Internet – az Internethez, Work – munkahelyi 
hálózathoz)! 
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MEGJEGYZÉS: Ha az Internethez csatlakozik, válassza a The Internet lehetőséget! 
Ha magánhálózathoz csatlakozik, mint például a munkahelyi hálózathoz, 
válassza a Work lehetőséget! 
 
 

5. A Tap an adapter to modify settings dobozban érintse meg a HP iPAQ Wi-
Fi Adapter elemet! 

6. Érintse meg az IP Address fület! 
7. Érintse meg a Use specific IP address elemet és adja meg a kért információt! 
8. Érintse meg az OK gombot a beállítások elmentéséhez! 

 

A DNS és WINS beállítások megváltoztatása 
 
MEGJEGYZÉS: A legtöbb Internet szolgáltató (ISP) és a legtöbb hálózat 
dinamikusan kiosztott IP címeket használ. Csak akkor kell módosítania a DNS és 
WINS beállításokat, ha a szolgáltatója vagy a hálózat, amelyhez csatlakozik, 
nem dinamikus IP címekt használ. Ha bizonytalan, beszéljen a hálózati 
adminisztrátorával! 
 
Az IP címmel rendelkező szerverek eléréséhez sokszor szükség van egy 
mechanizmusra, amely a számítógép nevét lefordítja annak IP címére. A HP iPAQ 
két névfeloldási megoldást támogat: 
 
§ DNS 
§ WINS 

 
A beállítások megváltoztatása: 
 

1. Kérdezze meg az Internet szolgáltatójától vagy a hálózati 
adminisztrátorától, melyik névfeloldási mechanizmust kell használnia, 
továbbá a szerver címét, és hogy rendelkezésre állnak-e másodlagos 
szerverek. 

 
MEGJEGYZÉS: Az elsődleges szerver elérhetetlensége esetén a másodlagos 
szerverhez csatlakozhat. 
 

2. Bizonyosodjon meg róla, hogy a Wi-Fi be van kapcsolva! 
3. Az iPAQ Wireless képernyőn érintse meg a Settings > Network Adapters 

fület! 
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4. A My network card connects to... legördülő menüben válassza ki, hogy 
hová csatlakozik (The Internet – az Internethez, Work – munkahelyi 
hálózathoz)! 

 
MEGJEGYZÉS: Ha az Internethez csatlakozik, válassza a The Internet lehetőséget! 
Ha magánhálózathoz csatlakozik, mint például a munkahelyi hálózathoz, 
válassza a Work lehetőséget! 
 

5. A Tap an adapter to modify settings dobozban érintse meg a HP iPAQ Wi-
Fi Adapter elemet! 

6. Érintse meg a Name Servers fület és adja meg a kért információt! 
7. Érintse meg az OK gombot a változtatások elmentéséhez! 

 

VPN kapcsolat beállítása 
 
A VPN kapcsolat segítségével biztonságos kommunikációt folytathat az Interneten 
keresztül magán- vagy vállalati hálózattal. A VPN kapcsolat beállítása: 
 

1. Kérdezze meg a hálózati adminisztrátortól a felhasználónevét, jelszavát, 
domain nevét, a TCP/IP beállításokat, továbbá a VPN szerver nevét vagy IP 
címét! 

2. Érintse meg a Connections ikont (  vagy ) a menüsorban, majd a 
Settings > Task fület a Connections képernyőn! 

3. A My Work Network részben érintse meg az Add a new VPN server 
connection (Új VPN kapcsolat létrehozása) elemet! 

4. Kövesse a Make New Connection (Új kapcsolat létrehozása) varázsló 
utasításait! 

 
MEGJEGYZÉS: Az Új kapcsolat létrehozása varázslóban illetve a beállításoknál a 

 ikonnal érheti el a Súgót. 
 

A VPN kapcsolat módosítása 
 

1. Érintse meg a Connections ikont (  vagy ) a menüsorban, majd a 
Settings > Task fület a Connections képernyőn! 

2. A My Work Network részben érintse meg a Manage existing connections > 
VPN fület! 
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3. Érintse meg a módosítandó VPN kapcsolatot, majd az Edit... vagy a New... 
elemet! 

4. Kövesse a képernyőn látható utasításokat a módosítás elvégzéséhez! 
 

VPN kapcsolat elindítása 
 
VPN kapcsolat elindítása: 
 

1. Kapcsolja be a Wi-Fi-t! 
2. Válassza ki az elindítandó VPN kapcsolatot! Érintse meg a Connections 

ikont (  vagy ) a menüsorban! 
 
A HP iPAQ automatikusan kapcsolódik a virtuális magánhálózathoz. 

 

Proxy szerver beállítása 
 
Ha a szinkronizáció során kapcsolatban áll az Internet szolgáltatójával vagy a 
hálózattal, a HP iPAQ letölti a megfelelő proxy beállításokat a számítógépről. Ha 
a beállítások nem állnak rendelkezésre a számítógépen vagy módosítani kell őket, 
akkor kézzel kell beállítania. A proxy szerver beállítása: 
 

1. Kérdezze meg az Internet szolgáltatójától vagy a hálózati 
adminisztrátorától a proxy szerver nevét, a szerver típusát, a portot, a 
használt Socks protokoll típusát, továbbá a felhasználónevét és a jelszavát! 

2. Győződjön meg róla, hogy a Wi-Fi be van kapcsolva! 
3. Érintse meg a Connections ikont (  vagy ) a menüsorban, majd a 

Settings > Task fület! 
4. A My Work Network részben érintse meg az Edit my proxy server > Proxy 

Settings fület! 
5. Érintse meg a This network connects to the Internet és a This network uses a 

proxy server to connect to the Internet négyzeteket! 
6. A Proxy server dobozban adja meg a proxy szerver nevét! 
7. Ha meg kell változtatnia a portot vagy a proxy szerver típusát, érintse meg 

az Advanced gombot és módosítsa a kívánt beállításokat! 
8. Érintse meg az OK gombot! 
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A Bluetooth használata 
 
A HP iPAQ képes Bluetooth kapcsolat létrehozására, amely rövid távolságban 
gyors, megbízható vezetéknélküli kommunikációt biztosít. 
 
A Bluetooth segítségével adatokat küldhet vagy végrehajthatja a következő 
feladatokat két Bluetooth-képes eszköz között, maximálisan kb. 10 méteres 
távolságból: 
 

• Névjegyek, naptár bejegyzések, teendők átküldése 
• Névjegykártyák cseréje vagy átküldése 
• Fájlok átvitele 
• Szinkronizálás a számítógéppel az ActiveSync segítségével 
• Kapcsolat Bluetooth-kompatibilis telefonnal és a telefon használata 

vezetéknélküli modemként 
• Kapcsolat más Bluetooth eszközökkel (virtuális COM port) 
• Nyomtatás Bluetooth nyomtatóra 
• Személyes helyi hálózat (Personal Area Network, PAN) létrehozása 

csevegés, játék stb. céljából 
 
MEGJEGYZÉS: A betárcsázós és vezetéknélküli Internet, e-mail, vállalati hálózat és 
egyéb vezetéknélküli kapcsolatokhoz, mint például a Bluetooth-képes eszközök 
használatához külön megvásárolt eszközökre lehet szükség a Wi-Fi infrastruktúra 
és a külön megkötött szerződés mellett. Érdeklődjön a szolgáltatójánál az 
elérhetőséggel és a lefedettséggel kapcsolatban! Nem minden Web tartalom 
elérhető. Elképzelhető, hogy bizonyos Web tartalmak nem érhetőek el. Bizonyos 
tartalmak eléréséhez elképzelhető, hogy külön programot kell telepíteni. 
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Ismerkedés a Bluetooth-szal 
 
Mielőtt vezeték nélküli kapcsolatot hoz létre a Bluetooth-on keresztül, szánjon pár 
percet az alábbiak megismerésére: 
 

• A fejezetben használt kifejezések 
• Támogatott szolgáltatások 
• Bluetooth beállítások 
• Bluetooth Manager 

 
 
MEGJEGYZÉS: Részletesebb segítségért olvassal el a HP iPAQ-on található Súgó 
fájlokat. A Start menüben érintse meg a Help > Bluetooth menüpontot! 
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Fogalmak 
 
A fejezetben a következő fogalmak szerepelnek: 
 
Fogalom Jelentés 
Azonosítás Egy numerikus jelkulcs ellenőrzése egy kapcsolat 

létrehozása vagy egy művelet végrehajtása előtt. 
Jogosultság ellenőrzés Egy kapcsolat vagy művelet engedélyezése a létrehozása 

illetve a végrehajtása előtt. 
Párosítás (párosított 
eszközök) 

A saját és egy másik eszköz között megbízható kapcsolat 
létrehozása. A párosítás létrejötte után a két készülék 
párosítva lesz. A párosított eszközök nem igényelnek 
azonosítást és jogosultság ellenőrzést. 

Készülékcím A Bluetooth eszköz egyedi elektronikus címe. 
Eszköz felfedezés Más Bluetooth eszköz megkeresése és felismerése. 
Eszköznév A felfedezett Bluetooth eszköz által az őt keresőnek 

megadott név. 
Titkosítás Adatvédelmi eljárás. 
Jelkulcs A kapcsolatokat és műveleteket kezdeményező 

készülékek azonosítására szolgáló kód. 
Személyes Információ 
Kezelő (Personal Infor-
mation Manager, PIM) 

A napi üzleti tevékenységet segítő alkalmazások 
együttese (például Contacts, Calendar, Tasks). 

Profil Bluetooth beállítások gyűjteménye. 
Szolgáltatás felfedezés A készülékeken megtalálható közös programok 

felfedezése. 
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Támogatott szolgáltatások 
 
A Bluetooth által támogatott funkciókat szolgáltatásoknak nevezzük. Csak azokkal 
a Bluetooth eszközökkel tud kommunikálni, amelyek a következő szolgáltatások 
közül legalább egyet támogatnak: 
 

• BPP (Basic Printer Profile – Nyomtatás) 
• FTP (File Transfer Profile – Fájl átvitel) 
• GAP (Generic Access Profile – Általános hozzáférés) 
• LAP (LAN Access Profile – LAN hozzáférés) 
• OBEX (Object Exchange Profile – Objektumcsere) 
• OPP (Object Push Profile – Objektum küldés) 
• PAN (Personal Area Network Profile – Személyes helyi hálózat) 
• SPP (Serial Port Profile – Soros port) 
• ActiveSync (SPP-n keresztül kapcsolódik a számítógéphez) 

 

Bluetooth beállítások használata 
 
A Bluetooth Settings fülön az alábbiakra nyílik lehetősége: 
 

• Felhasználó profil kiválasztása 
• Bluetooth be- és kikapcsolása 
• A HP iPAQ Bluetooth azonosító nevének megadása vagy megváltoztatása 
• A kapcsolat tulajdonságainak beállítása 
• Bluetooth szolgáltatások engedélyezése 
• Biztonsági beállítások meghatározása 
• A megosztás és a csatlakozás beállítása 
• A szoftverekre és a portokra vonatkozó információk megtekintése 
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A Bluetooth bekapcsolása 
 
A Bluetooth bekapcsolása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless ikont! 
2. Az iPAQ Wireless képernyőn érintse meg a Bluetooth ikont! 

 
Ha a Bluetooth be van kapcsolva, a HP iPAQ tetején a Bluetooth LED kéken világít. 
 
A Bluetooth kikapcsolásához ismét érintse meg a Bluetooth ikont! Ha a Bluetooth ki 
van kapcsolva, a Bluetooth LED nem világít és se kimenő, se bejövő Bluetooth 
kapcsolat nem hozható létre. 
 
Ötlet az akkumulátor kímélésére: Kapcsolja ki a Bluetooth-t, ha nem használja! 
 
 

A Bluetooth beállítások megnyitása 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont! 
2. Az iPAQ Wireless képernyőn érintse meg a Bluetooth Settings pontot! 

 

Elérhetőségi beállítások módosítása 
 
Mielőtt a Pocket PC kapcsolatba lép más Bluetooth eszközökkel, meg kell adnia 
vagy módosítania kell a hozzáférési beállításokat. 
 
A Hozzáférések (Accessibility) képernyő megnyitása: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont! 
2. Az iPAQ Wireless képernyőn érintse meg a Bluetooth Settings > 

Accessibility fület! 
3. Jelölje ki a nevet a Name mezőben és adja meg az eszköz nevét! Ezt a 

nevet fogja látni a többi eszköz, amikor megtalálják a készüléket. 
4. Válassza ki az Allow other devices to connect (Más eszközök 

csatlakozásának engedélyezése) pontot! 
5. Válassza ki az All devices (Minden eszköz) vagy a Paired devices only 

(Csak párosított eszközök) lehetőségek közül az egyiket! 
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FIGYELEM: Az All devices lehetőség választása esetén minden eszköz, még az Ön 
számára ismeretlenek is, csatlakozhat az Ön Pocket PC-jéhez. Ha a csatlakozás 
megtörtént, a különböző szolgáltatásokra a Bluetooth Settings-ben megadott 
biztonsági beállítások lesznek érvényesek. A Paired devices only lehetőség 
választásakor csak azok az eszközök csatlakozhatnak a HP iPAQ-hoz, 
amelyekben megbízik. 
 
MEGJEGYZÉS: A párosított eszközök egy, a készülék által létrehozott biztonságos 
Kapcsolat kulcsot osztanak meg illetve cserélnek ki egymással a kapcsolat 
létrejötte előtt. 
 

6. Kapcsolja be az Other devices can discover me lehetőséget, ha kívánja, 
hogy más eszközök megtalálhassák az Ön készülékét! Ha ezt nem 
szeretné, akkor hagyja ezt a lehetőséget kikapcsolva! 

 
MEGJEGYZÉS: Ha egy másik készüléknek megvan az Ön készülékének a címe, és 
be van kapcsolva az Other devices can discover me lehetőség, a másik készülék 
akkor is meg tudja találni és csatlakozni tud az Önéhez, ha Ön ezt nem 
kezdeményezte. 
 

7. Érintse meg az OK gombot a beállítások elmentéséhez! 
 

Bluetooth szolgáltatások engedélyezése 
 
Az alábbi biztonsági beállításokat alkalmazhatja fájlok átvitelekor, soros porti 
kapcsolat létrehozásakor, névjegyek cseréjekor, betárcsázós hálózati kapcsolat 
beállításakor és személyes helyi hálózathoz való kapcsolódáskor. 
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Szolgáltatások automatikus engedélyezése 
 
Szolgáltatások automatikus engedélyezése: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont! 
2. Érintse meg a Bluetooth Settings > Services fület! 
3. A Services dobozban válassza ki az engedélyezni kívánt szolgáltatást: 

File Transfer (fájl átvitel), Information Exchange (Adatcsere), Serial Port 
(Soros port), vagy Personal Network Server (Személyes hálózati szerver). 

 

 
 

4. A kiválasztott szolgáltatás automatikusan elérhetővé teszi a Service 
settings (Szolgáltatás beállítása) részt. Érintse meg a megfelelő 
jelölőnégyzetet, ha módosítani kívánja a beállításokat! 

5. Érintse meg az OK gombot az iPAQ Wireless képernyőhöz való 
visszatéréshez! 

 
MEGJEGYZÉS: Ha a beállításoknál az bekapcsolja az Authorization required 
lehetőséget, minden kapcsolatot engedélyeznie kell: a HP iPAQ minden esetben rá 
fog kérdezni, hogy engedélyezni kívánja-e a kapcsolatot. 
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Biztonságos kapcsolat jelkulcs vagy összeköttetés használatával 
 
Ha biztonságos kapcsolatot kíván létesíteni egy másik eszközzel, használhat 
jelkulcsot vagy összeköttetést. Ezt titkosítással is kiegészítheti. 
 
A jelkulcs egy olyan kód, amely a más eszközök által kezdeményezett kapcsolatok 
azonosítására szolgál.  A jelkulcsot mindkét félnek ismernie és használnia kell, 
különben a kapcsolat nem jöhet létre. 
 
Jelkulcs vagy összeköttetés használata:  
 

1. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth Settings > 
Services fület! 

2. Érintse meg az engedélyezni kívánt szolgáltatás fülét: File Transfer (fájl 
átvitel), Information Exchange (Adatcsere), Serial Port (Soros port), vagy 
Personal Network Server (Személyes hálózati szerver). 

3. Kapcsolja be az Authentication (Passkey) required jelölőnégyzetet! 
4. Kapcsolja be az Encryption required jelölőnégyzetet, amennyiben titkosított 

kommunikációt kíván folytatni! 
5. Érintse meg az OK gombot! 
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Megosztott mappa beállítása 
 
Megadhatja, hogy a többi készülék melyik mappához férjen hozzá, amikor a HP 
iPAQ-hoz kapcsolódnak. 
 
A megosztott mappa kiválasztása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless ikon > Bluetooth Settings 
> Services fület! 

2. A Services pontban érintse meg a File Transfer elemet! 
3. A Service Settings pontban állítsa be a kívánt paramétereket! 
4. Érintse meg az Advanced gombot! 

 

 
 

5. Érintse meg a Folder ikont, és válassza ki a kívánt mappát! 
6. Érintse meg az OK gombot az iPAQ Wireless képernyőhöz való 

visszatéréshez! 
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Profilok használata 
 
Használjon profilokat a különböző környezeteknek megfelelő egyéni beállítások 
gyors beállításához! 
 
Profil létrehozása 
 
Profil létrehozása: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont! 
2. Érintse meg a Bluetooth Settings > General fül > Lookup ikont! 

 

 
 

3. Érintse meg a New gombot! 
4. Adjon meg egy kifejező nevet! 
5. Válasszon egy sablonként használni kívánt, meglévő profilt! 
6. Érintse meg az OK gombot! 
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Profil bekapcsolása 
 
Miután létrehozott egy profilt, be kell kapcsolnia, ha szeretné, hogy az legyen az 
aktív profil. 
 
A létrehozott profil bekapcsolása: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth Settings elemet! 

2. A General fülön válassza ki a profilt a Current Profile legördülő listából! 
3. Érintse meg az OK gombot! 

 
 
Bluetooth beállítások elmentése profilba 
 
A Bluetooth beállítások elmentése valamelyik profilba: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth Settings elemet! 

2. A General fülön válasszön egy profilt s Profile legördülő listából! 
3. Érintse meg a Services fület és állítsa be a kívánt kapcsolatot, megosztást és 

a biztonsági beállításokat minden Bluetooth szolgáltatáshoz! 
4. Érintse meg az OK gombot a változtatások elmentéséhez és zárja be a 

Bluetooth Services ablakot! 
 
Profil átnevezése 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth Settings elemet! 

2. A General fülön érintse meg a Lookup ikont! 
3. Válasszon egy profilt az Add/Delete Profiles listából! 
4. Érintse meg a Rename gombot! 
5. Adjon meg egy új, kifejező nevet! 
6. Érintse meg az OK gombot! 
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Profil törlése 
 

1. A Today képernyőn érintse meg az iPAQ Wireless ikont, majd a Bluetooth > 
Settings elemet! 

2. A General fülön érintse meg a Lookup ikont! 
3. Válasszon egy profilt az Add/Delete Profiles listából! 
4. Érintse meg a Delete gombot! 
5. Érintse meg a Yes gombot annak megerősítéseként, hogy valóban törölni 

akarja a profilt! 
6. Érintse meg az OK gombot! 

 

A Bluetooth Manager használata 
 
A Bluetooth Manager használatával a következőkre nyílik lehetősége: 
 

• Kapcsolat létrehozása 
• Névjegyek cseréje 
• A képernyőn történő megjelenés szabályozása 
• Parancsikonok megjelenítése 

 

A Bluetooth Manager indítása 
 
A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, majd a 
Bluetooth Manager menüpontot! 
 
Az első megjelenő képernyő a My Shortcuts. 
 
MEGJEGYZÉS: A Bluetooth-nak bekapcsolt állapotban kell lennie, különben a 
Bluetooth Manager gomb nem engedélyezett. Ha le van tiltva a Bluetooth 
Manager gomb, nem tudja elindítani a Bluetooth Manager-t, ezért a következő 
műveletek során a Bluetooth bekapcsolása is szerepel. Amennyiben a Bluetooth 
már be van kapcsolva, amikor végrehajtja az adott műveletet, ne érintse meg újból 
a Bluetooth gombot! Amennyiben a Bluetooth be van kapcsolva, a Bluetooth gomb 
megérintése kikapcsolja! 
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Készülék megkeresése és kiválasztása 
 
Sok feladat végrehajtásához meg kell keresnie egy másik készüléket és 
kapcsolódnia kell hozzá. Ha meg kell keresnie egy készüléket, a Bluetooth tallózó 
megkeresi azt a szolgáltatást, amelyet a másik Bluetooth készülék támogat. 
 
 
Készülékek párosítása 
 
Készülékeket párosíthat úgy, hogy azoknak előtte ki kell cserélniük egymás közt 
egy generált kulcsot minden kapcsolat előtt. A kulcs a Bluetooth eszköz egyedi 
címéből, egy véletlen számból és egy, a felhasználó által megadott jelszóból áll. 
 
Párosítás után megbízható kapcsolat jön létre a két készülék között, a 
felhasználótól nincs szükség további bevitelre. A két párosított eszköz között a 
továbbiakban a felhasználó részéről történő állandó engedélyezés nélkül is jöhet 
létre kapcsolat, illetve végezhetnek műveleteket egymással. 
 
Készülékek párosítása: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a Tools > Paired devices elemet! 
3. Érintse meg az Add gombot! 

4. Érintse meg a Lookup ( ) ikont! 
5. Érintsen meg egy eszközt! 
6. Írjon be egy jelszót a Passkey mezőbe! 
7. Érintse meg az OK gombot! 
8. Írja be ugyanazt a jelszót a másik eszközön is! 

 
MEGJEGYZÉS: Bizonyos eszközök esetében, mint például a mobiltelefonoknál, 
engedélyezni kell, hogy elfogadjon párosítási kéréseket más eszközöktől. Erről az 
adott készülék használati útmutatójából tudhat meg többet. 
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Párosítás megszüntetése 
 
A készülékek párosítását megszüntetheti: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a Tools > Paired devices elemet! 
3. Érintse meg a megfelelő eszköz nevét! 
4. Érintse meg a Remove gombot! 
5. Érintse meg a Yes gombot a párosítás megszüntetéséhez! 

 

Kapcsolódás más eszközökhöz 
 
Az ActiveSync használatával, soros és betárcsázó kapcsolatokkal kommunikálhat 
más Bluetooth készülékekkel. Kapcsolatot hozhat létre mobiltelefonnal és 
használhatja az általa kínált Bluetooth szolgáltatásokat. 
 

A kommunikációs port azonosítása 
 
Azonosíthatja a virtuális soros (COM) portokat, amelyeken keresztül a soros porti 
kapcsolat létrejön. Szüksége lehet ezekre a soros portokhoz bizonyos műveletek 
végrehajtásához, mint például nyomtatáshoz. 
 
A bejövő soros portot olyankor használja, amikor másik készülék kezdeményez 
soros porti kapcsolatot. A kimenő soros portot olyankor használja, amikor 
kapcsolatot kezdeményez egy másik készülékkel. 
 
A kommunikációs port azonosítása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth Settings > 
Services fület! 

2. A Services pontban érintse meg a Serial Port-ot, majd az Advanced… 
gombot! 

3. Jegyezze fel a bejövő és a kimenő COM portok nevét! 
4. Érintse meg az OK gombot! 
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Kapcsolat kezelése 
 
Parancsikonokat hozhat létre a kapcsolatok megnyitására és adatainak 
megtekintésére. 
 
Parancsikon létrehozása 
 
A parancsikon létrehozása nem nyitja meg a kapcsolatot, csak egy parancsikont 
helyez a Bluetooth Manager Shortcut fülére. 
 
Parancsikon létrehozása: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a New-t, adja meg a szolgáltatás típusát, majd érintse meg a 
Next-et! 

3. Kövesse a képernyőn látható utasításokat! 
 
MEGJEGYZÉS: A párosított eszközöket pipa jelöli. 
 
 
Parancsikon törlése 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg és tartsa a tollat a törlendő kapcsolat ikonján vagy nevén! 
3. Érintse meg a Delete menüpontot! 
4. Érintse meg a Yes gombot a törlés megerősítésére! 
5. Érintse meg az OK gombot! 

 
Parancsikonok megtekintése 
 
A parancsikonokat ikon vagy lista formátumban tekintheti meg. 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a View elemet! 
3. Érintse meg a List (Lista) vagy az Icon (Ikon) lehetőséget! 
4. Érintse meg az OK-t! 
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ActiveSync kapcsolat létrehozása 
 
Ha ActiveSync kapcsolatot kíván létrehozni egy Bluetooth-képes számítógéppel, 
először a számítógépen állítsa be a kapcsolatot, majd a HP iPAQ-on! 
 
Ha Bluetooth modult vagy kártyát használ a számítógépen, a Bluetooth 
Configuration Manager-nél illetve a Beállításoknál látottakhoz hasonlóan kell 
eljárnia, majd ugorjon az „ActiveSync kapcsolat beállítása a HP iPAQ-on” 
részhez! 
 
 
ActiveSync kapcsolat beállítása a HP iPAQ-on 
 
ActiveSync kapcsolat létrehozása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth > Manager 
menüpontot! 

2. Érintse meg a New > ActiveSync via Bluetooth > Next menüpontot! 
 

 
 

3. Kövesse a képernyőn látható utasításokat! 
 
MEGJEGYZÉS: A HP iPAQ-on és a számítógépen egyformán kell az ActiveSync 
COM portot beállítani. 
 

4. A Bluetooth Browser képernyőn válassza ki a számítógépet, amellyel 
szinkronizálni kíván, majd érintse meg a Next gombot! 
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5. A Serial Port Selection részben válassza ki a számítógép soros portjának 
nevét, majd érintse meg a Next > Finish elemeket! 

 

 
 
 

Soros porti kapcsolat létrehozása 
 
A Bluetooth-on keresztül létrehozott soros porti kapcsolatot ugyanúgy használhatja, 
mintha egy soros kábellel lenne összekötve a két eszköz. A soros portot használó 
alkalmazást a megfelelő soros portra kell beállítania. 
 
Soros porti kapcsolat létrehozása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless ikont, majd a Bluetooth > 
Manager menüpontot! 

2. Érintse meg a New > Explore a Bluetooth device > Next elemet! 
3. Kövesse a kapcsolódás varázsló utasításait! 
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Kapcsolódás személyes helyi hálózathoz 
 
Összeköthet két vagy több Bluetooth eszközt és megoszthat fájlokat, 
közreműködhet munkában illetve játszhat többjátékos játékokat. 
 
Személyes helyi hálózati kapcsolat (Personal Area Network, PAN) létrehozása: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth > Manager 
menüpontot! 

2. Érintse meg a New > Join a personal network > Next gombot! 
3. Kövesse a kapcsolódás varázsló utasításait! 

 
 

Kapcsolódás mobiltelefonhoz 
 
Kapcsolatot hozhat létre mobiltelefonnal, és használhatja az általa felajánlott 
Bluetooth szolgáltatásokat. 
 
Kapcsolat létrehozása mobiltelefonnal: 
 

1. A Today képernyőn érintse meg az iPAQ Wireless ikont, majd a Bluetooth > 
Manager elemet! 

2. Érintse meg a New > Connect to Internet via phone menüpontot! 
3. Kövesse a kapcsolat varázsló utasításait! 

 

Fájlok kezelése 
 
Információkat cserélhet egy csatlakoztatott készülékkel, és a Bluetooth File Explorer 
segítségével: 
 

• Navigálhat a könyvtárakban 
• Megtekinthet fájlokat és mappákat 
• Létrehozhat új mappát 
• Küldhet és fogadhat fájlokat a távoli készülékről 
• Törölhet vagy átnevezhet fájlokat a távoli készüléken 
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Adatátviteli kapcsolat létrehozása 
 

1. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth > Manager 
menüpontot! 

 
Az első megjelenő képernyő a My Shortcuts. 
 

2. Érintse meg a New > Browse files on a remote device > Next gombot! 
3. Kövesse a képernyőn látható utasításokat! 

 
MEGJEGYZÉS: A távoli eszközön a Bluetooth-nak bekapcsolt állapotban kell lennie 
és a készülék megtalálásának engedélyezve kell lennie, mielőtt megpróbál 
kapcsolatot létrehozni. 
 

Fájlok küldése 
 

1. Érintsen meg és tartsa a tollat egy adatátviteli kapcsolat ikonján, majd 
érintse meg a Connect menüpontot! 

2. Érintse meg a File > Send a file... menüpontot! 
3. Keresse meg az elküldendő fájl(oka)t! 
4. Érintse meg az elküldendő fájl(oka)t! 
5. Érintse meg az OK gombot! 

 

Mappa létrehozása a távoli készüléken 
 

1. Érintsen meg és tartsa a tollat egy adatátviteli kapcsolat ikonján, majd 
érintse meg a Connect menüpontot! 

2. Navigáljon arra a helyre, ahol a mappát létre kívánja hozni! 
3. Érintse meg a File > Create a folder menüpontot! 
4. Amíg a New Folder ki van jelölve, írja be a mappa nevét, majd érintse meg 

az Enter-t! 
5. Érintse meg az OK gombot! 
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Fájl fogadása a távoli készülékről 
 

1. Érintsen meg és tartsa a tollat egy adatátviteli kapcsolat ikonján, majd 
érintse meg a Connect menüpontot! 

2. Keresse meg a fájlt a távoli készüléken! 
3. Érintse meg a fájlt! 
4. Érintse meg a File > Get menüpontot! 
5. Érintse meg az OK gombot! 

 

Fájl törlése a távoli készüléken 
 

1. Érintsen meg és tartsa a tollat egy adatátviteli kapcsolat ikonján, majd 
érintse meg a Connect menüpontot! 

2. Keresse meg a fájlt a távoli készüléken! 
3. Érintse meg a fájlt! 
4. Érintse meg a File > Delete menüpontot! 
5. Érintse meg a Yes gombot a törlés megerősítéséhez! 
6. Érintse meg az OK gombot! 

 

A Business Card Exchange használata 
 
A Business Card Exchange (Névjegy csere) használatával az alábbiakra nyílik 
lehetősége: 
 

• Elkészítheti a saját névjegyét 
• Névjegyet küldhet egy vagy több készüléknek 
• Névjegyet kérhet egy vagy több készüléktől 
• Névjegyet cserélhet egy vagy több készülékkel 

 
Névjegy küldéséhez és cseréjéhez először meg kell adnia egy alapértelmezett 
kapcsolatot. 
 
Meg kell adnia az alapértelmezett névjegyét a Bluetooth Settings Information 
Exchange fülénél. Ez lesz az alapértelmezett név névjegy továbbításakor. 
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Névjegy információ beállítása 
 
A névjegy információ beállítása: 
 

1. Hozzon létre egy névjegyet a Contacts alkalmazásban, amely tartalmazza 
az Ön nevét, beosztását és egyéb lényeges információkat! 

2. A Today képernyőn érintse meg az iPAQ Wireless > Bluetooth Settings > 
Services fület! 

3. A Services résznél válassza az Information Exchange-t! 
4. Érintse meg az Advanced... gombot! 
5. Érintse meg a My business card (vCard) ikont! 

 

 
 

6. Válassza ki a névjegyet a listából! 
7. Érintse meg az OK gombot! 
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Névjegy küldése 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a Tools > Business Card Exchange menüpontot! 
 

 
 

3. Érintse meg a Send ikont! 
4. Érintse meg annak a készüléknek a nevét, amelyre a névjegyet küldeni 

akarja! 
5. Érintse meg az OK gombot! 

 
MEGJEGYZÉS: Győződjön meg róla, hogy a fogadó készüléken engedélyezve van 
a névjegy fogadása! 
 
 
Névjegy kérése 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a Tools > Business Card Exchange menüpontot! 
3. Érintse meg a Request ikont! 
4. Érintse meg annak a készüléknek a nevét, amelytől névjegyet akar kérni! 
5. Érintse meg az OK gombot! 
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Névjegy kicserélése 
 
Lehetősége van névjegy információk kicserélésére a másik készülékkel. Ha 
rendelkezésre áll, a készülék információi egyenesen a Pocket Outlook Contacts 
listájába kerülnek. 
 
Névjegyek cseréje: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a Tools > Business Card Exchange menüpontot! 
3. Érintse meg az Exchange ikont! 
4. Érintse meg annak a készüléknek a nevét, amellyel névjegyet akar cserélni! 
5. Érintse meg az OK gombot! 

 

Kapcsolat megnyitása 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg a New > Explore a Bluetooth Device menüpontot és várja meg, 
hogy a készülék megkeresse az elérhető Bluetooth készülékeket! 

3. Amikor a felfedezett eszköz ikonja megjelenik a képernyőn, érintse meg és 
tartsa a tollat az ikonon, vagy a listában a kapcsolat nevén, majd érintse 
meg a Connect menüpontot! 

4. Érintse meg az OK gombot! 
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Kapcsolat állapotának megtekintése 
 
Megtekintheti: 
 

• A kapcsolat nevét 
• A készülék nevét 
• A kapcsolat állapotát 
• A kapcsolat időtartamát 
• A jel erősségét 

 
A kapcsolat állapotának megtekintése: 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg és tartsa a tollat egy aktív kapcsolat ikonján vagy nevén, és 
érintse meg a Status elemet! 

3. Érintse meg az OK gombot! 
 

Kapcsolat bezárása 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg és tartsa a tollat a kapcsolat ikonján vagy nevén! 
3. Érintse meg a Disconnect menüpontot! 
4. Érintse meg az OK gombot! 

 

Kapcsolat adatainak megtekintése 
 

1. A Today képernyőn érintse meg a parancssorban az iPAQ Wireless ikont, 
majd a Bluetooth > Manager menüpontot! 

2. Érintse meg és tartsa a tollat egy aktív kapcsolat ikonján vagy nevén! 
3. Érintse meg a Properties menüpontot! 
4. Érintse meg az OK gombot! 
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 Az akkumulátor kezelése 
 

Az akkumulátor behelyezése 
 
A HP rx3000-es sorozatú készülékek tartalmaznak egy kis belső akkumulátort, 
amely lehetővé teszi, hogy kicserélje az akkumulátort anélkül, hogy a fő 
memóriában lévő adatok (a telepített programok és a felhasználói adatok) 
elvesztése nélkül, ha gyorsan behelyezi az új akkumulátort. 
 
Ajánlott, hogy a készülék használatba vétele előtt teljesen töltse fel az 
akkumulátort. A HP iPAQ kikapcsolt állapotban is használ némi energiát a fő 
memóriában lévő adatok megőrzésére és az óra működtetésére. Mikor az 
asztalnál dolgozik, hagyja a készüléket a töltőn! Ha utazik, ajánlott, hogy vigye 
magával a hálózati adaptert, a töltő csatlakozót, vagy egy opcionális tartalék 
akkumulátort. 
 
Vásárláskor a HP iPAQ akkumulátora csak részben van feltöltve. 
 
Az akkumulátor behelyezése a készülékbe: 
 

1. A készülék hátulján csúsztassa el a reteszt å, fordítsa ki a hátlapot az 
egységből ç, majd vegye le a hátlapot é! 

 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak egyes modelleken áll 
rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban (Accessories 
Brochure) talál bővebb információt a HP Photosmart kameráról. 
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2. Helyezze be az akkumulátort a készülék jobb oldalán található akkumulátor 
nyílásba úgy, hogy a csatlakozói a jobb felső részen egy vonalban 
legyenek å, és tolja az akkumulátor bal oldalát a helyére ç! 

 
MEGJEGYZÉS: Az akkumulátoron található nagy címkének láthatónak kell lennie 
az akkumulátor behelyezése után. 

 
3. Helyezze vissza a hátlapot úgy, hogy a hátlap körmei a helyükre 

kerüljenek. 
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FIGYELEM: A hátlapot pontosan be kell reteszelni a HP iPAQ működéséhez. 
 
MEGJEGYZÉS: Ha az akkumulátor nincs teljesen feltöltve, a folytatás előtt 
csatlakoztatnia kell a hálózati adaptert és teljesen fel kell töltenie az akkumulátort. 
Az akkumulátor teljes feltöltése nagyjából négy órát vesz igénybe. 
 
 

Az akkumulátor eltávolítása 
 
FIGYELEM: Mivel a legtöbb, Ön által telepített alkalmazás és adat a fő 
memóriában kerül tárolásra, újra kell telepítenie őket, ha teljesen lemerül az 
akkumulátor vagy hosszabb időre kiveszi az akkumulátort a készülékből. 
 
Az iPAQ File Store mappában tárolt programokat és adatokat nem kell 
újratelepítenie, mert azok nem felejtő memóriában kerülnek tárolásra. 
 

Az akkumulátor töltése 
 
Ötlet az akkumulátor kímélésére: Ha nem használja a készüléket, csatlakoztassa a 
hálózati adapterhez. 
 

Töltés a hálózati adapterrel 
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A hálózati adapter a konnektorhoz csatlakoztatható. A külön megvásárolható 
adapterrel az autó szivargyújtójáról vagy más, 12V-os áramforrásról is feltöltheti a 
készülék akkumulátorát. 
 
 
FIGYELEM: Csak a HP által ajánlott hálózati töltőt használja! 
 
A HP iPAQ akkumulátorának töltése: 
 

1. Dugja be a hálózati adaptert a konnektorba å! 
2. A hálózati adapter csatlakozóját dugja be a töltő adapterbe ç! 
3. A töltő adaptert dugja be a HP iPAQ alján lévő csatlakozóba é! 

 

 
 

FIGYELEM: A HP iPAQ és a hálózati adapter károsodását megelőzendő 
győződjön meg róla, hogy a csatlakozók helyesen állnak, mielőtt bedugja őket! 
 

4. Amikor a készülék tetején lévő jelzőfény folyamatos sárgára vált, az 
akkumulátor teljesen fel van töltve és kihúzhatja a hálózati adaptert. Az 
akkumulátor teljes feltöltése nagyjából négy órát vesz igénybe. 

 

Töltés a dokkoló egységgel és a hálózati adapterrel 
 
A dokkoló egységet az alábbiakra használhatja: 
 

• Az akkumulátor feltöltése 
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• Szinkronizáció a számítógéppel (bővebb információt a 3. fejezetben 
(„Szinkronizáció a számítógéppel”) találhat) 

 
Az akkumulátor töltése a dokkoló használatával: 
 

1. Dugja be a hálózati adaptert a konnektorba å, és csatlakoztassa a másik 
végét a dokkoló hálózati csatlakozójához ç! 

2. A HP iPAQ-ot helyezze a dokkoló egységbe é úgy, hogy stabilan álljon 
benne! 

 
FIGYELEM: A készülék és a dokkoló sérülésének megelőzése érdekében 
bizonyosodjon meg róla, hogy a csatlakozók helyesen állnak! 
 

 
 

MEGJEGYZÉS: Az akkumulátor töltése közben a készüléken lévő LED sárgán villog, 
majd a töltés végeztével folyamatos sárgára vált. 
 

A háttérvilágítás beállítása 
 
Megváltoztathatja a háttérvilágítás beállításait az akkumulátor üzemidejének 
növelése érdekében: 
 

1. A Start menüben érintse meg a Settings > System fül > Backlight 
menüpontot! 

2. Állítsa be a háttérvilágítást: 
• Fényerő (Brightness) 
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• Akkumulátor (Battery Power) 
• Külső áramforrás (External Power) 

 
Ötletek az akkumulátor kímélésére: Állítsa be úgy a háttérvilágítást, hogy hamar 
kikapcsoljon, ha már nem használja a készüléket! Érintse meg a Start > Settings > 
System fül > Backlight menüpontot a beállítások elvégzéséhez! A beállítások 
különbözhetnek abban az esetben, ha a HP iPAQ akkumulátorról üzemel, és ha 
külső áramforrásról üzemel. 
 
Állítsa kisebbre a fényerőt, amikor akkumulátorról használja a készüléket! Érintse 
meg a Start > Settings > System fül > Backlight > Brightness fület! Húzza le a 
csúszkát a fényerő csökkentéséhez, vagy teljesen kapcsolja ki a háttérvilágítást! 
 
Kapcsolja ki a háttérvilágítást, ha nem használja a képernyőt, mint például ha 
MP3 zenét hallgat. A háttérvilágítás ki- és bekapcsolásához nyomja le és tartsa 
három másodpercig lenyomva a bekapcsoló gombot! 
 

A vezetéknélküli hálózat energiatakarékos módjának beállítása 
 
A Wi-Fi (WLAN) energiatakarékos módjának beállítása: 
 

1. A Start menüben érintse meg a Settings > System fül > Power > Wireless 
fület! 

2. Állítsa be a WLAN energiatakarékos módot: 
• OFF (Ki) – A WLAN energiatakarékos mód kikapcsolva. Csak akkor 

használja, ha maximális sebességgel kívánja használni a WLAN-t, vagy 
ha a hálózat nem támogatja az energiatakarékos módot! 

• Auto (Automata) – Automatikusan vált az energiatakarékos és a nem 
energiatakarékos mód között. 

• Extended (Kiterjesztett) – Ez a lehető legkevesebb energiát használja fel 
a Wi-Fi kapcsolatok fenntartásához. Ez az üzemmód jelentősen 
csökkenti az átviteli sebességet. Nem ajánlott nagy fájlok átviteléhez. 

 
MEGJEGYZÉS: Az Extended energiatakarékos mód használata nem ajánlott, ha a 
Bluetooth be van kapcsolva. 
 

A parancsgombok zárolása 
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Alapértelmezés szerint a parancsgombok megnyomása bekapcsolja a készüléket. 
 
Ötlet az akkumulátor kímélésére: Beállíthatja, hogy a parancsgombok és a 
fényképező gombok ne kapcsolják be a készüléket. Így csökkenti az esélyét, hogy 
a készülék véletlenül bekapcsolódik. 
 
A következő módon állíthatja be, hogy a parancsgombok és a fényképező 
gombok ne kapcsolják be automatikusan a készüléket: 
 

1. Érintse meg a Start > Settings > Buttons > Lock fület! 
2. Érintse meg a Disable all buttons except power button (Minden gomb 

letiltása a bekapcsoló gomb kivételével) jelölőnégyzetet! 
3. Érintse meg az OK-t! 

 
MEGJEGYZÉS: A bekapcsoló gomb akkor is bekapcsolja a készüléket, ha letiltja a 
parancsgombok automatikus bekapcsoló funkcióját. Ha a készülék be van 
kapcsolva, a gombok a beállított módon viselkednek. 
 

Az akkumulátor kézi ellenőrzése 
 
Az akkumulátor töltöttségének ellenőrzése: 
 

1. A Start menüben érintse meg a Settings > System fül > Power  ikont!  
2. Érintse meg az OK-t! 

 
Ötlet az akkumulátor kímélésére: Állítsa be úgy a készüléket, hogy kapcsoljon ki 
automatikusan, ha már nem használja. Érintse meg a Start > Settings > System fül 
> Power > Advanced fület! Érintse meg az On battery power: jelölőnégyzetet, 
majd érintse meg a lefelé mutató nyilat és adja meg, mennyi idő után kapcsoljon 
ki a HP iPAQ! 
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Bővítőkártyák 
 
Kibővítheti a HP iPAQ memóriáját és a kapcsolódási lehetőségeit. Az opcionális 
bővítő kártyákat a következőkre használhatja: 
 

• A készülék memóriájának bővítése 
• Memóriakártya (SD/MMC) tartalmának megtekintése 

 
 
MEGJEGYZÉS: A bővítőkártyák külön kaphatóak, a HP iPAQ csomagja nem 
tartalmazza. 
 
Ha bővítőkártyát vagy egyéb kelléket kíván vásárolni, látogassa meg a 
www.hp.com/go/ipaqaccessories weboldalt! 
 

Secure Digital (SD) vagy MultiMedia (MMC) kártya behelyezése 
 
Secure Digital (SD) és MultiMedia (MMC) kártya behelyezése a bővítő helyre: 
 

1. Keresse meg a bővítőcsatlakozót a készülék tetején! 
2. Távolítsa el a műanyag védőlapot! 
3. Helyezze be a bővítőkártyát és az érintkezős végével lefelé tolja 

határozottan a helyére! 
 

 
 

http://www.hp.com/go/ipaqaccessories
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MEGJEGYZÉS: Ha a készülék nem ismeri fel a bővítőkártyát, kövesse a kártya 
gyártójának telepítési útmutatóját! 
 

Secure Digital (SD) és MultiMedia (MMC) kártya eltávolítása 
 
SD vagy MMC kártya eltávolítása: 
 

1. Zárjon be minden programot, ami használja a memóriakártyát! 
2. Távolítsa el a kártyát a bővítőhelyről úgy, hogy először lenyomja å, hogy a 

rögzítést feloldja! 
 

 
 

3. Amikor a kártya kiugrik ç, húzza ki a bővítőhelyről! 
 
FIGYELEM: Eltávolítás előtt fel kell oldani az SD kártya rögzítését! Ne húzza ki a 
rögzített SD kártyát a bővítőhelyről, mert az a bővítőhely károsodását okozhatja! 
 

Memóriakártya tartalmának megtekintése 
 
A File Explorer segítségével megtekintheti az opcionális SD vagy MMC kártyán 
lévő tartalmat. 
 

1. A Start menüben érintse meg a Programs > File Explorer menüpontot! 
2. Érintse meg a My Device-on belül azt a könyvtárat, amelynek a tartalmát 

meg kívánja tekinteni! 
 

 



  

Használati útmutató  - 228 - 

 Hibaelhárítás 
 
Az alábbi útmutató segítségével megpróbálhatja megoldani a készülékkel 
kapcsolatban felmerülő problémákat. 
 
MEGJEGYZÉS: A beépített HP Photosmart kamera csak egyes modelleken áll 
rendelkezésre. Ha bővíteni kívánja a készülékét, a Kelléktárban (Accessories 
Brochure) talál bővebb információt a HP Photosmart kameráról. 
 

Általános problémák 
 
Probléma Megoldás 
Nem látszik 
semmi a 
képernyőn. 

§ Kapcsolja be a készüléket! 
§ Csatlakoztassa a készüléket a hálózati adapterhez és a 

dokkolóhoz! 
§ Indítsa újra a készüléket: a tollal finoman nyomja meg a 

Reset gombot! 
§ Távolítsa el az akkumulátort, majd tegye vissza! 

Hamar lemerül az 
akkumulátor. 

§ Ha nem használja a készüléket, csatlakoztassa a 
hálózati adapterhez! 

§ Vegye alacsonyabbra a háttérvilágítást! 
§ Kapcsolja ki a Bluetooth-t és a Wi-Fi-t, ha nem 

használja! 

A háttérvilágítás 
mindig kikapcsol. 

§ A háttérvilágítás beállításainál növelje meg a 
kikapcsolási időt! 

§ Állítsa be, hogy a háttérvilágítás bekapcsoljon a 
képernyő megérintésekor illetve egy gomb 
megnyomásakor! 

Magammal 
szeretném vinni a 
HP iPAQ-ot 
utazáskor. 

§ Mentse el az adatait! 
§ Vigyen magával egy példányt a biztonsági mentésből 

SD kártyán! 
§ Szüntesse meg a külső eszközök csatlakoztatását! 
§ Vigye magával a hálózati adaptert és a töltőt! 
§ Tartsa a HP iPAQ-ot védőtokban és vigye magával a 

kézipoggyászában! 
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Probléma Megoldás 
Külföldi utazásra 
magammal 
szeretném vinni a 
Pocket PC-t 

Vigye magával a cél országban használható hálózati 
adaptert! 

Légi utazáskor ki 
akarom kapcsolni 
a Bluetooth-t és a 
Wi-Fi-t. 

A Launch vagy a Today képernyőn, a Start > iPAQ Wireless, 
majd a képernyő alján az All Off gomb megérintésével 
minden vezetéknélküli funkciót kikapcsolhat. 

Szervízbe 
szeretném küldeni 
a készüléket. 

1. Készítsen biztonsági mentést az adatairól! 
2. Szüntesse meg a kapcsolatot külső eszközökkel! 
3. Csomagolja a HP iPAQ-ot és az ügyfélszolgálat által 

kért külső eszközöket védőcsomagolásba. Tegye mellé 
az ügyfélszolgálat által kért dokumentációkat és 
eszközöket. 

Nem tudok 
csatlakozni egy 
hálózathoz. 

§ Győződjön meg róla, hogy megadta a szükséges 
szerver információkat! 

§ Győződjön meg róla, hogy a hálózat, amihez 
csatlakozni kíván, elérhető és nem foglalt! 

§ Ha SDIO Ethernet kártyát használ, ellenőrízze, hogy 
telepítve vannak-e a megfelelő meghajtó programok! 

§ Ellenőrízze, hogy helyes felhasználónevet és jelszót 
adott-e meg! 

§ Érintse meg a Start > Settings > Connections fül > 
Connections menüpontot, és ellenőrízze a kapcsolat 
beállításait! Érintse meg az OK gombot a változtatások 
elmentéséhez! 

§ Győződjön meg róla, hogy helyes WEP kulcsot használ! 
§ Győződjön meg róla, hogy helyes IP címet használ! 
§ Ellenőrízze, hogy a kapcsolathoz használt hardver 

eszköz megfelelően be van-e állítva és működőképes-e! 
§ Indítsa újra a készüléket: a tollal finoman nyomja meg a 

Reset gombot! 
Az Inbox 
megnyitásakor 
hibaüzenetet 
kapok vagy 
lefagy a 
program. 

Korlátozza a létrehozott e-mail postafiókok számát! 
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Probléma Megoldás 
A Calendar vagy 
a Tasks 
programban 
üzenet 
felvételekor 
hibaüzenetet 
kapok. 

Használjon jobb tömörítésű beállítást a Calendar vagy a Tasks 
programban (8,000 Hz, Mono [8 KB/s] a legtömörebb, 
rendelkezésre álló formátum). Tömörebb felvételi formátum 
beállítása: a Today képernyőn érintse meg a Start > Settings > 
Input > Options fület! 

Látni szeretném a 
mai dátumot. 

1. A Today képernyőn érintse meg a Start > Calendar 
menüpontot! 

2. Érintse meg a Go-to-Today ikont! 
Nem látom az 
összes 
találkozómat. 

Győződjön meg róla, hogy a létrehozott találkozó a 
kiválasztott kategóriában van-e! 

Nem találom az 
elmentett 
dokumentumot 
vagy 
munkafüzetet. 

A Pocket Word és az Excel csak a My Documents mappában 
vagy az eggyel alatta lévő mappában lévő dokumentumokat 
ismeri fel és jeleníti meg. Például, ha a My Documentsben 
szereplő Personal mappában létrehozott egy  mappát, a 
benne szereplő dokumentumok nem lesznek láthatóak. 
 
A dokumentum illetve munkafüzet megkereséséhez érintse meg 
a Start > Programs > File Explorer menüpontot, nyissa meg a 
létrehozott mappát és érintse meg a keresett fájlt! 

A készülék 
mindig jelszót kér 
tőlem. 

Érintse meg a Start > Settings > Personal fül > Password 
menüpontot és ellenőrízze a jelszó beállításokat! 

Nem találom a 
fájlokat, 
amelyeket egy 
másik készülékről 
lettek átküldve. 

Ellenőrízze a My Documents mappát. A fogadott fájlok 
alapértelmezés szerint ide kerülnek. 
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ActiveSync 
 
A Microsoft ActiveSync-ről bővebb információt a 3. fejezetben („Szinkronizáció a 
számítógéppel”) talál. 
 
Probléma Megoldás 
Nem tudok a 
számítógéphez 
csatlakozni a 
dokkoló 
segítségével. 

§ Győződjön meg róla, hogy a HP iPAQ csatlakoztatása 
előtt telepítette a számítógépre a Microsoft ActiveSync 
3.7 vagy későbbi verzióját! 

§ Ellenőrízze, hogy a HP iPAQ csatlakoztatva van-e a 
dokkolóhoz, és a dokkoló a számítógéphez! 

§ Győződjön meg róla, hogy a HP iPAQ stabilan rögzítve 
van a dokkolóban és érintkezik! 

§ Ellenőrízze, hogy Microsoft Windows 98SE, ME, 2000, 
vagy XP operációs rendszert használ-e, és telepítette a 
Microsoft ActiveSync 3.7 vagy későbbi verzióját! 
Győződjön meg róla, hogy közvetlenül a számítógép 
USB portjához csatlakozik, és nem egy USB hubhoz! 

§ Távolítsa el és telepítse újra az ActiveSync-et! 
§ Ha személyes tűzfalat futtat, próbálja meg letiltani! Ha 

így tud szinkronizálni, lépjen kapcsolatba a program 
gyártójával, hogy hogyan lehet beállítani a tűzfalat úgy, 
hogy a probléma ne lépjen fel. 

Csatlakoztattam 
a HP iPAQ-ot a 
Microsoft 
ActiveSync 
telepítése előtt. 

1. Bontsa  a kapcsolatot a HP iPAQ és a számítógép 
között! 

2. Windows 98 és 2000 esetén érintse meg a Start > 
Settings > Control Panel > System menüpontot! A 
Device Manager megnyílik. Keresse meg és válassza ki 
az „unknown” (ismeretlen) USB eszközt, majd távolítsa 
el (remove, Windows 2000-ben uninstall)! 

3. Indítsa újra a számítógépet és engedje meg, hogy 
detektálja az USB eszközt. 

4. Telepítse a Microsoft ActiveSync 3.7 vagy újabb 
verzióját! 

5. Csatlakoztassa a HP iPAQ-ot a számítógéphez! 
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Probléma Megoldás 
A Microsoft 
ActiveSync nem 
találja a HP 
iPAQ-ot 
szinkronizációkor. 

§ Győződjön meg róla, hogy a készülék be van 
kapcsolva! 

§ Ellenőrízze a kábelek csatlakoztatását! 
§ Távolítsa el a HP iPAQ-ot a dokkolóról vagy húzza ki az 

AutoSync kábelt, kapcsolja be a készüléket a 
bekapcsoló gombbal, majd tegye vissza a dokkolóra 
vagy csatlakoztassa az AutoSync kábelhez! 

§ Indítsa újra a készüléket: a tollal finoman nyomja meg a 
Reset gombot! 

§ Ellenőrízze a számítógépen az ActiveSync-ben a 
Connection Settings képernyőjén, hogy a használni 
kívánt kommunikációs port aktív. 

Nem tudom 
megnyitni a 
leveleket az 
Inboxban a 
Microsoft 
ActiveSync-kel 
történt 
visszaállítás után. 

Szinkronizálja a Microsoft ActiveSync-kel a HP iPAQ-ot a 
számítógéppel! Erről bővebb információt a 3. fejezetben 
(„Szinkronizáció a számítógéppel”) találhat. 

Szinkronizáltam 
egy munkafüzetet 
de a Microsoft 
ActiveSync nem 
alakította át a 
fájlt. 

A Pocket Excel nem támogatja az Excel formázások 
mindegyikét, ezért a Microsoft ActiveSync nem tudja 
szinkronizálni a fájlt. 
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Bővítőkártyák 
 
A bővítőkártyákról bővebb információt a 11. fejezetben („Bővítőkártyák”) talál. 
 
Probléma Megoldás 
A HP iPAQ nem 
ismeri fel a 
bővítőkártyát. 

§ Ellenőrízze, hogy a bővítőkártyát szorosan behelyezte-e 
a HP iPAQ-ba! 

§ Ellenőrízze, hogy a megfelelő bővítőhelyre helyezte-e be 
a kártyát! 

§ Ellenőrízze, hogy a szükséges meghajtóprogramok 
telepítve vannak-e! 

Nem tudom 
behelyezni a 
kártyát. 

§ Ellenőrízze, hogy a címke a készülék eleje felé néz-e! 
§ Helyes szögben helyezze be a kártyát! 
§ Az érintkezős részt álljon a készülék belseje felé! 

Nem tudom 
kivenni az SD 
kártyát. 

Nyomja le a kártyát a rögzítés kioldásához. A kártya kiugrik 
és könnyedén eltávolítható. 

Az iPAQ Pocket 
PC nem ismeri fel 
a kártyát. 

§ Töltse be a kártyához tartozó meghajtó programokat! 
§ Indítsa újra a készüléket (a tollal finoman nyomja meg a 

Reset gombot)! 
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Bluetooth 
 
A Bluetooth-ról bővebb információt a 9. fejezetben („A Bluetooth használata”) 
talál. 
 
Probléma Megoldás 
Nem tudok más 
eszközt 
felfedezni. 

§ Győződjön meg róla, hogy be van-e kapcsolva a 
Bluetooth! 

§ Menjen közelebb az eszközhöz! 
§ Ellenőrízze, hogy nem korlátozta-e más készülékek 

felfedezhetőségét! 
§ Ellenőrízze, hogy a felfedezni kívánt eszköz be van-e 

kapcsolva és engedélyezve van-e a felfedezhetősége! 
Látok más 
eszközöket, de 
nem tudok 
kapcsolódni vagy 
adatot cserélni 
velük. 

§ Ellenőrízze, hogy a Bluetooth be van-e kapcsolva! 
§ Menjen közelebb az eszközhöz! 
§ Ellenőrízze, hogy a másik eszköz nem korlátozza-e a 

hozzáférést! 
§ Próbáljon meg a másik eszközről párosítást 

kezdeményezni! Egyes Bluetooth eszközök képesek 
párosítást kezdeményezni, de fogadni nem. 

Más eszközök 
nem találják a 
készülékemet 
vagy nem tudnak 
csatlakozni 
hozzá. 

§ Ellenőrízze, hogy a Bluetooth be van-e kapcsolva! 
§ Menjen közelebb az eszközhöz! 
§ Ellenőrízze, nem tiltotta-e le az eszköz 

megtalálhatóságát! 
§ Ellenőrízze a Bluetooth beállításoknál, hogy 

engedélyezve van-e az eszköz felfedezhetősége és a 
kapcsolódás! 

Más eszközök 
nem kapják meg 
helyesen a 
névjegyemet. 

§ Ellenőrízze, hogy jól állította-e be a névjegyét a 
Bluetooth Settings-nél! 

§ Ellenőrízze a Bluetooth Settings-nél, hogy nem 
korlátozta-e ezt a funkciót! 
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Wireless LAN 
 
A Wi-Fi-ről bővebb információt a 8. fejezetben („A Wi-Fi használata”) talál. 
 
Probléma Megoldás 
Nem tudok 
hozzáférési 
ponthoz 
kapcsolódni. 

§ Ellenőrízze, hogy a WLAN be van-e kapcsolva! 
§ Ellenőrízze, hogy az eszköz azonosította-e a hálózatot, 

amelyhez kapcsolódni kíván! 
§ Ellenőrízze, hogy megadta-e a szükséges azonosítókat, 

amikor a rendszer kérte! 
§ Győződjön meg róla, hogy a HP iPAQ a hozzáférési 

pont hatósugarában van-e! 
Csatlakoztam egy 
hozzáférési 
ponthoz, de nem 
tudom böngészni 
az Internetet. 

Ha a vezetéknélküli hálózat, amelyhez csatlakozott, 
munkahelyi hálózathoz kapcsolódik, elképzelhető, hogy be 
kell állítania egy proxyt. Proxy beállítása: 

1. Kérdezze meg a hálózatadminisztrátorától a proxy 
beállításait! 

2. Érintse meg a Connections ikon > Add proxy server 
parancsot! 

3. A 8. fejezetben („A Wi-Fi használata”) talál bővebb 
információt. 

Nem látom a 
vezetéknélküli 
hálózatot a HP 
iPAQ-on. 

Elképzelhető, hogy a vezetéknélküli hálózatot nem lehet 
felfedezni. 

1. Érintse meg a Connections ikon > Settings elemet! 
2. Érintse meg az Advanced fül > Network Cards > Add 

New Settings menüpontot! 
3. Kövesse a képernyőn látható utasításokat! 

Túl lassú az 
adatátvitel. 

• Ha a Bluetooth be van kapcsolva, kapcsolja ki. 
• Kapcsolja ki a vezetéknélküli hálózat energiatakarékos 

módját. Bővebb információt a 8. fejezetben („A Wi-Fi 
használata”) talál. 
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Probléma Megoldás 
Nem tudok egy 
név nélküli 
elérhető 
hálózathoz 
csatlakozni. 

A hálózat valószínűleg rejtett, vagy nem sugározza az SSID-t. 
A csatlakozáshoz ismernie kell a hálózat nevét (SSID). 
 

1. Érintse meg a Start > Settings > Connections fül > 
Connections > Advanced fül > Network Card 
menüpontot! 

2. Válassza az Add New Settings lehetőséget! 
3. Adja meg a hálózat nevét (SSID)! 
4. Válassza ki a megfelelő értékeket a Connects to: 

dobozban! 
5. Ha szükség van WEP beállításokra, érintse meg az 

Authentication fület és adja meg őket! 
Nem tudok 
megbízhatóan 
csatlakozni az 
elérhető 
hálózathoz, 
illetve gyakran 
megszakad a 
kapcsolat. 

§ Győződjön meg róla, hogy elég erős-e a jel. 
§ Ha be van kapcsolva a WLAN energiatakarékos mód, 

próbálja meg megváltoztani a módot vagy kikapcsolni. 
Bővebb információt a 10. fejezetben („Az akkumulátor 
kezelése”) találhat. 

§ Ha Extended Power Save módot használ, kapcsolja ki 
a Bluetooth-t! 
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iPAQ Mobil Média 
 
Az iPAQ Mobil Médiával kapcsolatosan bővebb információt a 6. fejezetben 
(„iPAQ Mobil Média”) talál. 
Probléma Megoldás 
A Launch 
képernyőn nem 
tudom beállítani 
a Media Control, 
Media Stream, 
vagy a Media 
Copy módot. Az 
ikon szürke. 

• A Media Control, Media Stream és Media Copy ikonok 
szürkék, ha nem csatlakozik a Wi-Fi hálózathoz, a 
Mobile Media for PC komponensek nincsenek telepítve 
a PC-n, nem futnak, vagy a PC ki van kapcsolva.  

o Ellenőrízze, hogy be van-e kapcsolva a Wi-Fi és 
a HP iPAQ csatlakozva van-e egy Wi-Fi 
hálózathoz! Nyissa meg az iPAQ Wireless 
programot: érintse meg a Launch képernyőn az 

 ikont! Ha van kapcsolat, a Wi-Fi ikon zöld 

és az  ikon látható a parancssorban. Ha a 
Wi-Fi ikon sárga, a Wi-Fi be van kapcsolva, de 
nincs kapcsolat. Érintse meg a Settings gombot 
és ellenőrízze, hogy megadta-e a hálózat nevét 
és a biztonsági beállításokat! 

o Ellenőrízze a Wi-Fi kapcsolat beállításait! Érintse 
meg a Start > Settings > Connections fül > 
Connections > Advanced fül > Select Networks 
menüpontot és ellenőrízze, hogy be van-e állítva 
az Internet szolgáltatója a „Programs that 
automatically connect to a private network 
should connect using...” pontban! A Settings 
képernyőn érintse meg az OK-t, a Connections 
képernyőn az OK-t, majd a Network Cards 
ikont! Válassza ki és érintse meg a hálózat nevét 
a listából, és ellenőrízze, hogy a munkahelyi 
hálózathoz (Work) kapcsolódik-e! 

• Ellenőrízze a Wi-Fi hozzáférési pontot, hogy be van-e 
kapcsolva és helyesen működik-e! 

• Ellenőrízze, hogy be van-e kapcsolva a számítógép, 
amelyhez kapcsolódni kíván, és fut-e rajta a 
NevoMedia Server és a NevoMedia Player! A 
NevoMedia Server és a NevoMedia Player 
elindításához érintse meg a Start > All Programs > 
Hewlett-Packard > Mobile Media for PC menüpontot! 
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Probléma Megoldás 
 • Az iPAQ Mobile Media-ban válasszon ki egy elérhető 

média módot, érintse meg a Customize (csavarkulcs) 
menüt és válassza a Refresh Servers and Player 
lehetőséget, majd térjen vissza az iPAQ Mobile Media 
fő képernyőjéhez! 

Az egyik Media 
Server vagy 
Media Player 
nem jelenik meg 
a Media Server 
vagy a Media 
Player listában. 

• Ellenőrízze, hogy be van-e kapcsolva a számítógép, 
amelyhez kapcsolódni kíván, és fut-e rajta a 
NevoMedia Server és a NevoMedia Player! A 
NevoMedia Server és a NevoMedia Player 
elindításához érintse meg a Start > All Programs > 
Hewlett-Packard > Mobile Media for PC menüpontot! 

• Az iPAQ Mobile Media-ban válasszon ki egy elérhető 
média módot, érintse meg a Customize (csavarkulcs) 
menüt és válassza a Refresh Servers and Player 
lehetőséget, majd térjen vissza az iPAQ Mobile Media 
fő képernyőjéhez! 

Nem találom az 
anyagot, amit a 
Media Serverben 
keresek. 

• A Media Control, Media Stream, Media Copy esetén 
ellenőrízze, hogy a keresett anyagot a NevoMedia 
Server katalogizálta-e! Nyissa meg a számítógépen a 
NevoMedia Servet-t, és ellenőrízze, hogy olyan 
könyvtárban van-e a fájl, amelyet hozzáadott a 
könyvtárhoz! 

• Az iPAQ Mobile Media-ban válasszon ki egy elérhető 
média módot, érintse meg a Customize (csavarkulcs) 
menüt és a Refresh Folder lehetőséget! A megnyitott 
mappa tartalma frissül. 

• Ha Local (helyi) módban van, ellenőrízze a Storage 
Settings (Tárolási) beállításokat, hogy a megfelelő 
helyre mutatnak-e a HP iPAQ-on! A Customize 
(csavarkulcs) menüben válassza a Storage Settings 
elemet, majd válassza ki azt a mappát, amelyben az 
anyag található! 

Amikor 
kiválasztok egy 
fájlt, hibaüzenetet 
kapok, hogy ez a 
formátum nem 
támogatott. 

• A média formátumokat a HP iPAQ az iPAQ Mobile 
Media vagy egy másik, telepített média alkalmazás 
segítségével támogatja. A formátumokról bővebben a 
készülékhez kapott „Ho Do I Guide...” útmutató „Ho Do 
I Play Copyrighted Music and Video on My iPAQ?” 
című részében találhat. 
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Probléma Megoldás 
Media Control 
módban nem 
tudom lejátszani 
a NevoMedia 
Player-ben a 
.wma vagy .wmv 
fájlokat. 

• Ellenőrízze, hogy be van-e kapcsolva a számítógép, 
amelyhez kapcsolódni kíván, és fut-e rajta a 
NevoMedia Server és a NevoMedia Player! A 
NevoMedia Server és a NevoMedia Player 
elindításához érintse meg a Start > All Programs > 
Hewlett-Packard > Mobile Media for PC menüpontot! 

• Ellenőrízze, hogy a számítógépen az Internet Explorer 
beállításai kompatibilisek-e! Egyes vállalati és egyéb 
hálózatok esetén be kell állítani proxy-t vagy le kell 
futtatni egyéb konfigurációt szkripteket az Internet 
eléréséhez, ezeket az iPAQ Mobile Media 
működéséhez le kell tiltani. A számítógépen indítsa el 
az Internet Explorert, majd a Tools menüben válassza 
az Internet Options menüpontot, a Connections fülön a 
LAN Settins-et! Ellenőrízze, hogy nincs-e beállítva 
automatikus konfigurációs szkript vagy Proxy szerver az 
Internet eléréséhez! Minden jelölőnégyzetnek kikapcsolt 
állapotban kell lennie. 

Media Stream 
módban nem 
tudok MP3 zenét 
hallgatni a HP 
iPAQ-on. 

• Az iPAQ Mobile Media nem támogatja az MP3 stream-
et, csak a WMA stream-et. MP3 zenét úgy hallgathat, 
hogy Media Copy módban átmásolja a HP iPAQ-ra, 
majd Local Media módban játsza le. 

Local módban 
nem találom a 
beépített HP 
Photosmart 
kamerával 
készített 
fényképeket. 

• A beépített HP Photosmart kamerával készült képek a 
My Documents\My Pictures mappában vannak tárolva. 
Ha az iPAQ Mobile Media segítségével kívánja elérni 
ezeket a képeket, ellenőrízze, hogy a Storage Settings 
(Tárolási) beállítások a megfelelő helyre mutatnak a HP 
iPAQ-on. A Customize (csavarkulcs) menüben válassza 
a Storage Settings lehetőséget, majd válassza ki a 
könyvtárat, ahol a fájlok találhatóak! 
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Probléma Megoldás 
A számítógépen 
le tudom játszani 
a .wmv videó 
fájlokat, de a HP 
iPAQ-on nem. 
Van hang, de 
kép nincs. 

• A videó csak akkor játszható le, ha megfelelő 
beállításokkal lett elmentve. A Windows Movie Maker 
segítségével elmentheti a fájlokat a megfelelő 
beállításokkal. Indítsa el a Windows Movie Maker-t, 
majd a File menüből válassza az Import into Collections 
lehetőséget! Válassza ki a videó fájlt, majd nyomja 
meg az Import gombot! Szerkessze a videót, ahogy 
kívánja, majd válassza a Save to My Computer 
menüpontot! a Save Movie Wizard Movie Setting 
képernyőjén válassza a Show More Choices 
lehetőséget, majd az Other settings-et, és mentse el a 
videót Pocket PC format formátumban! Mentés után 
helyezze a fájlt egy olyan könyvtárba, amelyet a 
NevoMedia Server katalogizált, vagy másolja át a fájlt 
a HP iPAQ-ra és játsza le Local Media módban! 

Hogyan 
módosíthatom a 
NevoMedia 
Player vizuális 
effektjeit? 

• A NevoMedia Player-ben a zene lejátszása közben 
megjelenő vizuális hatások a Windows Media Player-
ben módosíthatóak. Nyissa meg a Windows Media 
Player-t, a View menüből válassza a Visualizations 
menüpontot, majd válassza ki a kívánt vizuális hatást! 

Az online 
zeneboltban 
megvásárolt 
zenét nem tudom 
lejátszani. 

• Az online zeneboltból megvásárolt és letöltött zene 
másolásvédelemmel van ellátva, ezért nem játszható le 
az iPAQ Mobile Media segítségével. Másolásvédett 
zene lejátszásához azt a számítógépről a Windows 
Media Player segítségével kell átmásolnia a HP iPAQ-
ra, majd a HP iPAQ-on a Windows Media Player 
segítségével játszhatja le. 

• Elképzelhető, hogy a zene az iPAQ Mobile Media által 
nem támogatott formátumban van tárolva. Az iPAQ 
Mobile Media csak .wma és .mp3 formátumot játszik le 
(Media Stream módban az .mp3 nem támogatott). 

A Mobile Media 
for PC számító-
gépre telepítése-
kor „nem támoga-
tott” hibaüzenetet 
kapok. 

• A Mobile Media for PC csak Windows XP-n (Home, 
Professional, Media Center és Tablet Edition) fut. Más 
operációs rendszert futtató számítógépre nem 
telepíthető. 
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Szabályozások 
 

Európai Uniós nyilatkozat 
 
Beltéri (otthoni és irodai) használatú, a 2.4GHz-es sávban működő rádiós eszköz 
– Wireless Local Area Network (WLAN). 
 

 
 

Megfelelőségi nyilatkozat 
 
Az eszköz megfelel az alábbi EU irányelveknek: 
 
§ Kisfeszültségre vonatkozó előírás 73/23/EEC 
§ EMC előírás 89/336/EEC 
§ R&TTE előírás 1999/5/EC 

 
Az eszköz CE megfelelősége csak akkor érvényes, ha a HP által biztosított CE 
jelölésű hálózati adapterről van üzemeltetve. 
 
Az ezeknek az irányelveknek való megfelelés maga után vonja a következő 
Európai Normáknak való megfelelést (zárójelben az egyenértékű nemzetközi 
szabványok és előírások): 
 
§ EN 55022 (CISPR 22) - Elektromágneses Interferencia 
§ EN 55024 (IEC61000-4-2, 3, 4, 5, 6, 8, 11) - Elektromágneses 

sugárzástól való védettség 
§ EN61000-3-2 (IEC61000-3-2) - Erősáramú vezetékek harmonikus 

frekvenciái 
§ EN61000-3-3 (IEC61000-3-3) - Erősáramú vezetékek okozta vibrálás 
§ EN 60950 (IEC 60950) – Termékbiztonság 
§ ETS 300 328-2 – A 2.4GHz-es sávban működő, szórt spektrumot használó 

rádióberendezésekre vonatkozó mûszaki követelmények 
§ EN 301 489-1, -7, -17 – Általános EMC követelmények rádiós 

készülékekkez szemben 
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A készülék rádiós funkciója a következő EU és EFTA országokban 
használható: Ausztria, Belgium, Ciprus, Cseh Köztársaság, Dánia, Észtország, 
Finnország, Franciaország, Németország, Görögország, Magyarország, 
Izland, Írország, Olaszország, Lettország, Liechtenstein, Litvánia, Luxembourg, 
Málta, Hollandia, Norvégia, Lengyelország, Portugália, Szlovák Köztársaság, 
Szlovénia, Spanyolország, Svédország, Svájc, Egyesült Királyság. 

Franciaországi és olaszországi nyilatkozat 
 
Olaszország: 
 
E’necessaria una concessione ministeriale anche per l’uso del prodotto. Verifici 
per favore con il  roprio distributore o direttamente presso la Direzione Generale 
Pianificazione e Gestione  requenze. 
 
Működtetéséhez engedély szükséges. Beszéljen a kereskedővel vagy közvetlenül a 
frekvenciákat felügyelő hatósággal (Direzione Generale Pianificazione e Gestione 
Frequenze). 
 
Franciaország: 
 
L'utilisation de cet equipement (2.4GHz Wireless LAN) est soumise a certaines 
restrictions: Cet equipement peut etre utilise a l'interieur d'un batiment en utilisant 
toutes les frequences de 2400 a 2483.5MHz (Chaine 1-13). Pour une utilisation 
en environement exterieur, vous devez utiliser les frequences comprises entre 
2454-2483.5MHz (Chaine 10-13). Pour les dernieres restrictions, voir 
<http://www.art-telecom.fr>. 
 
A 2.4GHz-es vezetéknélküli LAN működtetésére vonatkozó korlátozások: A 
készülék beltéren a teljes 2400-2483.5 MHz-es tartományban használható (1-13 
csatornák). Kültéri használatra csak a 2454-2483.5 MHz-es tartomány (10-13 
csatornák) használható. Az aktuális korlátozásokat a http://www.art-telecom.fr 
címen találja. 
 
 
 

http://www.art-telecom.fr
http://www.art-telecom.fr


  

Használati útmutató  - 243 - 

Figyelmeztetés az akkumulátorról 
 
VIGYÁZAT: A készülék lítium-ion tölthető akkumulátort tartalmaz. A tűz- és 
égésveszély elkerülése érdekében ne szedje szét, ne törje össze, ne szúrja ki, ne 
zárja rövidre, ne dobja vízbe vagy tűzbe! 
 
FIGYELEM: Az akkumulátor helytelen cseréje robbanásveszéllyel járhat. Csak 
ugyanolyan, vagy a gyártó által ajánlott típusra cserélje az akkumulátort! Az 
elhasznált akkumulátort az utasításoknak megfelelően dobja el. 
 
FIGYELEM: Csak a HP által jóváhagyott akkumulátort használja az iPAQ Pocket 
PC-hez! A nem megfelelő akkumulátor használata a készülék meghibásodását 
eredményezheti! 
 
Az iPAQ Pocket PC akkumulátorát a helyi előírásoknak megfelelően kell a 
szemétbe dobni. A kereskedőnél érdeklődjön a helyi szabályozásokról és/vagy 
akkumulátor begyűjtő program létezéséről. 

 

Figyelmeztetés a készülékről 
 
 
 
VIGYÁZAT: A személyi sérülés, áramütés, tűz és a berendezés károsodásának 
megelőzése érdekében: 
§ A hálózati töltőt mindig könnyen elérhető fali csatlakozóba dugja! 
§ A készülék csatlakozását a hálózati töltő konnektorból való kihúzásával 

vagy a szinkronizációs kábel számítógépből való kihúzásával szüntesse 
meg! 

§ Ne tegyen semmit a vezetékekre! Úgy helyezze el a vezetékeket, hogy 
senki se lépjen rá vagy essen el benne! 

§ Ne húzza a vezetéket! Ha ki akarja húzni a töltőt, a töltőt fogja meg! 
§ Ne használja a készülékhez kapható átalakítókat az áramellátás 

biztosításához! 
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Utazás légiközlekedéssel 
 
A repülőgép fedélzetén a légitársaság szabályozza az elektronikus készülékek 
használatát. 
 

Figyelmeztetés vezeték nélküli berendezésekkel kapcsolatban 
 
Bizonyos helyeken a vezeték nélküli berendezések használatát korlátozhatják. 
Ilyen korlátozások lehetnek repülőgép fedélzetén, kórházban, robbanóanyagok 
közelében, veszélyes helyeken stb. Ha bizonytalan benne, hogy egy adott helyen 
szabad-e használni a készüléket, bekapcsolás előtt kérjen engedélyt rá! 
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Specifikációk 
 

Rendszerjellemzők 
 
MEGJEGYZÉS: Nem minden modell kapható mindenhol. A beépített HP Photosmart 
kamera csak egyes modelleken áll rendelkezésre. Ha bővíteni kívánja a 
készülékét, a Kelléktárban (Accessories Brochure) talál bővebb információt a HP 
Photosmart kameráról. 
 
 
Jellemző Leírás 
Processzor Samsung 2440 
A felhasználó 
rendelkezésére 
álló memória 

rx3700 sorozat: 152 MB 
rx3417: 88 MB 
rx3415: 56 MB 
rx3115: 56 MB 

SD I/O slot SD memóriakártya támogatott 
Képernyő 3.5 colos színes transzreflektív QVGA TFT, 240x320 képpont, 

64K színű 
LED 
Háttérvilágítás 

Többszintű fényerő beállítás 

Hang Integrált mikrofon, hangszóró, 3.5 mm-es sztereó jack 
csatlakozó, MP3 sztereó az audio jacken keresztül 

Beépített 
digitális kamera 

HP Photosmart 1.2 megapixeles kamera, 4x digitális zoom, 
1280x960 képpontos felbontás, tükör Önmaga 
fényképezéséhez. Fénykép formátuma: JPEG. Motion JPEG, 
H.263 (csak rx3700). Lejátszható videó formátumok: MPEG1, 
MPEG4 (csak rx3700), MotionJPEG. 

Infravörös 
(IrDA) 

IrDA, maximálisan 115.2KB/s. 

Hálózati 
adapter 

Hálózati feszültség és áram: 
100-240V 50/60Hz max. 0.3A 
Kimeneti feszültség és áram: 
5V DC 2A (tipikus érték) 

Bluetooth 1.1 kompatibilis, Class II eszköz, tipikusan 10m hatótávolság 
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Jellemző Leírás 
LED jelzések 
(Baloldali LED) 
 
 
(Jobb LED) 

3 üzemmódú jelzés: 
Értesítés: villogó zöld 
Töltés: villogó sárga 
Töltés befejezve: folyamatos sárga 

Bluetooth/WLAN rádiós aktivitás: 
Bekapcsolva: folyamatos kék 

Akkumulátor rx3700 sorozat: levehető, újratölthető,1440mAh, opcionálisan 
2880mAh lítium-ion akkumulátor kapható. 
rx3400 és rx3100 sorozat: levehető, újratölthető, 1440mAh és 
2880mAh lítium-ion akkumulátor kapható. 

Fizikai jellemzők 
HP iPAQ rx3700 sorozat 
 Egyesült Államok Metrikus 
Hossz 4.5 in. 114.3 mm 
Szélesség 2.8 in. 71.2 mm 
Magasság 0.64 in. 16.3 mm 
Súly 158 g 158 g 
 
HP iPAQ rx3400 és rx3100 sorozat 
 Egyesült Államok Metrikus 
Hossz 4.5 in. 114.3 mm 
Szélesség 2.8 in. 71.2 mm 
Magasság 0.64 in. 16.3 mm 
Súly 147 g 147 g 
 

Működési környezet 
  Egyesült 

Államok 
Metrikus 

Működési 32°-104°F 0°-40°C Hőmérséklet 
Tárolási -4°-140°F -20°-60°C 
Működési 90% 90% Relatív 

páratartalom Tárolási 90% 90% 
Működési 15,000 láb 0-4,572 m Max. tengerszint 

feletti magasság Tárolási 40,000 láb 0-12,192 m 
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